The New Standaro

The SMH Series

Senal SMH headphones are rapidly becoming the industry stan-
dard for audio professionals in the field and in the studio. They
are ideal for demanding musicians, engineers, and broadcasters
who require a wide dynamic range, natural frequency response,
durability, and comfort. And when you’re finished in the studio,

you don’t have to pack them up. You can continue enjoying
your Senal headphones after the session is over because we
have carefully optimized the impedance to work with your mo-
bile device or smartphone. Senal headphones will deliver the
sound you need, when you need it.
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SMH-1200

The SMH-1200 professional studio-monitor
headphones are tailored for accurate music
reproduction and monitoring in the most
demanding professional environments. The
refined frequency response of the SMH-1200
offers superior detail and accuracy while pre-
venting ear fatigue.

* Closed-Back, Over-Ear Circumaural Design
* EQ Curve for Music and Monitoring

« Slightly Boosted Lows for Defined Bass

» Refined Mids Reveal Recording Details

* Detachable, Twist-Locking, Cable Design

* Extra Deep Replaceable Ear Cushions

)

SMH-1000

The rugged SMH-1000 Studio Headphones
are ideal for commercial recording, broadcast,
home studios, and live and location sound. They
are also great for home and portable entertain-
ment. With our refined and finely tuned fre-
quency response, the result is a natural sound
with subtle emphasis in all the right places.

» Closed-Back, Over-Ear Circumaural Design
» Rugged Design for Field and Studio Use

* Detachable, Twist Locking Cable Design

» Midrange Refined to Reduce Ear Fatigue

* EQ Curve For Pro Field and Studio Use

» Collapsible For Easy Storage

SMH-500

The SMH-500 Professional Studio Head-
phones are ideal for studio and light field
applications. The circumaural (over-the-ear),
closed back design provides ample isolation
to block out ambient noise on location, and
prevent headphone leakage when recording
in the studio. Designed for long-lasting com-
fort, the 10’ single-sided coiled cable allows
freedom of movement for musicians, editors,
and engineers.

* Designed for Light Field and Studio Use
« Closed-Back, Over-Ear Circumaural Design

10’ Coiled and 4' Cable for Mobile Use
» Adjustable Headband and Foldable Design
* 3-Year Limited Warranty

299D

Onyx -~ Cherry Red Nautical Blue Burgundy

* 3-Year Limited Warranty
#SESMH1200

$149.99

#SESMH1000

SC-550X
Professional Cardioid
Condenser Microphone

« Condenser Element

« Cardioid Polar Pattern

« Selectable -10 dB Pad

* Selectable Hi-Pass Filter at 80 Hz

140 dB Maximum SPL

» Wide, Linear Frequency Response

* Accurate Transient Response

« All-Metal Body

* Designed for Multiple Applications

* Includes Shockmount, Pop Filter, & Case

HoESCo30X st ataltatstats’ $129.99

Professional Audio

Precision engineered microphones

and monitoring solutions to accurately
capture and reproduce your audio.

* Soft Replaceable Ear Cushions
» 10’ Coiled, 3' Straight Cables Included
* 1/4" Gold-Plated Adapter Included

* Soft Replaceable Ear Cushions
 Refined EQ Curve

« 10" Attached Coiled Cable

« 1/4" Gold-Plated Adapter Included
* 3-Year Limited Warranty

$89.99 #SESMH500

$49.99

SCS-98
DSLR/Video
Stereo Microphone

* Designed for Video & DSLR Cameras

« XY Stereo Capsules for Accurate Imaging
 Integrated Shock Mount with Shoe Mount
« Dual Shock Mount Design

« Adjustable Gain (-10 dB, O dB, +10 dB)

« High-Pass Filter at 80 Hz

« Durable Coiled Cable

* 3.5mm Stereo Output Connector

* Runs on Single AAA Battery

« 7" coiled cable with 3.5mm connector

G et st st st $184.95
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GEAR NO ENGINEER SHOULD BE WITHOUT

Gear for the Working Ear: Five Tools Every Engineer Needs

Who knows how it happened? Maybe the band chose you to record their DIY releases. Maybe you've been sketching demos out your whole life.
Maybe you inherited a panoply of gear from your quirky uncle Alfred. Whatever the case, you've already got the bases covered [the interface, the
computer, the midi-controller; etc.), but now you've got a real problem: you've been bitten by the bug—the engineering bug. You want to improve
your skill set and your efficiency. You need to procure a tight ecosystem of gear that'll get you from point A to point B as expeditiously as possible.
You feel this deeply, in your bones, and the question quickly becomes, “What do | buy next?”

Arranged into five categories, here are some basic tools no engineer should ever forego.

’I A Workhorse Microphone

If you're going to be recording
anything in your studio—anything
at all from drums to quitars,
from vocals to the sound of your
radiator rattling (sound design!}—
you'll need a microphone you can
count on, one that'll work when
everything else fails, be it aurally or
mechanically. For many engineers,
that mic has always been the Shure SM57-
LC, which in addition to working on guitars,
drums, and even vocals, also makes a pretty
good paperweight and decent hammer.
Seriously, you can use this mic on anything.

Alternative Monitoring Options

By now you have a fair idea of how your
usual monitors sound, and yet your mixes
never feel right when you give them a listen at
afriend’s place orinyour car. Why is this? Two
reasons: the sonic signature of your room,
which might influence what you're hearing for
the worse, and your speakers themselves, to
which you've become inured over time.

Look, you'll have to address your room
somehow. You'll have to treat it, or you'll
have to learn its deficiencies so deeply that
you can overcome them; most likely it'll be
a combination of both. In the meantime,
alternative monitoring options will dowonders
foryourworkflow: if the drums sound great on
your speakers, a secondary speaker system,
and three sets of headphones, chances are
they sound great—period.

Think about supplementing your main
monitors with a pair of Auratone 5Cs or
a single 5C Super Sound Cube for mono-
checks, because if theyre good enough for
Quincy Jones, they're good enough for you.

Diagnostic Tools

There is one absolute
law of every studio situation,
and that law is Murphy's
Law: anything that can
go wrong will go wrong—
usually when you've got a
deadline. Inthese situations,
you need to get granular and you need to act
fast. This is where equipment such as cable
testers come in handy.

If you've got a million cables set up but no
sound coming out whatsoever, you need to
know which cable is causing the headache.
For this task, check out the Kopul CBT-12 - 12-
in-1 Cable Tester; one solid-metal unit which
can test twelve different cable connections.

Software

Chances
are your DAW
came  with
some stock
plug-ins and,
yes,  some
of them are
quite  good.
While  pros
such as Dave Pensado and Jaycen Joshua
can get titanic tones out of the stockiest soft-
ware, it can take years of ear-training to coax
beautiful sounds out of middling algorithms.
In the meantime, check out Izotope Alloy 2 or
IK Multimedia T-Racks CS—affordable soft-
ware bundles publicly praised by engineers
like Pensado (in the case of Izotope) and Dave
Kutch (in the case of T-RackS). Both feature
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excellent EQs, dynamite compressors, suit-
able limiters, and comprehensive metering
sections, the latter being especially important
for expediting mixes.

The common consensus on the metering
within most DAWs is that it leaves much to be
desired. The same goes for stock plug-ins:
some are loved, but most are commonly re-
viled. These plug-ins, however, are vouched for.

Stuff You Already Own

You're not going to find any links to
gear pieces or landing pages here, because
chances are you already own a ton of stuff you
didn't know you could use. Case in point—
room treatment: bookshelves make excellent
diffusers, as the porously-paged books lining
them differ randomly in width, length, and
height. Those extra carpets you've got lying
around—why not line every inch of the floor
with them? You can get quite creative with
this. When | was a wee lad, | stacked all
my unused clothing in the corners because
| couldnt afford bass traps. Were they a
perfect solution? No! Of course not! But they
did reduce unwanted bass-bloom enough to
allow me to judge what | was hearing.

Besides your own two ears, the best thing you
already own is your entire music collection.
The tunes you know are the most important
tools in furthering your workflow. How? They
become your references: if you need your
snare to sound like Dave Grohls, then you
should probably slap on Nevermind or In
Utero and tweak your snare till it competes.
Put on your favorite record. Does it sound
like it did when you were a kid? No? Then
you know you've got more work to do on
your room. Conversely, listen to your favorite
record through a new pair of monitors.
Can you hear more details than you ever
remembered? Then maybe those new
speakers will provide a useful perspective.



I WU el LARGE DIAPHRAGM CONDENSER MICROPHONES

Large Diaphragm Condenser Microphones

A go-to mic choice for tracking vocals, voice overs, string instruments such as acoustic guitars and violins,
percussion, and more, B&H carries a wide variety of large diaphragm condensers to suit a variety of needs
and budgets. Available selections provide polar patterns ranging from supercardioid
(very narrow pick up path) to omnidirectional (360 degree pick up), while many can
handle SPL levels as high as 150dB for use on louder sound sources. Many selections

include stands, cases, and cables, and come in a wide variety of finishes.

I @audio-technicag b@p Cﬁ) ‘LEUJITT @ SCH?"‘I’E"E”S"‘

Model C214 CA14XLI P220 AT2020 AT2035 AT-4040 BlueBird | Baby Bottle SPARK E100S M179 LCT 240 V676 770
Diaphragm Size 1 1 1 63 96 Ea 98" 1.0 9" 1 (AN 67 1.26” 87
Polar Pattern Cardioid Multi Cardioid Cardioid Cardioid Cardioid Cardioid Cardioid Cardioid | Super Cardioid Multi Cardioid Cardioid Cardioid
Freq Response | 20Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 40Hz-18kHz | 10Hz-20kHz | 20Hz-20kHz | 30Hz-20kHz | 30Hz-20kHz
Dynamic Range 143dB 134dB - 124dB 136dB 133dB 130dB 128dB - - 133dB 130dB - -
S/N Ratio 13dB 88dB 78dB T4dB 82dB 82dB 7ThdB 76dB 84dB - 11dB 78dB 74dB 74dB
Pad -20dB  |-6db-12dB-18dB|  -20dB N -10dB -10dB N N N -10db -20dB -10dB, -20dB N -10dB
HP/LC Filter Y Y Y N Y Y N N N Y Y N N Y
Max SPL 143dB 140dB 155dB 144dB 148dB 145dB 130dB 133dB 128dB 150dB 143dB 166dB 130dB 137dB
Included Acc. SM, HC SM, HC, PF SM, CC SM SM,TA,PP | SM,HC, DC SM, HC SMPEWC | SM,PFWC SM, HC SM SM, WS, LB SM SM, CC
Color Black Black Black Black Black Black Blue Black Orange Black Silver-Gray Black Blue Black
SKU (AKC214) (AKCA14XLIN (AKP220B) (AUAT2020) (AUAT2035) (AUAT4040) (BLBBMQ) (BLBBMSP) (BLSPARK) (CAET008) (CAM179) (LELCT240) (MXV876) (MX770)
Price 399.99 1,099.99 149.99 99.00 149.00 299.00 299.99 399.00 199.00 | Callor Log-on | Callor Log-on |  199.99 85.38 74.99

Neumann sk Electronics

Model TLM 102 TLM103 U87 Ai/SETZ NT1A NT1Kit | NT2A Studio Pkg | X1 Studio Bundle | ~ SC-550X UB-440 SM27 KSM32/SL SU-017 B1 Cu-29
Diaphragm Size - - 1 1 1" 1" 1 - - 1" 75 1 1 -
Polar Pattern Cardioid Cardioid | Multi/Variable | Cardioid Cardioid Multi Cardioid = Cardioid Cardioid - Cardioid Cardioid Cardioid
Freq Response | 20Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 50Hz-18kHz | 20Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz
Dynamic Range 131dB 131dB 115dB 13248 - 140dB - 140dB - 128dB - - - -
S/N Ratio 87dB 87dB 82dB 132dB - 87dB - 79dB 60dB 84.5dB 81dB - 82dB 168dB
Pad N N -10dB N - -5dB, -10dB -10dB -10dB N -15dB -15dB - -10dB, -20dB -
HP/LC Filter N N Y N Y Y Y Y N Y N - Y -
Max SPL 138dB 138dB 117dB 137dB 132dB 147dB 125dB 1408 12548 152dB 148dB 12048 13248 138dB
Included Acc. MS, SM WC, SM WC,SM  |[PFXC,DC,DVD|  SM,DC  |PFXC,DC,DVD|  SM,PF SM, CC,PF | SM, MS, UC SM, PP SM, SM, HC |SM, 6C, WC, PS| SM,CC,WS | SM,CC, WS
Color Nickel Nickel Nickel Silver-gray RONTIKIT Nickel Black Black Black Black Champagne Copper Silver-gray Black
SKU (NETLM102STST)| (NETLM103A) | (NEUSAISZ) | (RONTTACRS) | (RONTIKIT) | (RONTZASSP) |(SEEXTMRFXRFC)| (SESC550X) (SEUBA40) (SHSM27LC) | (SHKSM32SL) | (S0SYZSUD17) (STB1) (TECU29)
Price 799.95 1,299.95 3,599.00 229.00 269.00 399.00 (CallorLlog-on|  129.99 129.99 299.00 549.00 3,499.99 119.99 1,295.00
INCLUDED 6C = 6-Pin Cable DC = Dust Cover LB = Leather Bag PF = Pop Filter SB = Stereo Bar TA = Threaded Adapter WC = Wood Case XC = XLR Cable
ACCESSORIES KEY:  CC = Carry Case HC = Hard Case MS = Mic Stand PS = Power Supply SM = Shock Mount UC = USB Cable WS = Windscreen

272 800-859-5252 + 212-444-5072




SMALL DIAPHRAGM CONDENSER MICROPHONES [z {eW:\V]sl[e)

Small Diaphragm Condenser Microphones

A mic locker standard that is at home in front of a variety of string or acoustic instruments, choirs,
drum overheads, and more, small diaphragm condensers are both excellent on their own and integral
companion mics to their big brother, the large diaphragm condenser. Available selections provide polar
patterns ranging from hypercardioid (very narrow pick up path) or omnidirectional (360 degree pick
up), with certain models handling up to 155dB of SPL. Many selections include stand mounts
and cases, and like large diaphragm condensers, they are available in a variety of finishes.

7 B .
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Behringer Earthworks
Model C451B/ST | C391BKit | C1000S P170 Pro 37 AT4053b AT2021 SCX1/HC | MB5050 -2 B-5 GXL-1200 P30 603S 550/551
PolarPattern | Cardioid | Cardod |VRCIOO0 conig | caod | MR o | MO caod | caion | O™ | cadod | Caod | Coiod | Cardiod
Freq Response | 20Hz-20kHz | 20Hz-20kHz | 50Hz-20kHz | 30Hz-20kHz | 30Hz-15kHz | 20Hz-20kHz | 30Hz-20kHz | 40Hz-20kHz | 50Hz-19kHz | 20Hz-20kHz | 20Hz-20kHz | 30Hz-20kHz | 9Hz-30kHz | 30Hz-20kHz | 30Hz-20kHz
Dynamic Range |  117dB - - - 112dB 1298 126dB 116dB - 140dB - - 72dB - -
S/N Ratio 73dB 77dB 73dB 75dB 65dB 78dB 75dB 20dB - 75dB 78dB 14dB 22dB 77dB 78dB
Pad -10db, -20dB | -10dB -10dB -20dB N -10dB N N N -10dB -10dB N N N N
HP/LC Filter Y - Y N N Y N N N N Y N N N N
Max SPL 135dB 142dB - 155dB 141dB 14548 145dB 130dB - 140dB 140dB - 14248 137dB 137dB
Included Acc. | MS, WS None WS, CC MS SM, WS, CC | MS,WS,CC | MS,CC None SA, WS, XC |SA, WS, SB, CC| MS, WS, CC None None SM, CC MS, CC
Color Nickel Matte Grey Black Black Black Black Black Black Black Nickel Nickel Gold Black Nickel Red
SKU (AKCABTBST) |  (AKC391B) | (AKC1000SN) |  (AKP170B) (AUPRO37) | (AUAT4053B) | (AUAT2021) | (AUSCXTHC) | (AUMBS5050) (BEC20) (BEBS) (CAGXL1200) | (EAP30CB) (MX603P) | (MX550551R)
Price 1,099.99 499.99 199.99 79.99 169.00 599.00 79.00 499.00 499.00 59.99 69.99 Log-on 669.00 134.00 82.99
Pyle Pro Sennheiser Studio Projects
Model 606 SKM184MT | KM 185 MT | PDMIC45 M3 M5 NT3 NT5 co2 Colette E614 MKH 50 SM137 C4 TM-PC1
PolarPattern | Cardod | Cadod | (P | Caiod | Caiod | Caiod | Caod | Caod | Caod | ST | St St gy | Catio Do g
Freq Response | 30Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 20Hz-16kHz | 40Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 20Hz-20kHz | 40Hz-20kHz | 4OHz-20kHz | 40Hz-20kHz | 40Hz-20kHz | 20Hz-20kHz | 40Hz-20kHz | 20Hz-20kHz
Dynamic Range . 12248 124dB . 121d8 . 128dB 128dB 112dB - - - 123dB - .
S/N Ratio 77dB 78dB 67dB 85dB 73dB = 77dB 78dB = 79dB = 12dB 75dB 78dB 78dB
Pad -20dB N N N -20db, -10dB N N N N N N -10dB 15dB -10dB 10dB
HP/LC Filter Y N N N Y N N N N N N Y N Y Y
Max SPL 137dB 138d8 142dB 149dB 142dB 140dB 140dB 143dB 134dB 128d8 - 134dB 137d8 150dB 132dB
Included Acc. | MS,CC | MS, WS, CC MS MS,XC | MS,WS,CC | MS,WS WS,CC | MS,WS,CC | SM,WS,CC | MS,WS,CC | MS,CC SM,WS | MS, WS, CC WS, CC SM, PF, CC
Color Silver-Gray Black Black Black Black Black Silver-Gray | Silver-gray Nickel Gray Black Black Black Gray Nickel
SKU (MX606)  |(NESKM184MT)| (NEKM185MT) | (PYPDMICAS) (ROM3) (ROM5MP) (RONT3) (RONTS) (SAC02) (SCCMC641S) | (SEE614) (SEMKH50) | (SHSM137) (STC4) (TATMPC12)
Price Log-on 1,599.95 899.95 22.00 149.00 199.00 269.00 429.00 Log-on 1,622.00 219.95 1,199.95 179.00 349.99 Log-on
CLUDED 6C = 6-Pin Cable DC = Dust Cover LB = Leather Bag PF = Pop Filter SA = Stand Adapter SM = Shock Mount UC = USB Cable WS = Windscreen
ACCESSORIES KEY:  CC = Carry Case HC = Hard Case MS = Mic Stand PS = Power Supply SB = Stereo Bar TA = Threaded Adapter WC = Wood Case XC = XLR Cable

www.BandH.com
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USB Microphone

» 16-bit/48kHz Resolution

» 4 Selectable Polar Patterns

» 1/8" Headphone Monitoring Jack
» Instant Mute

» Latency-Free Monitoring

» Desktop Stand, USB Cable

» Mac & Windows Compatible

[BLYETIQ) o

@ Snowball iCE
USB Condenser Mic
» Cardioid Pattern
» USB connectivity
» Fasy plug ‘n play - no drivers to install
» Mac or PC Compatible
» From desktop to laptop to iPad
» CD-Quality Audio
» Includes Stand and USB Cable ¢ °

.......Call or Log-on

[BLSBI) . 4999

@ Snowflake
Compact USB Microphone
» Professional-Quality Sound,
perfect for podcasters, musicians,
or movie editors
» Compact and Portable
Ideal for life on the road
» Good for Desktops or Laptops
» Mac and PC Compatible

(BLSF) ... Call or LOg-0R

MiC 96k

apocee USB Microphone

» Fori0S & Mac

» Up to 96kHz/24-bit Conversion

» 30-Pin & Lightning Compatible

» Multicolor LED Input Meter

» Plug-and-Play Setup

» Includes Lightning Cable, USB Cable

» Includes Table Top Stand & Stand Adapter

[APMICOOKLO) ..o 229,00

A U37 usB condenser
* Microphone

Aucio

» USB Connection to Computers
direct to Windows or Mac based computers

» Large Condenser Capsule

» -10dB Pad Switch reduces distortion and peaks
when capturing highly transient audio

» Low-Frequency Roll-0ff Switch
reduces rumble and other low-frequency noise

[CAUBT) . 4969

USB MICROPHONES

MXE: TempoKR

USB Condenser Mic

» USB Output to Computer

» Headphone Output for Monitoring
» |deal for Singing and Speech

» USB Powered

» Includes Desktop Tripod Stand

» Apple iPad Compatible

» Mac & Windows 0S

(MXTEMPOKR) ..o 10.00

UB-440
Professional USB Mic
» Cardioid condenser element
» 16-Bit/48kHz recording resolution
» Integrated preamp with variable gain
» Headphone monitor out with gain control
» Selectable 10dB pad
» Selectable high-pass filter at 80Hz
» Compatible with Windows, Mac, & i0S
» Includes stand, mount, & USB cable

(SEUBAAD) ..o 129,99

Mg~ Beecaster
NEAT  USB Quad-Capsule Microphone

» 24-hit/96kHz Resolution Capture

» 4 Proprietary Mic Capsules

» Multiple Selectable Patterns

» Integrated Boom Arm for Placement
» Plug-and-Play for Mac & PC

.. 349.00

(NEMICBCPDU)....ccccce

Mg~ WidgetA "
NEAT  Desktop USB Microphone |\ '-.\
» For Skype, Podcasts, Voiceovers, & Music
» Full-Range 24-Bit/96kHz Audio
» 20 Hz to 20kHz Frequency Response
» Integrated Internal Pop Filter
» Includes Internal Shock Mount
» Height Adjustable
» Compatible with Mac or Windows

-

(NEMICWADU) .o 99,00
SHURE MV5
Digital Condenser Microphone ey

» For Mac, PC, i0S, & Android Devices
» Suitable for Music, Podcasting, & Skype
» Built-In Real-Time Headphane Monitor
» Removable Desktop Stand

» Includes a Micro-B-to USB Cable

» Includes Lightning Cable

Black SHMV5BLTG) 99.00
Grey (SHMV5LTG) 99.00

USB Microphone

» 16-Bit/48KkHz Resolution Capture

» Cardioid Polar Pattern

» 1/8" Headphone Monitoring Jack

» Direct Mix Control  » iPad Compatible
» Includes Pop Shield & Tripod Desk Stand
» Includes Ring Mount, & 20" USB Cable

» Includes Storage Pouch

[RORODNTUSB) .. 169,00

USB Broadcast Microphone
» USB Connection provides direct connection
to PCs without additional hardware
» Built-in headphone input and amplifier
» Includes Stand Mount
» Cardioid Polar Pattern,
minimizing off-axis noise
and feedback.

. 229.00

[ROPODCASTER).....occ

@audio-technica. T2020USB+
Cardioid Condenser USB Mic

» 16-Bit Audio at 44.1/48kHz Sample Rate
» [ero-Latency Monitoring

» High-Output Internal Headphone Amplifier
» Mix Control Blends Input with DAW Audio
» Off-Axis Rejection for Clean Recordings

» Mac and Windows Compatible

» Includes Desk and Stand Mounts

[AUATZ020USBP)....ccccccc

SAMSON Meteor Mic
USB Studio Microphone

» USB Plug-&-Play Connection
» |deally suited for Apple iPad
» Integrated Tripod Stand

» Large 26mm Diaphragm

» Cardioid Polar Pattern

» 1/8” Headphone Output

» Headphone Level Control.

[SAMTR). oo 09,99

SAMSON GoMic

USB Microphone for Mac and PC

» USB Qutput

» Requires No Drivers

» 1/8" (3.5mm)
Headphone Output

» 4h.TkHz [ 16-Bit
Resolution

» Clip-on or Desktop Mount

SILVer (SAGMS) ... 3999

800-859-5252 + 212-444-5072




DYNAMIC, RIBBON & TUBE MICROPHONES

SHURE PGA52-LC Cardioid

Dynamic Kick Drum Microphone

» Dynamic Element Microphone

» Suitable for Acoustic Kick Drum
» Cardioid Polar Pattern

» 3-Pin XLR Output Connector

» Rugged Design » Internal Shock Moun
» Accessories Included

(SHPGAS2LC) 114.00
n D112 MKII
A Dynamic Bass Microphone

» Cardioid Polar Pattern

» Specialized for Bass Guitar/Drum

» Response tailored for bass guitar and bass
drum pickup, bath in the studio and on-stage

» Very Low THD ~ » Built-In Windscreen

» Response Maintained to 20Hz

» Built-In Swivel Mount

[AKDT12MKIN 199.99

PR40 Dynamic Cardioid
= Studio Microphone

» Large Dynamic Element
» Steel Housing

» Internal Sorbothane Shock Mount Er*_ﬂs_’-J
» Cardioid Pickup Pattern €
» |deal for Vocals and Kick Drums .

» Assembled in the USA =

PRO AUDIO

SHURE SM57-LC

Microphone

» Professional Workhorse Mic

» Dynamic » Cardioid Polar Pattern
» Bright, Clean Sound

» Extremely Durable

» |deal for Live Sound Reinforcement
» For Instruments and Vocals

99.00

(SHSMB7LC)

Dynamic Vocal Broadcast
Microphone
» Tailored for Vocal Capturing
» Cardioid Polar Pattern minimizes off-axis noise
» Internal Shock Mounting
» Internal Pop Filter minimize
handling noise and plosives
» AUl Metal Construction
(ROPROCASTER)....ooo- oo

i 229.00

[7] SENNHEISER e409
Microphone

» Dynamic Element Microphone

» For Instrument Capture

» For Guitars & Sound Reinforcement

» Supercardioid Polar Pattern

» Excellent Off-Axis Rejection

» Hum Compensating Coil

» Rugged Design, Internal Shock Mounting

SHURE SM7B

Cardioid Dynamic
Announcer Microphone

» For Professional Voiceover
Applications
» Flat, Wide-Range
Frequency Response
» Air Suspension Shack Isolation
» Pop Filter Built-In -~ » Cardioid Polar Pattern
(SHSM7B)

349.00

Electro-Voice RE20
Cardioid Dynamic Voiceover
Microphone

» Tailored response for vocals

» Rugged, steel construction with low handling noise
» Supercardioid polar pattern

» Internal Windscreen, internal blast and wind filter
» Bass tilt down switch

» Flat Frequency Respone

[ELREZD) cvvovvvviireiie e 449.00

MXL BCD-1

Broadcast Dynamic Microphone
» High quality dynamic mic built for
broadcast and voice-over productions
» Excellent side rejection
» Built-in Isolation Shockmount
» Cardioid Polar Pattern ~ » Tuned Filter
» Includes Windscreen

[MXBEDT) . 169,95

(HEPRAO) ... CallorLog-on (SEE609) 109,95
RIBBON MICROPHONES
R1 Active MKIII RODE NTR
Active Ribbon Microphone Active Ribbon Microphone
» Classic Ribbon Mic Sound » Figure-8 Polar Pattern
» Active Circuitry Provides Higher Output » 20 Hz to 20kHz Frequency Response
» Ultra-Realistic Reproduction » 130dB Maximum SPL
» Fast Transient Response » 1.8 Micron Ribbon Element
» Bipolar/FET Discrete Low-Noise Amplifier » Internal Shock Mounting System
» Uses 48V Phantom Power » Includes Ribbon-Securing Travel Screw
» Handles Up to 160dB SPL » Custom-Designed and Manufactured Transformer
(GORTACTMK3) (RONTR) 799.00

CU-29 copperhead Tube

Condenser Microphone
» NOS Telefunken Tube
» Custom Qutput Transformer
» Cardioid Polar Pattern
» External Power Supply

[TECU29) . 1,295.00

Fat Head
Ribbon Microphone

» Hand-tuned ribbon element

» True figure 8 pattern

» Balanced audio input signal to both
sides of the ribbon assembly

» Suited for guitar cabinets, drum over-heads,
vocal, piano, horns, strings and more

In Brown/Gold (CAFHBGR)

TUBE MICROPHONES

1.0"” Condenser Microphone

» Large-Diaphragm Condenser

» Class-A Tube Circuitry

» Mylar Dual-Diaphragm Capsule
» Jensen Transformer

» 9 Polar Patterns

» Separate Power Supply

» Uses +48V Phantom Power

AVANTONE CV-12
Condenser Microphone

» Dual 32mm Gold Sputtered Capsules

» Hand Selected 6072A Tube Output Stage
» Variable Polar Patterns - 9 Stages

» Pad Attenuation Switch: -10dB

» Low Frequency Roll-0ff: 80Hz

» External Power Supply

» Custom Retro Shockmount

[AVEVI2)




PRO AUDIO

SHURE S5M58-1C
Cardioid Handheld Dynamic Mic

» Frequency response tailored for vocals

» Built-in pop filter

» H0Hz-15kMhz Frequency Response

» Unidirectional cardioid pickup pattern 50Hz to 15kHz
frequency response » Break-resistant stand adapter

» Available with or without on/off switch

(SHSMB8LC).... IR ..99.00
SM58S M|cr0phone vvnh Swﬁch [SHSMBBS] ... 104.00

SHURE KSM8 Dualdyne
Dynamic Handheld Vocal Mic

» For Live Sound and Recording

» Two Ultra-Thin Diaphragms

» Accurate Frequency Response

» Cardioid Polar Pattern  » Flat Off-Axis Attenuation
» Pneumatic Shock Mount ~ » Carbon-Steel Grille

Black (SHKSMAB) . 499.00
Nickel (SHKSMGN) 499.00

@ enCORE 300
Handheld Condenser Mic Kit
» Aria Condenser Capsule
» Cardioid Polar Pattern
» Transformed Output
» Natural Vocal Reproduction
» Minimal Handling Noise
» Clarity and Detail

(BLE300) 159.99

. HANDHELD PERFORMANCE |

HANDHELD PERFORMANCE & HEADSET MICROPHONES

Black (NEKMS105NI)...

Eld Electro-Voice ND76
Dynamlc Cardioid Vocal Mic

» For Live Sound and Recording

» Shockmounted Capsule

» Memraflex Grille Resists Denting

» Neodymium Magnet

» Humbucking Coil Guards Against Line Hum

(ELND76CM)

/I SENNHEISER §35S
Cardioid Handheld Dynamic Mic

» Metal construction - rugged and reliable

» Shock-mounted capsule

» Cardioid pickup pattern

» Hum compensating coil reduces electrical interference
» Neodynum ferrous magnet with boron

» Falcon ring - consistent sound over time

KMS 105
Live Vocal Condenser Mic
..699.95
129.00
99.95

(SEE835)

SHURE SM31FH Fitness Headset
Condenser Microphone
» Designed for Fitness
Instructors
» Hydrophobic Fabric
Protects Mic
» Flexible Gooseneck
» Cardioid Polar Pattern
» Includes Windscreen

[SHSMBTFHTAG) . 9900

» Durable and thin metal frame

» Ergonomic design and comfortable fit

» Offers maximum stability to the user. Tiny 0.1 x 0.3" lightweight
capsule. Extendable, fully adjustable gooseneck boom

NIADY  HM-5U

Unidirectional Condenser
Headset M|crophone

» Unidirectional electret
condenser microphone

(NAHMSUA) 29.99

AUDIX om2

Dynamic Hypercardioid
Handheld Microphone

» Provides excellent vocal isolation on stage
» Superior off-axis rejection

» Dent resistant steel spring grill

» Added warmth in the lower mid-bass

» Zinc alloy/fusion coating

» Handles high SPL without distortion

[AUOM) . 99.00

XM8500 Dynamic
oehringer  ULTRAVOICE Microphone

» Ultra-professional dynamic vocal microphone
» Internal shock mount system

» Cardioid polar pattern

» Two-stage pop filter

» Ultra-low distortion for a super clean sound
» b0Hz-15kHz frequency response

» Microphone stand adapter included

[BEXMBB00) .. 19.99)

D5 Handheld Supercardioid
Dynamic Vocal Microphone

» Supercardioid polar pattern

» Dual shockmount capsule

» Patented AKG Laminated
Varimotion Diaphragm

» 70Hz-20kMHz frequency respanse

» Rugged Construction

» Includes: Stand Adapter, Pouch

(AKDB) . 99,99

» K105 Supercardioid Capsule
HEADSET MICROPHONES

» Low Self-Noise
» Built-in high-pass filter
» 132 dB dynamic range

» Transformerless

» Good Pop Shielding without Side Effects

» Includes Stand Clamp

T RS2TRR Isomax

Headset Microphone

» Cardioid Polar Pattern -4
» For Wireless Transmitters /

» Moisture Resistant

» 1/8" (3.5mm) Locking-mini for Sennheiser
» Miniature Unobtrusive Design

» Flexible Boom for Easy Positioning
» 20Hz-20kHz Frequency Response

Beige (COMHOWSLSR) 284.95

SAMSON SE10T omnidirectional

Head Worn Microphone

» Micro-miniature condenser with 3mm capsule
» Omnidirectional pickup pattern )"
» Fits left or right ear

» Moisture resistant coating

» Detachable cable

» Four cable adapters for wireless transmitters

» Includes: 3 windscreens, clothing cable clip & carry case

(SASENOT) i 99,99

(/1) audio technica. PRO 8-HEX

Headworn Dynamic Microphone

» Professional Quality Vocal Pickup
with Hands-Free Operation

» Hi-Energy Neodymium Element

» Low Visibility Headband Provides
Stable, Comfortable Fit

» Pivot Mounted Flexible Mic Boom
Descends from Left or Right Side

(AUPROBHEX] 79.00

y C520

Headworn Condensor Microphone
» Adjustable Behind-the-Neck Headband

» 20Hz to 20kHz Frequency Response
» Cardioid Polar Pattern
» Adjustable Gooseneck for
Easy Microphone Positioning
» XLR Terminated
Microphone Connection
[AKEB20) e 1. 219,99

A

800-859-5252 + 212-444-5072




BOUNDARY , HANGING & GOOSENECK MICROPHONES

@audio-technica. PRO-44 Hemi-Cardioid
Condenser Boundary Microphone

» Low profile for minimum visibility

» Wide-range condenser element

» Rugged design and construction

» Self-contained electronics eliminate
need for external power modules

» Low-mass diaphragm for superior performance

[AUPRO44) 99.00

1COLSTIC '!u wrc Voice Tracker I

Array Microphone

» Ideal for Voice Recognition
» Listening Beam Technology
» Coverage Throughout

A Large Room
» Optional USB Power Adapter

» Mac & Windows Compatible

BOUNDARY MICROPHONES

PRO AUDIO

A U7 use Boundary
° Condenser Microphone

» Great for conferences and meetings
» USB output for direct
connection to computer
» Omnidirectional polar pattern
» The low-profile design
» Frequency response tailored
for speech capture

(CAU7)

@ crown PCC-160

Phase Coherent Cardioid Microphone

» Industry Standard Stage
Microphane

» Half Super-Cardioid
Polar Pattern

» XLR Connection

» Phase Coherent Pick Up

» Rugged Design  » Compact Dimensions

SHURE MX393/0 Microflex
Omnidirectional Boundary Microphone

» Flat frequency Response Across the Vocal Range

» Interchangeable Cartridges that Provide a
Choice of Polar Pattern for Each Application

» Programmable Mute Button

» Balanced, Transformerless Output

» LED indicator » Logic Input/Output

» Sleek, Low-Profile Design  » RF Filtering

(SHMX3930) 219.00

MXL AC-404

Portable USB Conferencing Microphone

» Low Profile Design

» 180 Degree Coverage

» No Drivers Needed -
Plug and Play

» 3 Capsule Boundary Design

» Mac & Windows Compatible

(ACVTHAM). oo 342,00
VOICE TRACKER I Array Microphone (ACVTIAM) .................... 243.10 (CRPCCT60) . 349,99 [MXACAOA) e 1149
GOOSENECK MICROPHONES
(D) audio technica. PRO45 SHURE MX2028C NLAD»Y ' 0HCM-200
.. . . MX202BC Hanging Microphone Overhead Hanging Microphone
Cardioid Condenser Hanging Mic - ) )
» Perfect for suspension over choirs and orchestras : E/la.rq‘?d P(;larf'Fl’attern : Eve(;hgzdPSlgnaF)l (t?tapturmg
» Wide range condenser element with Hi-SPL handling N In[T;seUFr’efearmO;;e N LS\:v»II(\]/IIassOE?)rndSnsee[rnElement
> Low massAdiaphragmfolr supgripr performance » 30" Cable & Stand Adapter » Miniature Profile
’ ]‘Se“ cgnta\[]ed electm(rjncls eliminate need » Wide Frequency Response » Attached 20" Cable
or external power modutes » Impervious to RF Interference with XLR Connector
» Flat, smooth frequency response » Includes Hanging Wire Mount
» 25" XLR cable permanently attached
Black (SHMX2028C) 185.00
[AUPROAB) oo 99.00 White (SHMX202WC) ... 185.00 (NAOHCM200B) oo 61,35
ioi COUNTRYMAN y
AUDIX. ADX40 (.:ardIOId ASSOCIATES, INC Isomax 2 CHM 9.9 . h,
Overhead Condenser Microphone Audience and Choir Microphone Hanging Microphone
» Cardioid Polar Pattern » Miniature and Versatile » Cardioid Polar Pattern
» Miniature Profile » Cardioid Polar Pattern » Especially suited for choir recordings
» Wide Frequency Relsponse » High Sound Pressure Handling » Freqouepcy Response: 70Hz to 18kHz
» External Preamplifier / Power Module » Excellent gain before feedback » 125° pickup angle
» Includes: MC40 wire hanger » Pristine Audio Quality » Adjustable Hanging Clamp
& 30 foot cable » -40dB Headroom » 33" Cable
» 10 Cable with 3-pin XLR : \&_\"“u
(AUADX40) 189.00 (COM2CP410) 239.95 White (AKCHM99W) 149.99
HANGING MICROPHONES
SHURE MU18C DD autotectica PRO-490 carcioia EA D) Matic72-18
18" Cardioid Gooseneck Microphone Condenser Gooseneck Microphone [~ _ = " Miniature Dynamic
» Wide dynamic range & frequency response Gooseneck Microphone
» Interchangeable cartridges * Cardioid Polar Fattém » |deal solution for general speech applications
» Fixed-charge back plate, » 18" Flexible Gooseneck
» Balanced,transformerlless output permanently polarized condenser » Cardioid Polar Pattern
> Shock mount that provides » Frequency Response: 70Hz-16,000Hz » Quiet Positioning
over 2008 solation > 16.46" length > 3-pin YLR base > d-pin KLR Comnector Base
» Locking flange mount » Quick Connect and Release » Durable dent resistant screen
(SHMXATBC) oo 206,00 [AUPROA9QL) oo 119,00 (AST2TU8) oo 6900

www.BandH.com




(e \U[p][ol} MIC STANDS, BROADCAST ARMS & POP FILTERS

SAMSON MK10
Lightweight Boom

& rome s meven 210/9

Tripod Microphone

Mic Stand Stand with ™
» Ultra lightweight, ideal for travel \ Telescoping Boom
» Sturdy steel construction, » Stable_ and_stur_dy steel

collapsible for portahility materlal with zinc
» Folding tripod base die-cast base
» Rubber feet » 2-piece telescopic
» Adjustable height boom arm
» Mic clip included ',,-—4<
(SAMKIO) o 19.99 (KM2109B) oo 69.95
RODE PSA-1 MXL: BCD-Stand
Studio Boom Arm Desktop Microphone Stand
for Broadcast Microphones » Articulating arm and
» 32" Horizontal Reach swivel action
» 33" Vertical Reach » 12 built-in XLR cable
» Touch-Fastener » Screw and clamp

Cable Wraps mounts will secure
» Desk-Clamp Included the stand onto desks
» Desk-Insert Hardware e and workstations

in broadcast studios and
voice over studios. 2

[ROPSAT) . 99.00 (MXBDCS) oo 52,89
SHURE PS-6 auray  PFN-6

Popper Stopper Pop Filter

» Reduces Noise Due to

Plosive "p" and "b" Sounds

» 6", 4-Layer Screen

» Includes Adjustable Gooseneck
and Microphone Stand Clamp

[SHPS6) 29.49

6" Nylon Pop Filter
with Gooseneck
» Thumb-screw fastener
» Attached 13.5"
gooseneck for
flexible
positioning
» Minimizes annoying pops, and dampens
excessive sibilance in recordings.

[AUPFNG) .. 18,95

UL TIN AT E S-DMS50

UuPPORT

Table-Top Mic Stand

» Height Adjustable from §” to
12.25" with Reliable Turn Clutch

» Durable, Scratch-Resistant,
Powder Coated Finish

» Non-Slip Rubber Ring on
Bottom of Base

» Solid Die-Cast Round Base

[ULISDMSB0) . 14,99

Atlas DS-7E
/Sound agjustable
Round Base Desk Stand

» Variable Height Adjustment
between 8" - 13"

» §” Cast Iron Round Base

» Grip-Action Clutch

» Non-Reflective Black Tubing

» Weighs just 3Lb

» Quality Construction Assures Extended
Service and Quality Appearance

[ATDSTE) .. 30.50

MIC STANDS

BROADCAST ARMS

POP & REFLECTION FILTERS

FLOOR & TABLE STANDS

auray  MS-5130
Round Base
Microphone Stand

» Telescoping Shaft with
Ergonomic Clutch

» Weighted Round Base

» Non-Slip Rubber Feet

» Durable Steel Construction

[AUMSB130 . 19.50

auray  MS-5230F

Tripod Microphone
Stand with Fixed Boom

» Multi-Angle Boom Arm

» Telescoping Shaft with
Ergonomic Clutch

» Reinforced Tripod Base

» Non-Slip Feet

» Durable Steel Construction

» Portable, Collapsible Design

A

(AUMSB230F) . 21,99

"W\ ¢ wieco. ProBoom Elite

Microphone Arm System

» For Broadcast Studios,
Voice-Over
Production, |
Announcer i
Booths, and More ‘P\i

» Noise Free Springs

» Extended Length of 45"

» Exclusive Cable Channgl

[0CTA199BC) . 199,95

auray  BAE-2X

Two-Section Broadcast Arm
with Integrated XLR Cable

» For Radio Broadcast,
Podcast, Voiceover

» Smooth, Noise-Free
Positioning

» 100° Front to Back
Movement

» Extends up to 407 1

» C-Clamp and Surface Mount Included

(AUBAEZX) . 89,99

W

ﬁﬁ% Halo
X} Refletion Filter
» Vertical and Horizontal Filtering
» Corrugated Surface
Diffuses Sound
» 4" Radius
for Sound
Isolation
» Portable and
Lightweight

...299.00

[ASTHALD).....occccccc

auray RF-5P-B

Reflection Filter

» Compact Microphone
Isolation Solution

» Absorbs Unwanted
Room Noise
and Reflections

» b-Panel Perforated Aluminum Screen

» Adjust Side Panels for Varied Isolation

» High Density Pyramidal Acoustic Foam

» Mounts to Straight or Boom Mic Stands

e 149,99

[AURFSPB) ..o

QUIKL®K A-188

Desktop Microphone Stand

with Tripod Base f

» Folding Tripod Legs

» Rubber Microphone Holder

» Adjustable height between
43 t06.7"

» |deal for general
speech capturing in broadeast,
recording and public-address applications.

(QUATBB)....oo . 10,09

auray  TT1-6220
Telescoping Tabletop
Microphone Stand

» Telescoping shaft for
adjustable height

» Weighted round base

» Five, non-slip rubber feet

» Microphone cable guide

» Durable steel construction

.__

(AUTT62208) ... 12,00

800-859-5252 + 212-444-5072
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K&M KONIG & MEYER
N=7 Stands For Music

SHURE
(=]

Hosa Technology.

\X/INOTecH

[whirlwind|’

PEARSTONE

&

SESCOM

DINKUM

SYSTEMS

To view a full listing
of all Microphone
Accessories

SCAN THIS CODE

or visit our website
BandH.com/w15295

MICROPHONE ACCESSORIES

Whether you need a clip for your hand-
held dynamic, small diaphragm con-
denser, or shotgun mic, B&H's selec-
tion will provide you with what you're
looking for. Ranging from rubber to
plastic and clothespin style, we have
a variety of clip options to select from.

On-Stage MY200

Clothespin-Style Plastic
Microphone Clip

(ONMY200) ..o 59D

Prevent your mic from being plagued by
vibrations from your stand or mount by
incorporating shockmounts from B&H's
wide selection. Regardless of what
kind of mic you're using, whether it's a
large diaphragm condenser, a small di-
aphragm condenser, a dynamic or cam-
era-mounted shotgun mic, our website
has a vast array to suit your needs.

W

Auray SHM-UC2
Clamping Suspension
Shockmount

(AUSHMUCD) ... 29.99

Whether you're capturing audio in the
studio, in ENG environments, or work-
ing with live sound, it's inevitable that
you're going to have to attach one piece
of equipment to another. B&H stocks a
large selection of clamps, mounts, and
brackets, ranging from the common to
the unique, ensuring that your acces-
sory needs are covered.

CLAMPS, MOUNTS & BRACKETS

K&M 237B
Adjustable Table Clamp
with 5/8” Threaded Bolt

(KM237B) . 1499

Don't et mismatched threads keep you
from connecting your gear to stands or
cameras. Regardless of whether you're
trying to connect a mic to a stand or
an accessory to your camera’s shoe
mount, B&H's ample thread adapter
options will help keep your gear con-
nected.

THREAD ADAPTERS

AKG KM216 Black
3/8” Male to 5/8”
Female Thread Adapter

[AKKM216B)............c...cc......... 6.00

B&H's selection of in-line accessories
provides a variety of solutions to com-
mon everyday issues found in studios
or ENG scenarios. Ranging from in-line
attenuators, to phase switches, gender
changers, ground lifts, and more, our
in-line accessories section has the
solution you're Looking for.

IN-LINE MIC ACCESSORIES

Senal XU-1648
XLR Input to USB
Output Interface

(SEUT648) ... 89.00

CLIPS

SHOCKMOUNTS

PRO AUDIO

Om

QuikLok MP892

Small Rubber Mic Clip
for Wired Microphones

(QUMPB9Z)....oco

1.99

r

Shure A25D

Stand Adapter for
SM58/57/87 & Beta 87

(SHAZBD) . 699

i

WindTech SM-2

Microphone Suspension

Shock Mount

(WISM) oo 22,99

§

Shure A53M
Shock Mount
Microphone Clip

(SHAS3M) ... 38,00

i

\

Dinkum Systems 3013
FlexiMount On-Stage MMO01
Ball-Joint Mic Adapter
0I3013) . 49.00 (ONMMOT) . 9,95
s 3
il
Auray Combo Audio-Technica AT8469
Male to Female Reversible Camera Shoe Mount
Thread Adapter Adapter
(AUADCOMBOS)........................ .95 (AUATB489) ... 13.75
DS
Hosa GXX145 Shure A15AS
3-Pin XLR-F to 3-Pin In-line Switchable
XLR-F Adapter Attenuator
(HOAXFXF) oo 523 (SHATBAS) ..o 37.99




(o :\V[p][el8 MIC PREAMPS & CHANNEL STRIPS

Focusrite ISAONE

Microphone Preamp

» Independent gain control,
output for routing to an
amp, independent XLR
output on the rear

» Independent DI

» Four switchable input-impedance levels

» Headphone output with volume control

499.99

[FOISAONED ..o

Clasim = I1]
8-Channel Microphone Preamp

o o f st I e P, ol Aol

e A e B e O WS e (e -

P ;
» 8 MIDAS XL4 Microphane Preamps
» Per Channel Phantom Power and 20dB Pad
» MIDAS XL4 Low- and High-Pass Filters

» 8-Segment LED Meter per Channel

» Low Latency 24-bit/96kHz A/D Converters
» AES and ADAT Output, 1U Rack Chassis

(MIXL4B)

899.00

6176

wers e Channel stl’ip

» Classic sound of the legendary 610 modular console

» Ultra quiet operation  » Independent Channel Functionality
» Classic 1176LN compression  » Shelving EQ's

» Internal switching power supply

[UNBTT6). £,499.00

LINDELL. AUDICY. 18Xs Mkl

Channel Strip

» Single-Channel Mic Pre, DI, & EQ  » Class A Line Amplifier
» Pultec-Influenced EQ Design  » Up to 65dB of Gain
» Mix Knob for Parallel Processing  » Output VU Meter

(LIT8XSMK2) oo 89999
MIC100 ULTRAGAIN PRO
venringer Tube Mic Pre and Direct Box
» Tube mic/ling preamp with L
integrated limiter s .

» 12AXT vacuum tube

» Phase reverse switch, 20dB pad

» +48v phantom power, Wide-range
input gain and outputlevel adjustment.
Balanced 1/0 on 1/4” TRS phone and XLR connectors.

[BEMICTOO) e 9999

280 800-859-5252 + 212-444-5072

’@%@A o TB12 Tone Beast

W] =1y} Microphone Preamplifier

» Mic, Instrument, & Line Inputs

» Up to 71dB of Gain, Output Gain Attenuator

» Switchable Discrete Op Amp, Switchable Input Impedance
» Switchable Output Transformer, Switchable Capacitor

» 48V, Polarity Switch, 20dB Pad

(WATBT2).. 999,00

8y

B173 Single-Channel
= Microphone Preamplifier

» Based on the Neve
1073 Preamplifier 3

» Discrete Class A
Circuit Design

» Input and Output Transformers

» 12-Step Gain Control, +12 to +80dB Gain

» Qutput Level Control, Microphone/DI Input Switch

» Phantom Power, 1RU 1/2 Rack Chassis

. 649,00

(BLSCMPRAMP) ..o

AVALON [{)) pEsicN Mb
Microphone Preamp

» Mono » Large VU Meter
» Pure Class A Design

» Minimal Signal Path o @ 8
» |deal for Vocals & Acoustics -
» High-Performance Input Transformer

» DC-Coupled Pure Class A Output

» Variable High-Pass Filter, Sealed Silver Signal Routing

(AVMSB) o 1,665.00
5052 Microphone
Mreay "] £ srsians preamplifier and
= Inductor EQ

» 12-Way Rotary Mic Gain from 0 to 66dB

» Continuously Variable Trim Control

» Switchable +48V Phantom Power

» Polarity Switch  » Silk and Texture Controls
» Square-Core Transformers

» Discrete Class-A Component Design

[RUBDBZ) .

{15 PreSonus TubePre v2
Tube Preamplifier/DI Box

» Single Channel
» Preamp and DI
» Solid State Preamp L
» Phantom Power,

High-Pass Filter
» Phase Reverse, Backlit VU Meter
» Rugged and Compact Enclosure

» Balanced & Unbalanced 1/0
» 12AXT Vacuum-Tube Stage

(PRTUBEPREVZ) . 129,99

GIRACE m1m

D € s 1 G n

Microphone Preamp with Ribbon Mic Mode

» Fully balanced,
transformerless,
single-channel SR
microphone preamp with optimized DI instrument input

» Built in switchable 75Hz, 12dB/8ve high pass filter

» Precision 12-position, gold contact, rotary switch gain control

» 10 to 75dB gain range, 10dB output trim controls

» Switchable 48V phantom power

[BRMIOT)c 105,00

PRE-73 MKII
1073-Style Microphone Pre
» Vintage, 1073-Style
Electronics
» NoCs In the
Signal Path
» Mic, Line, and Instrument Inputs
» Mic Input Has Switchable Impedance
» Input and Output Controls, Solid Build Quality

. 049.99

[BOCMPBAMKZPLY.....cc

Solid State Logic XLogic Alpha Channel

souND || visionN Recording Channel

o T e
» Mic preamp with line level and Hi-Z instrument input switches
» "Variable Harmonic Drive” circuitry

» High-pass filter with selectable 40

» 80 or 120Hz cutoff frequency

» Three-band SSL parametric EQ, with mid-frequency Q control

[SOAC) i 1,229.00

db . 286s
x Mic Preamp/Channel Strip
B B i B B BB BB BB,

» Phantom Power
» Insert Jack
» Meters

» De-Esser
» Enhancer
» Expander/Gate

» Single Channel
» 4 Processors
» Compressor

199.95

(DB286S)

A2 2T Tybe MP Studio V3

Tube Microphone Preamp

» V3 technology which presets that
allow you to select between
preamp settings designed for
quitars, keyboards, drums,
vocals and more.

» OPL (Output Protection Limiter)
accurately controls and maintains the output peak signal.

[ARTMPSVE) ..o 98,99



COMPRESSORS & EQUALIZERS

Stereo Variable MU

Limiter Compressor

» Sound of the Original Variable MU » Hardwire Bypass Switch
» Hand-Wound Custom Nickel Transformers ~ » All-Tube Design
» Large Illuminated Sifam Meters  » Stereo or Dual Mono

» Side-Chain High-Pass Filter ~ » 6x Tubes per Channel

AR
MANLEY
B

(MAMSLCHP)... oo

i 3,960.00

AL_F_T ProVLAIl

Compressor/Leveler

» Two-channel,
tube-based E
leveling amplifier

» Hand selected 12AT7 output tubes, Stereo linking of channels

» XLR balanced inputs and outputs Variable Threshold and Ratio
controls. Variable Output Level rotary controls

» Ten-segment Gain Reduction LED array » Rack-mountable

(ARPROVLAII) 269.00

BBLI.@ MaxCom Compressor

Sound Inc. and Limiter with Gate

» Two channel compressor/expander with gate

» Peak limiter to protect from clipping

» Dynamically controlled, program adaptive gate

» Built-in BBE Sonic Maximizer. “Auto” mode for easy setup
» Stereo link for phase-coherent stereo compression

COMPRESSORS

PRO AUDIO

db _ 166xs
x Compressor/Limiter/Gate

#9.0.8.00.8 9.0.9.9.9.0 9.8 0,0,

» Dual Channel  » Stereo or Dual-Mano
» PeakStop Limiter » Classic dbx "Auto” Mode
» Side Chain Insert  » Separate LED Displays

(DBTBXS). . 239,95

| ASHLY [t

Compressor/Limiter

» Stereo or dual mona operation of compression with side chain
access, Extremely low noise and distortion

» Dual release time for minimizing “pumping”

» Powerful peak control with minimum audible side effects

» Both XLR and 1/4” input and output connectors

(ASCLX52) 335.00

ROILLS CL1516LC Compressor/Limiter

with Microphone Preamp

» Compact compressor, limiter gate
with mic preamp, Soft-knee
compression/limiting

» Noise Gate with Threshold and Release

» 12V of phantom power available

» Balanced inputs and outputs

» Side Chain for detector circuit access

COMP-3A
Vintage Style Compressor & Leveler
» Program-Dependent am e
Compression -~
» Geared Toward
Project Studios
» Selectable Metering
» High-Frequency Side-Chain Circuit  » XLR & 1/4" TRS
Jacks > Transformer-Balanced Inputs & Outputs

p— LA ]

(GOCOMP3A) .o

Ll WAT76

Discrete FET Compressor

U ARG

AUUJDIO

» Single-Channel g
Limiting
Amplifier

» Ultra-Fast Attack Time. "All Buttons In" Feature

» CineMag Input and Output Transformers

» Class-A Line-Level Output Amplifier

» Gain Reduction or Output Meter  » 19" Rackmount Chassis

(WAWA76) 599.00

MDX2600 Compressor/Limiter
vehringer With Gating & Tube Emulation

» Adjustable dynamic enhancer

» Interactive gain control peak limiting, Switchable de-esser
» Automatic or manual adjustable attack and release times
» Servo balanced XLR and 1/4” TRS inputs and outputs

(BEMDX2600) 129.99

(BBMAXCOM) Call or Log-on (ROCL151) Call or Log-on
EQUALIZERS
PRE-73 MKIIl Plus Ll EQP-WA
@um.c@m Pultec Style Tube Equalizer

with Carnhill Transformers

» §0dB of Gain  » Tantalum Capacitors in Signal Path
» Selectable HF AIR Boost at 30kHz ~ » 4-Step LED Meter

» Selectable 40 or 170Hz HPF - » Mic/Line Gain Switch Selection
» Similar Circuit to Classic 1073 » Switchable Phantom Power

(6OPRE73MK3PL) 499.99

@3 PYLE" PPEQ100
PR Dual 10 Band Stereo Equalizer

g | =

» Blue LED Lights for Easy Visibility
» Four Audio Inputs

» VFD Display Screen

» Removable Rack Brackets

[PYPPEQT00) . 68UT

» Recreation of Pultec EQP-TA » Five Added Frequency Points
» Fully Discrete Design  » Aesthetics and Sonics of the Original
» CineMag Transformers and Premium Tubes  » No Insertion Loss
» Bypassable EQ Section  » Flat Response from 20 to 50,000Hz

(WAEQPWA) 699.00

Ultracurve Pro DEQ2496
vehringer Digital EQ/RTA Mastering Processor

» FDU(COHCUUGntly’m
selectable
e modues = | Y S
» High resolution
sixty-one band FFT analyzer
» Flexible compressor/expander function
» Separate RTA microphone/line with phantom power

(BEDEQZA9) ... 299,99

. 231s Dual Channel

db! 31-Band Graphic Equalizer

. T TR )
AT .
R AR

» Dual Channel, 2 x 31-Band

» 1/3 Octave. Switchable Boost/Cut Range
» 20mm Sliders  » 4-Segment LED Ladders

(DB23TS) . 199,95

AL E0-355

Graphic Equalizer

» Dual Channel 31-Band
» Constant Q Filtering
» XLR and 1/4" Balanced and RCA Unbalanced Connectors

[AREQ355)..oc. 189,00




PRO AUDIO

TASCAM. DP-24SD
Digital Portastudio

» Record up to 8 Tracks Simultaneously

» Records to SD/SDHC Cards .

» 19 Faders

» 2b-bit/h8kHz
Resolution

» Up to 24 Track Playback

» 8 Combo XLR/TRS Mic Inputs

» Built-In Mixing & Mastering Effects

(TADPZASD)...ccc

DENON DN-700R

Network SD and USB Recorder

- S - Iniimiiniiniinl @
» Web Remote Setup and Control
» Automatic or Timed FTP File Archiving

» IP, RS-232c, GPIO, USB Keyboard Control
» Records to SD/SDHC and USB Media

» MP3 and WAV at 24-bit/96kHz Resolution
» XLR, RCA, and AES/EBU Audio Connections

(DEDN700R0

599.00

Rack Mountable USB/SD Recording Deck

» USB Flash Drive / SD Card (up to 32 GB), RCA, 1/8” (MP3] Inputs
» RCA (Line Out) Output  » USB 2.0 Compatible

» Frequency Response: 20Hz-20KHz +3dB

» Plays .mp3, .wav, .wma files from USB drives and SD Cards

» 20Hz-20KHz +3dB Frequency Response

[TEURECT) .. 06,98

KORG KP3+

Dynamic Effects/Sampler

» Manipulate Effects in Real-Time
» XY Touchpad » 150 Effects
» 4 Sample Banks

» 8 Program Memories
» Hold Function  » USB MIDI
» Store Samples on SD/SDHC Cards
» Mac0SX » Windows XP/Vista/7/8

[KOKPBPLUS) .o 205,99

VIRTUALIZER 3D FX2000
ehringer 3D Multi-Engine Effects

SHTESSsS BN -

» 71 Algorithms with true RSM stereo and 3D effects

» Wave-adaptive virtual room reverb algorithms

» Multiple modulation, dynamic, psychoacoustic and EQ algorithms
» 11 effect-combinations with selectable serial/parallel configuration
» Extensive MIDI Implementation

[BEFK2000) o 129,99

TASCAM. DP-008EX
8-Track Digital Pocketstudio

» Dual Omnidirectional Microphones 4
» XLR and 1/4” TS Inputs .
» Mini USB 2.0 Output

» Includes 26B SD Card
» Records WAV Files at 16-Bit/44.TkHz
» Onboard Channel, Reverb and Mastering FX
» Integrated Metronome and Tuner  » RCA Stereo Line Qutput
» 5.5 Hours of Operation on 4 AA Batteries

(TADPOOBEX) - 119,99

UI30SS BR-800

8-Track Portable Digital Audio Recorder

» 4-Track Recording, 8-Track Playback
» Stereo Condenser Microphone
» Records to SD/SDHC

» Integrated Effects

» Drum Machine with Editor

» USB Audio Interface and DAW Control
» Cakewalk SONAR 8.5 LE Software

(BOBRDD) . 549,00

747/ 7 27 SDR-4000 Dual Digital
USB / SD Audio Recorder & Player

» Dual-Digital Recording to SD & USB Drive

» Dual Playback  » SD Card Slot & USB Port
» RCA & XLR Connectors

» 1/4" Headphone Jack on Front Panel

» Toggled Output ~ » Slim 1RU Chassis

(VOSDRADOO). ...

|exicon MX300

Stereo Reverb Effects Processor

J—A A A

» Stereo/dual-mono reverb/delay processor with USB connectivity

» S/PDIF digital input/output  » Five effect-routing options
» Sixteen legendary Lexicon reverbs
» Provides delay and modulation effects, dbx compression and

de-essing  » Includes MX-Edit Editor/Librarian software
(LEMXB00) . 269,99

ALESIS NanoVerb 2

Digital Effects Processor

NANOVER® 2

» 16 programs, with 16 variations each, for a total of 256 presets
» Analog wet/dry mix control  » Signal/clip LED control

» Adjustable input and output gains  » Minimized signal patch
» Create stereo effects from mono input signal

» Rugged, compact design  » Bypass control with footswitch

(ALNZ) . 99,00

DIGITAL RECORDERS & EFFECTS PROCESSORS

=MV rs

8-Track Digital Recorder/Interface/Controller/Sampler

» 8-Track Recordert

» Writes to SD Cards

» 16 or 24-bit WAV files
» Integrated Stereo Mics
» High-Definition USB Interface
» Full Mixing and Transport Contrals
» 8-Voice Pad Sampler and Sequencer

» XLR/TRS Combo Inputs with 48V Phantom

i 299.99

=MV R16 Multi-Track Recorder

& Mixer, Computer Interface & Controller

» USB 2.0 Computer TR e
Interface and Controller O
» Field Recorder and
Portable Mixer 1
» Built-In Stereo Condenser Mics &
» AC or Battery Power for b Hours of Use
» Supports 3268 SD Cards  » Mac & Windows Compatible

[ZORTO). . 399,99

gemini DRP-1

Rackmount Digital Audio Recorder

» Slim 1U Rackmount Design  » XLR, 1/4”, and RCA Inputs
» XLR and RCA Outputs  » Color LCD

» Records to USB or SD Card

» WAV and MP3 Recording

» Headphone Jack with Level Control  » Jog Wheel

[BEDRP) e 138,48

t.c. electronic M350 pual Engine

Multi-Effects and Reverb Processor

T ] ' FTT.
i_eee@ceiooocdEml

» Dual engine multi-effects and reverb processor

» 15 reverbs and 15 effects with b seconds of delay

» Full DAW integration through VST/Audio Units compatible editor

» Can function both in dual send/return or serial patching setups

» Tap tempo using pedal input

(TCMBB0) - 143,03

AIRAVT-3

Voice Transformer

» Real Time Vocal Processing
» Dedicated Pitch and
Formant Sliders
» Reverb and Mix Balance Sligers
» Three Favorite Settings for Recall
» Optional Footswitch Connection
» XLR/TRS Combo Jack with +48V
» Stereo or Wet/Dry Qutputs  » Built-In USB Audio Interface

[ROVTS) i 199200

800-859-5252 + 212-444-5072




CD RECORDERS, CASSETTE RECORDER/PLAYERS

TASCAM. CD-RW900MKII

Professional CD Recorder

» High-Performance AKM Codec  » Digital and Analog 1/0

» Gapless Live Recording  » Various Track Division Functions
» 4 Second RAM Buffer Prevents Skipping

» Auto Start/Stop Record at Preset Level

» Fade-In/Fade-Out Recording Function

(TACDRWIOOMKZ) .. 969,99

TASCAM. CD-RW901MKII

Professional CD Recorder

» High-Performance AKM Codec  » Balanced Analog 1/0

» Digital /0 » ISRC/RID Code Display Function

» Gapless Live Recording  » Various Track Division Functions
» Fade-In/Fade-Out Recording Function

[TACDRWIOTMKZ) . 669,99

TASCAM. CC-222MKIV

Professional CD Recorder/Cassette Combo

» Record Cassette Tapes to CD-Rs; Record CDs to Cassette Tapes
» Phono Input for Recording Vinyl Records

» Simultaneously Record to CD and Tape

» Independent I/0 for CD & Cassette  » Analog and Digital I/0
» High-Performance AKM Codec  » Wireless Remote Controller

[TACCZ22MKIVY . 699,99

TASCAM. CD-A550mkl

CD Player and Cassette Recorder

» Record to Cassette from CD » Shock-proof memory
» CD-R/CD-RW Support, MP3 & Wav File Play

» CDText & ID3Tag » CD-Tape continuous play

» Auto Cue, Auto Ready, Cue Call and Incremental Play

379.99

(TACDABBOMKI) o

@Né CAS1500
Cassette Player/Recorder

» Cassette Playback and Recording

N,

» Durable ABS Construction

» Integrated Mic and Speaker
» Large, Sturdy Buttons

» 2.5mm/3.5mm Remote Mic Inputs
» AC or Battery Power  » Volume Control )
» Dual 1/4” Headphone Jacks  » 500mW Amplifier

[CACAS1B00) ... 99,9

TASCAM. CD-200iL

Professional CD Player

» Lightning & 30-Pin iPod/iPhone Dock  » Pitch Control Function
» Higher Quality D/A Conversion  » Stereo Mini Jack Input

» 10 Second Skip-Proof CD Drive Buffer  » Headphone Output

» Continuous, Shuffle, and Program Modes

(TACD200IL) . 349,99

DENON DN-501C

CD and Media Player

» Slot-in CD Drive

» USB Mass Storage Device Playback
» Direct Digital Playback from iPod/iPhone
» Balanced XLR Analog and Digital AES/EBU

» Dedicated CUE button  » OLED High Contrast Display
» Program Play  » 3-Phase Brush-less Spindle Motor
» IR and RS-232c Controllable

(DEDN501C) 399.00

DENON DN-501C

Balanced CD and Media Player

» CDDA/WAV/MP3/AAC/AIFF Audio File Formats

» Slot-in CD Drive  » USB Mass Storage Device Playback

» Direct Digital Playback from iPod/iPhone

» Balanced XLR Analog and Digital AES/EBU  » Dedicated CUE

button  » Program Play » OLED High Contrast Display
(DEDNSOTC) e 399,99

Qﬁpyu: PT649D Rackmountable

Dual Cassette Player

» Auto Stop
» Dynamic Noise Reduction

» Normal and High Speed Dubbing

» Cr02 Tape Selector  » 3 Digit Tape Counter

» Recording Level Control  » Rec/Play Level Meters

(PYPTOAID) .o 19,99

To view a full listing of all
CD Recorders & Players

or visit our website
BandH.com/w15299

PRO AUDIO

CD-2u

SD/CD Recorder

» 2x Combo XLR/TRS Mic
Inputs with 48V
» Built-In Stereo Mics
» Built-In Speaker System
» Stereo RCA Line Inputs
» Record Directly to SD/SDHC Cards or CDs
» Playback Speed and Key Adjustment  » 1x 1/8” Mic Input
» Built-In Tuner and Metronome ~ » Includes Wireless Remote

699.00

[ROCD2U)..eee

DENON DN-30028

Media Player

» Balanced XLR Audio Outputs  » Wireless Playback via Bluetooth
» AM/FM Tuner with Dedicated Audio Qutput

» Plays CD-DA, MP3, WAV & AAC Files

» Supports USB Thumb & HDDs, SD/SDHC Cards

» Super-Fast Loading, Slot-In CD Player

[DEDN3DOZB).. . 39900

DENON DN-5008D

TRU Professional Blu-ray Disc Player

» Controllable with included remote, RS-232C, or over IP

» Supports nearly all Blu-ray, DVD, and audio CD formats

» Display hiding mode eliminates unwanted status visuals

» Discrete 7.1 analog surround sound outputs

» Front-loading USB slot for playback of image and audio files

[DEDNSOOBD) . 399,00

><10M TAPE2PC USB

Cassette-to-MP3 Converter

» Mac/Windows
Compatible

» USB 1.1 Connection

» Dual Cassette Deck

» Metal/Cr02 Tape Type Selector

» Converter Software Included

» Requires Internet Connection
» Display Shows Audio Meters and Record and Dubbing Status

106.95

(IOTAPEZPC..cece

><10M Tape Express+
Portable Tape-to-MP3 Converter
E——

» Easily transfers cassette audio to a
computer using the included
USB cable  » 1/8" audio
» EZ Vinyl/Tape Converter software outpu
» Battery or USB-powered with a portable design to play and
transfer anywhere (sold separately)  » Includes Headphones
» Load MP3s into your digital music Library or onto a mabile player

(OTEH) . 94,99



[ {o:\VU[p][ely STUDIO MONITORS

Studio Monitors

Monitoring is one of the most important purchases you can make

for your studio, and B&H offers a large selection to cater to just
about every scenario and taste. Choose from a variety
of active (self powered) or passive (requiring an external
amplifier] monitors with woofers ranging from 3" to

8" can be chosen from. Available models also provide
connectivity for RCA, 1/4", 1/8" XLR, Speakon, or binding
post sources, with many models providing integrated
volume control.

O\

behringer

JBL

ADAM

PROFESSIONAL AUDIO

TFOCAL

THE SPIRIT OF SOUND

£
L2

auray lsolation Pad for studio Monitor

The Isolation Pad from Auray is a monitor speaker isolation
pad made from high-density acoustic foam. It is designed
to decouple your monitor's speaker from its resting
surface by absorbing the monitor’s vibrations. This
stops reverberation through the desk or speaker
stands, therefore preventing unwanted resonance.
Removing these unwelcome vibrations results in greater depth of field, tighter low end
and transient response, and a higher level of detail across the frequency spectrum.

SMALL 7.5 x11.25" (AUIPS) 15.00
MEDIUM 10.25 x 14.5” (AUIPM) 16.00
LARGE 12.75 x 12.75" (AUIPL) 17.00

MACKIE. [({ GENELEC”

@ rostex ©YAMAHA M-AUDIO" (Il PreSonus TANNOY

BRAND MODEL STQLRL/E SIZE gﬂ}"’;ﬁ CONFIGURATION | SHIELDED CONNLTOR cvoor%T”r:doEL 'Csooéﬁl'ﬁglme SKU PRICE
ADAM ATX SINGLE 7 1500 2-WAY VES XLR. RCA N0 Ip-M (ADATX) 749.99
BEHRINGER MS16 PARR v oW 2-WAY N RCA, 114", 116" Yes Ip-s (BEMST6) 79.99
BEHRINGER MS40 PAR v o 2-WAY YES | RCA. 1", SIPDIF TOSLING YEs Ip-M (BEMSAD) 179.99
FOCAL ALPHAS0 | SINGLE 5 B0 2-WAY YES XLR, RCA NO Ip-M (FOALPHASD) | 299.00
FOCAL CMS65 | SINGLE | 65" 1600 2-WAY YES XLR, RCA NO Ip-M (FOCMS6S) 795.00
FOSTEX 630INE | SINGLE e 250 FULL-RANGE N XLR 14" YES Ip-5 (FOG30INE) 29.99
GENELEC 8010 SINGLE y 250 2-WAY YES XLR N Ip-5 (GEBOT0AP) 350,00
GENELEC 8020 SINGLE v o 2-WAY YES XLR N Ip-5 (GEB020CPM) 575.00
GENELEC 80308 SINGLE 5 B0 2-WAY YES XLR N0 Ip-5 (GEBO30BPM) 799.00
JBL LSR35 | SINGLE 5 aw 2-WAY YES XLR. 14" N Ip-M (JBLSR305) 149.99
JBL CONTROLZP |  PAR 535" W 2-WAY VES XLR, 14" N Ip-s (JBC2PS) 209.00
JBL LSR38 | SINGLE § oW 2-WAY YES XLR, 14" N Ip-M (JBLSR306) 29.99
KRK ROKITS63 | SINGLE 5 50 2-WAY YES XLR, 1/4", RCA N Ip-s (KRRPEGNA 149.50
KRK ROKIT563 | SINGLE 5 500 2-WAY YES XLR, 1/4", RCA N Ip-s (RRPSGIWNA) | 149.50
KRK ROKIT663 | SINGLE ¢ 730 2-WAY VES XLR, 1/4", RCA N Ip-M (KRRPEGINA) 199.50
KRK ROKIT863 | SINGLE y 100W 2-WAY YES XLR, 1/4", RCA N Ip-M (KRRPBGINA) | 249.50
MACKIE CR3 PARR y 780 WY VES RCA, 104", 118" N Ip-L (MAZ0AGO2900) | 99.99
MACKIE CRA PARR v 780 2-WAY YES RCA, 114, 1/8° N0 Ip-5 (MAZOAGO3O0D) | 149.99
MACKIE MREMK3 | SINGLE | 575" 5O 2-WAY Ve XLR, 1/4", RCA N Ip-L (MAMREMK3) 149.99
M-AUDIO AV 4D PAIR v 20 2-WAY VES RCA, 114", 1/8" YES Ip-s (MASPAVADZG) | 149.00
PRESONUS | ERISEGS PAIR 45 250 2-WAY YES RCA, 114", 1/6" NO Ip-s (PRELS) 199.95
PRESONUS ERISES | SINGLE | 575 700 2-WAY VES XLR, 1/4", RCA N Ip-5 (PRERISES) 149.95
SENAL ASM-3 PARR y 28 2-WAY YES XLR N0 Ip-5 (SEASMS) 349.00
SENAL ASM-4 PAR 2 W 2-WAY YES XLR NO Ip-5 (SEASMA) 549.00
SENAL ASM-5 SINGLE 5 700 2-WAY YES XLR N0 Ip-M (SEASMS) 42999
TANNOY | REVEALLDZ | SINGLE 2 50 2-WAY YES W NO Ip-M (TAR402) 104,07
YAMAHA MSI0 | SINGLE v 10w FULL-RANGE YES RCA,1/4° Yes Ip-s (YAMST013) 149.99
YAMAHA MSP3 SINGLE v 200 2-WAY YES XLR, 1/4", RCA N Ip-s (YAMSP3 149.00
YAMAHA Hs5 SINGLE 5 700 2-WAY Yes XLR, 14" No Ip-s (VAHSE) 199.99
YAMAHA Hs8 SINGLE y 1200 2-WAY VES XLR, 14" No Ip-M (VAHSE) 349.99

284 800-859-5252 + 212-444-5072



STUDIO MONITOR ACCESSORIES

‘Auralex Monitor Isolation Pads

acoustics for Pair of Speakers

Sometimes easy solutions provide benefits
that far outweigh the cost. In this instance,
isolating one’s monitors from what they are
standing on, be it speaker stands or the
meter bridge of a console, can provide an
instant improvement in bass response

and stereo imaging.

{5 PreSonus Monitor Station V2
Desktop Studio Control Center

A monitoring and communication system that allows you
to switch between 3 sets of studio monitors and 3 input
sources. It features a built-in headphone amplifier with
four 1/4” headphone outputs, each with dedicated level
control, making it suitable for a variety of recording,
monitoring and mixing applications. For communicating with the talent, the Monitor Station V2 is equipped
with a built-in electret-condenser talkback microphone with input-gain control and talkback button.

299,95

XENYX CONTROL1USB

vehringer Studio Control & Communication Center

The XENYX CONTROL1USB from Behringer is a comprehensive
solution for control room monitoring and for communicating
with the talent in the studio. The controller places master
volume, talkback, source selection and monitor controls
front and center, while having the ability to choose from

up to three sets of active studio monitors, and four different stereo input sources to create custom moni-
tor mixes. Plus a built-in talkback microphone can be routed to headphanes or for slating a two-track.

e 99.99

(BECONTROLTU) ..
MIZA

z a 0 D-Stands, Pair (Black/Cherry)

The black/cherry MIZA D-Stands from Zaor are a pair of height adjustable
modular speaker stands that have been designed to put the sound
of your speakers at a desirable height on your desktop. They can
also be used to prevent the transfer of speaker cabinet energy to
surrounding surfaces for applications such as home recording,
mixing, studio post production, and more. Notably, the height

of the stand is adjustable from 7.76” to 11.10".

A

[ZAMZDSTBKCHE]....o. e

LTI N AT E JS-MS70

UuPPORT

Studio Monitor Speaker Stands

An ideal solution for small project, home, or mobile studios, JS-MS70
stands have stable low-profile bases with a triangular shape that can
be positioned into tight areas. The stands come with leveling floor
spikes for carpeted areas and rubber feet for use on hard floors. The
top platform measures 9" square and has Tmm thick non-slick strips
to keep your monitor speakers in place. Each stand can be adjusted
to 4 different heights for terrific customization.

[ULISMSTO) e 19,99

www.BandH.com

Toview a full listing
of all Studio Monitor
Accessories

SCAN THIS CODE

or visit our website
BandH.com/w15301

PRO AUDIO

@ Palmer cudio tools MONICON

Passive Monitor Controller

Monicon Passive Monitor Controller is a passive mini mixer
with an oversized control knob that is designed to be inserted
between the sterea output of a natebook, PC, or audio interface
and the inputs of a pair of active studio monitors. The fully passive
circuit design ensures that the sound is not detrimentally affected
by the monitor controller. To accommodate both professional and
consumer equipment, the rear panel of the device features pairs of XLR/TRS combo connectors for the
input and output as well as an 1/8” TRS stereo input and an 1/8” TRS stereo output connector.

99,98

IMIACKIE. BIGKNOB

Control Room Monitoring Distributor

A compact tabletop control room speaker selector and
router unit, that effectively replaces the monitoring
section of a mixing board in the often console-less
professional and project DAW recording studio. The BIG KNOB switches are all equipped with activity LED
indicators, and the built-in Talkback mic, dual Headphone outputs, and main Studio Outs all provide an
independent volume control knab. The rear panel Monitor and Studio Out connector sections, in addition to
each of the source inputs, are equipped with individual trim controls, as well.

t.c. electronic Level Pilot

Analog Stereo Volume Control
The Level Pilot from t.c. electronic is a high-quality
analog stereo volume control that provides you with
precise control over your levels without cluttering

your desk. Constructed from aluminum, the Level Pilot has a slip-free design
and a tight grip rubberized bottom plate to keep it from sliding on your desk.

In order to keep clutter minimized, the Level Pilot requires no power supply, and employs quad-core cabling. The
connectors are standard 3-pin XLR, allowing the Level Pilot to connect to virtually any mixing station or DAW.

auray LMS-355

Studio Monitor Stands

Constructed from steel tubing and a 9" steel plate, these stands are designed
to support studio monitors at the optimal listening position in professional and
home recording studios. An ergonomic locking knob secures the stand and a
locking pin is inserted into six pre-drilled holes to allow the height of each
monitor to be adjusted between 35 and 58.5". The three-leg design has a base
spread of 23" for stability and a geometry that allows for the stand to it around
corners and beside studio furniture. They come with bath interchangeable
rubber feet for hard wood floors as well as metal spike feet for carpeted floors.

QOOOOARCGOSY. 360i Speaker Stand

with IsoAcoustics Isolation Technology

Comprised of 5/4” powder-coated substrate for
stability and resilience, these 36” high Iso Acoustic-
enhanced stands allow you to adjust the speaker
angle up to 6.5° up or down. They feature die-cut
side panels and beveled edges. The mounting
platform is 7-3/4 x 9-7/8", and the base is 16 x 16"

ra
Lld

(ARPAIRBO0IBY ... 309,99
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™~ ULTRASONE 880

Performance Series Headphones

» 40mm Titanium-Plated Driver
» Circumaural Sound-Isolating Design

» Leather and Velour Earpads with Foam
» S-Logic Plus and S-Logic EX

» S-Logic Natural Surround Sound
» Two Detachable 3.5mm Cables

(ULTPERFB80) ... Call or LOg-0n

T FOCAL Spirit

Professional Headphones

» Closed-Back Design
» 40mm Drivers  » 32 Ohms
» Memory Foam Ear Cups
and Headband
» bHz-22kHz Frequency Response
» Detachable Coiled Cable
» Includes Carrying Bag

[FOSPIRITPRO). .o 949,00

SMH-1000 professional
Field & Studio Monitor Headphones

» Closed-Back, Over-Ear Circumaural Design
» Rugged Design for Field and Studio Use
» EQ Curve For Pro Field and Studio Use
» Collapsible For Easy Storage

» Soft Replaceable Ear Cushions

» 10 Coiled, 3" Straight Cables Included
» 1/4” Gold-Plated Adapter Included

[SESMHTO00) .. 89,99

SMH-1200 Enhanced

Studio Monitor Headphones

» Closed-Back, Over-Ear Circumaural Design
» Detachable, Twist-Locking, Cable Design
» Slightly Boosted Lows for Defined Bass
» EQ Curve for Music and Monitoring

» 40mm Neodymium Drivers 4

» Extra Deep Replaceable Ear Cushions

000

Onyx (SESMH12000X) ..o L 149.99

SMH-500

Professional Studio Headphones

» Designed for Light Field and Studio Use
» Closed-Back, Over-Ear Circumaural Design
» Soft Replaceable Ear Cushions
» Refined EQ Curve
» 10 Attached Coiled Cable
» /4" Gold-Plated Adapter Included
» 3-Year Limited Warranty
49.99

[SESMHB00) ...

HEADPHONES

A AUDEZE E-8

Magnetic Planar Headphones

» Neodymium Planar Magnetic Transducers
» Closed Circumaural Design

» 10 to 50,000Hz Frequency Response

» Fazor Technology Focuses The Sound

» Uniforce Diaphram for Reduced Modes

» Industrial Design by BMW DesignWorks
» Includes 1/8” to 1/4” Adapter

(AUZOOEBTTTB0) o

Lola
Over-Ear Isolation Headphones

» b0mm Fiber-Reinforced Dynamic Driver
» Sealed Over-Ear Design for Isolation

» For Music Production or Just Listening
» 15 Hz-20kHz Frequency Response
» Multi-Jointed Headband

» 42 Ohms Impedance

» Designed for Comfortable Fit

699.00

White (BLLOLAWD ...

SONY MDR-7510

Professional Studio Headphones

» 50mm PET Diaphragms

» Neodymium Magnets

» Closed-Back Design

» Around-Ear Cushions

» Adjustable, Padded Headband

» Single-Sided OFC Cable

» Gold-Plated 3.5mm Plug and 1/4" Adapter

[SOMDR7S10)....occcccccccss e 109.99

&

@audio-technica. ATH-M50x

Monitor Headphones

» 45mm Neodymium Drivers

» Circumaural, Sound-Isolating Design

» 90-Degree Swiveling Earcups

» Single-Ear Manitoring

» Detachable Single-Sided Cable

» Includes Straight, Coiled, & Short Cable
» Includes Pouch & Screw-0n 1/4” Adapter

(AUATHMBOXB) ..o .-169.00

«"  HPC-A30

POLSEN" Studio Monitor Headphones

» Studio, Field, Mobile & DJ Applications Q
29.99

» b0mm Drivers  » Pivoting Ear Cups
» Closed-Back for Isolation

» Collapsible For Easy Storage

» Padded Adjustable Headband

» Single-Sided 9.8" Cable

» Includes 1/4" Adapter

[POHPCABD) .t

7 sennHEISER HD 280
Circumaural Closed-Back Monitor
Headphones

» Circumaural, closed-back headphone

» Leatherette Cushions

» Padded, Adjustable Headband

» Collapsible, rotating earcups

» Standard 3.5mm Plug with 1/4” Adapter

(SEHD280P) ... e 99.95
HD 380 Pro Circumaural Momtormg Headphones [SEHDSBUP] .11.9.95

SHURE S5RH1540

Premium Closed-Back Headphones

» 40mm Neodymium Drivers

» Alcantara, Slow Recovery Foam Earpads
» Closed-Back Design for Noise Reduction
» Detachable Oxygen-Free Kevlar Cable

» Aluminum & Carbon Fiber Construction
» Padded Dual-Frame Headband

» Includes Extra Cable & Pair of Earpads

[SHSRHTBAD) ..o

SONY MDR-7506

Professional Studio Headphones

» Circumaural closed-back stereo headphone
» Ideal for use in professional applications

» 40mm diameter driver

» mpedance: 62 Ohms

» Compact, foldable design

» Coiled cable allows for better mability

» 1/8" mini-jack & 1/4"TRS phono connectivity

[SOMDRTEO)......coc

Call or Log-on

v K 240 professional
Semi-Open Stereo Headphones

» Semi-Open, Circumaural Design
» Self-Adjusting Headband

» Patented Varimotion Speakers
» Thick Around-Ear Cushions

» Single-Sided Detachable Cable
» Standard Stereo Mini Plug

» 1/4" Adapter Included

[AKKZAOSTUDIO) ..o M

N K553 Pro
Closed-Back Studio Headphones

» 2" (50mm) Transducers

» Closed-Back Over-Ear Design

» 12 to 28,000Hz Frequency Response
» Extra Large Soft Ear Pads

» For Monitoring, Mixing, Mastering
» Includes 1/4" Adapter

» Fold Flat 2D-Axis Mechanism

» Passive Noise Isolation

[AKBBIPRO) .o

800-859-5252 + 212-444-5072




behringer

HEADPHONE AMPLIFIER, DACS & ACCESSORIES

Powerplay Pro-8 Headphone
Ampilifier Distribution System

» 8-Chann

el headphone amplifier with 8 hannel output

» Dual independent Main inputs, Mano or Stereo

» Invividua
» Ultra hig

| Mono monitoring switches for all 8 channels
h frequency response up to 150 kHz

» High quality, detented ALPS potentiometers, rugged and precise

» Individually Itluminated switches

behringer

» 4 Indepe

(BEHABODD) ..o
HA-400
Headphone Amplifier
ndent Stereo Qutputs i
ntrol Per Channel B

» Level Co

» Ultra Compact
» Power On LED
» DC 12V Adapter

Included

[BEHAGDD).....ooc

FiiO

Stereo

E6
Headphone Amplifier

» Compact and Lightweight

» Power, V

» 3.5mm 1/0 Jacks

» USB Cha

» Integrated LED provides
visual EQ status indication
» Rechargeable Lithium Battery

olume, and EQ Controls

rging

(@ audioengine D3
24-Bit USB Digital to Analog Converter

» USB Bus

» Up to 24-

» Built-In

» Dual Clo

ck Asynchronous Data Transfer

» Metal Injection Molded Aluminum Case

» Compati

i komic ameven Headphone Holder

» Soft Rub

» Screw Clamp
» Fits Tubes up to 30mm in Diameter

(KM160808)

ble with Mac and PC

1

ber-Covered Construction
» Slotted Front

aurday  Earpads

» Soft Padded Cushions for Senal SMH-100
SMH-500, Sony MDR-7506 & MDR-V6 and
Audio-Technica ATH-M30 Headphanes

Pair (AUEPMDR7508) ...

» Switchable power supply
149.99

24.99

Powered Thumb Drive DAC 0 .‘/
bit 96 kHz Audio Resolution
Headphone Amplifier >

» Drives Low Impedance Headphones

49.00

0&

13.95

A2 LT HeadAmpé
6-Channel Stereo Headphone Ampilifier

» Professional rackmount 6-channel headphane amplifier

» Stereo XLR and 1/4” TRS inputs  » Aux input section

» LED 8-segment level meter  » Front and rear panel 1/4”
main outputs  » Mix and balance controls for each channel

» Front-panel 1/4™ Aux input for quick input override

» 4 operating modes; Stereo, Mono Left, Mona Right, or Mono Bath

149.00

(ARHA®)

A2 T HeadAmpé

Stereo Headphone Amplifier

» High-quality Headphone Amplifier

» Stackable metal construction

» 4 channels, with up to two
users per channel

» Both 1/4” and 1/8" connectors
are available for all I/0s

» Four level control knobs on the front panel

65.00

(ARHEADAMPA ..o

FuO E10K
DAC Headphone Amplifier
» Handles PCM Files up to 24-bit/96 kHz
» Front-Panel 1/8” Headphone Output

» Selectable Bass Boost
» Coaxial Digital Output
» Micro USB Connector

» 1/8" Line Qutput

» Bus Powered

(FIETOK) i 19,99

audioquest. pRAGONFLY

Flash drive sized Digital-Audio Converter
» Improved Circuitry from Version 1

» Plugs Into an Available USB Port

» Provides Improved Sound Quality

» 24-bit ESS Sabre Conversion Chip

» 1/8" Jack Outputs Directly to Headphones
» Decodes Resolutions up to 24-bit/96kHz
» Can Also Feed Preamp or Power Amp

(AUDRAGONFLYT) oo 148.79

To view a full listing of all
Headphone Amps & DACS

SCAN [oEHO
ad:
=

or visit our website
BandH.com/w15335

THIS
CODE

PRO AUDIO

HPA-4X2 Reference
POLSEN" Headphone Amp

» For Pro & Project Studio Applications
» Durable & Compact Design

» 1x 1/6" TRS Stereo Input

» 4-Channels » Stereo RCA Inputs
» 4y 1/4" Stereo Headphone Outputs

» Link Feature Daisy Chains Multiple Units
» Independent Amp Circuits Per Channel

» Stereo/Mono Switch

(POHPA4X2) ... - ..39.99
HMA-41 4- Channel Stereo Headphone Ampllfler [PUHMAA ] 24.99

PYLE' PHAL
PR( Stereo Headphone Amplifier

» Compact and lightweight design

» Up to 4 users to listen to the
same audio signal

» 4-Channels

» /4" Stereo Jacks

» Individual Level Controls

» Power LED  » Power Supply Included

14.99

[PYPHAGD).....ooc

{15 PreSonus HP4
Headphone Distribution Amplifier

» Four High Power Headphone Outputs

» Convenient Controls

» Separate Volume Control,
Monitor Mute Switch
and Mono Switch

» Modular Add-On

» 4-Channels

129.95

A\ AUDEZE Deckard
Headphone Amplifier and DAC

» Class-A Amplifier

» Front Panel Volume Control and Switches

» 16- to 32-bit DAC

» Up to 384 kHz

» Mac and
Windows

699.00

[AUBOTMAZTION) o

auray Headphone Holder

Clamp on for Mic Stand

» Holds 2 Pairs of Headphones  » Sturdy Metal
Construction  » Fits Stand Diameters Up to 1.2"

(AUCOHH) .o
1/4” Stereo Adapter

PEARSTONE Screw-On
» Male 1/8” to Male 1/4” » Gold-Plated Construction

2.99

.9.99

(PEAMPS3S).....c e



o :\V[p][ol8 AUDIO INTERFACES

XU-1648
XLR-to-USB Interface

» XLR Input to USB Output

» Microphone Input Level Adjustment

» Switchable 48V Phantom Power

» Monitoring with Balance Adjustment

» 1/8" Headphone Output with Level Control
» ero-Latency Monitoring  » Peak Level Indicator
» Rugged Metal Chassis  » USB Cable Included

[SEUTOAB) .. 8900

U-PHORIA UM2
behringer 2% 2 USB Audio Interface

» Up to 48kHz Sampling Rate

» XENYX Mic Preamp with 48V

» Stereo RCA Outputs

» Selectable Direct Monitoring

» Front Panel Combo XLR/TRS Mic/Line Input

» DAW Software Download with Registration

» 1/4" Headphone Qutput  » Front Panel 1/4" Instrument Input

(BEUM). . 29,99

U-PHORIA UMC404HD
vehringer USB 2.0 Audio/MIDI Interface

» 4 Input/4 Output
» MIDAS-Designed
Microphone Preamps

» Headphone Out, Zero-Latency Monitoring  » USB Bus Powered
» Analog Inserts and MIDI1/0 » 48V Phantom Power

» Status, Signal and Clip LEDs ~ » 24-bit/192kHz

» DAW Software Download Included  » Mac 0S X, Windows

[BEUMCADAHD) ... 99,99

. .
audient D14
High Performance USB Audio Interface

» 2x Class-A Preamp and 1x JFET Instrument

» 24-bit/96 kHz Burr Brown AD-DA Converter

» Low Latency DSP Mixer  » Monitoring Software Control
» ADAT Digital Expansion [

» USB 2.0 Bus Powered (3l -
» iD ScrollControl Mode
» Main Speaker Qutput v
P —— ]
(AUIDTA) . 299.00

ALESIS 02 Express
USB Audio Interface

» 2-Channel

» 24-Bit [ 48kHz 4

» 48V Phantom Power ’

» USB Bus Powered

» /4" TRS Insert Connection

» 1/4" Phone Line & XLR Mic Input
» Includes Cubase LE Software

e 19,99

[ALIOZE). s

288 800-859-5252 + 212-444-5072

Icicle
USB Microphone Interface

» Plug and Record - No Special Drivers Required

» Built-in Studio Quality USB Microphane Preamp
» Supplies 48V Phantom Power for Condenser Mics
» Fully Balanced Low Noise Analog Front End

» Analog Level Control

» Phantom Power Active Light

» Includes 6" USB Cable

(ICIELEQ o=

(BLICICLE). oo Calll O Log-0N

{5 PreSonus AudioBox USB
Audio Recording Interface

» 2 Input/2 Output

» Portable

» USB1.10r2.0

» Studio One Artist
Software Bundle

» Mac 0S X

» Windows XP/Vista/7

(PRABUJ... 99,99

{15 PreSonus Studio 192 Mobile
Audio Interface/Studio Command Center

» Pristine Audio Up to 192 kHz ~ » Zero-Latency Monitaring

» Stream up to 26 Inputs and 32 Outputs  » Fat Channel Effects
» (Class-A XMAX Mic Preamps  » Speaker Switching and Talkback
» Compatible w/ Mac and Windows Computers

999,95

(PRSTUDIOTIZM) ..o

USB 2.0 Digital Audio Interface

» 6 Input / 6 Output

» 2 Microphone Preamps
» MIDI /O

» S/PDIF /0

» Phantom Power

» Iero Latency Direct Monitoring
» Includes Software

229.00

A2 R T SBDyal Pre

USB 1.1 Digital Audio Interface
with Dual Microphone Preamps

» Low Noise Fully Balanced XLR
and 1/4” TRS Combi Inputs

» Latency Free Monitoring
Mix and Level Controls

» Preamps Provide Up to 48dB of Clean Gain

» Built-in Low Noise Phantom Power Supply

.79.00

[ARUSBDP). ..ot

W XLR-USB-48
POLSEN" XLR to USB Audio Interface
» Connects XLR Mic to USB
» Selectable 48V Phantom Power
» Plug-and-Play with
No Drivers Needed

» 1/8" Headphone Qutput
with Level Control

» UUSB Cable Included

\2

e h099

(POXLRUSBAB) ..o

TASCAM. UH-7000

USB Interface and Standalone Mic_:_Preamp

» Stereo XLR Analog Outputs

» 4-inf4-out USB Interface

» AES/EBU Digital /0

» XLR and TRS Inputs

» Burr-Brown PCM4220/1795 AD/DA Converters

» 24-bit/192kHz AD/DA Conversion  » Built-In DSP Mixer Effects
» HDIA Mic Preamps: -128dB EIN  » Mac & Windows Compatible

[TAUHZ000) . 399,99

Octa-Capture UA-1010
High Speed USB Audio Interface
» 10 Input/10 Output
» 8 Mic Preamps
» 24-Dit/192kHz
» Phantom Power
» Auto Input Level Adjustment
» Compressor and Reverb DSP

» 4 Input/4 Output Version

(ROUA1010) 499.00
QUAD-CAPTURE USB 2.0 Audio Interface (ROUASS)................ 249.00

SOUND & DEVICES USBPre2
Microphone Interface for Computer
» 2 Channel USB Interface
» Precision Mic Preamps

with 48V Phantom,

FiltErS, and 15dB Pad _

Limiters, High-Pass
» Dynamic Range Greater Than 114dB
» Flat 10Hz to 40kHz (@96kHz SR) Audio Bandwidth

[SOUSBPREZ)....ooo . 879,00

K,} Zen Studio
ntelope Portable USB Audio Interface

» Up to 24 Simultaneous 24-bit 192kHz 1/0
» 12x Class-A Microphone Preamps with +48V

» Parallel DSP and Effect Processing  » 4x ADAT & 2x SPDIF

» 2x Assignable Headphone Outputs  » Zero Latency USB Interface
» 1x Stereo Monitor Output Pair - » 2x Word Clock BNC Connectors

[ANZENSPAI) . £,295.00



Duet usB Audio Interface
Apocee with Waves Silver Plug-in Bundle

» 2 Input / 4 Output

» 2 High-Gain Microphone Preamps

» 16 Waves Plug-ins via Registration
» Phantom Power  » Soft Limit

» Full Color OLED Screen

» Multi-Function Controller Knob

» Maestro 2 Software for Mac and i0S
» Bus Powered from Mac Computer

[APDUETMACIOS) . 595,00

Focusrite Scarlett Series

The Scarlett range of USB 2.0 interfaces deliver the Focusrite sound
to your DAW. At the heart of these solutions are class-leading digi-
tal conversion & mic preamp design. Each Scarlett interface comes
with the Scarlett Plug-in Suite that includes reverb, EQ, compressor
and gate in VST/AU/RTAS formats.

Scarlett SOLO: 2 Input/2 Output (FOSCARLETTSO)..........ooo......99.00
Scarlett 2i4: 2 Input/40utput (FOS214USB) 199.99
Apollo Twin DUO

» 2 Input/6 Output

» Front-Panel Hi-Z Input
» Headphone Qutput

» Low Latency High-Resolution Audio
» 2 Mic Preamps with Unison Technology
» DUO Core Realtime UAD Processing

» Analog Classics Plug-In Bundle  » Aluminum Construction

[UNAPTWD)....occ. 899,00
APOLLO TWIN USB for Windows (UNAPTWDUSBJ.........c..covcrcee 899.00

MOTTU Track16

Desktop Studio FireWire/USB 2.0 Interface

» 6 Input / 14 Qutput

» Effects & Mixing
Features Built In

» Detailed Metering

» Bus-Powered FireWire

» High-Speed USB 2.0

» MIDIIN and Out

[MATRACK18) .. 529,00

MOTU 8pre

16x12 USB Audio Interface with 8 Mic Inputs

» Eight Microphane Preamplifiers

» Eight Channels of ADAT Optical Expansion

» 16-Channel MIDI Interface  » USB 2.0

» Headphone Monitoring  » 24-bit 96 kHz Resolution
» Includes CueMix DSP Mixing Software

MABPRETO .. 949,00

www.BandH.com

AUDIO INTERFACES [d:{el.\V]sl[e]

ONE

apocee USB Audio Interface

» for iPad & Mac

» Built-in Condenser Microphone

» Preamp for External Microphone

» 2 Input/2 Output  » Phantom Power
» Lightning Connector for i0S

» Maestro Software  » 24-bit / 96kHz
» USB 2.0 forMac  » Mac 0S X and i0S

(APONEIOSMAC)......occcc

Focusrite Saffire Series

JAM

apocee Studio Quality Guitar Input
» foriPad, iPad2, iPhone 4 and Mac
» Designed for Electric Guitar and Bass
» Made for GarageBand, Logic, MainStage
» Multicolor LED for Status and Leval
» Pristine Sound Quality
» Plug and Pla !

g y 'Q

» Mac i0S and 0S X

o 99.00

Focusrite Clarett Series

The Saffire range of DAW interface solutions deliver the Focusrite
sound into your DAW via Firewire, Thunderbolt, USB or ADAT. At the
heart of these solutions are class-leading digital conversion and
25 years of excellent mic-pre design. Combined, they ensure you
capture every subtle nuance of your sound.

Saffire Pro 26: 18 Input/8 Qutput (FOSFP26FAI)...........c..cc............299.00
Saffire Pro 40: 20 Inputs/20 Outputs (FOSP40) 499.99

{=2IT1[= Babyface Pro

USB Bus-Powered Audio Interface
» 12 Analog Inputs, 12 Analog Outputs

» 3.5mm and 6.3mm Headphone Outputs
» TOSLINK /0 » FPGA Chip for DSP
» Integrated XLR Socket %
» SteadyClock Jitter Reduction ' -
» MIDI1/0 Via Included Breakout Cable ™.

» Class Compliant for Mac, PC, Linux, iPad N

v 149,00

(RMBFP

MOTU MicroBook lic

USB 2.0 Audio Interface

» 4 Input / 6 Output

» Microphone and Hi-Z Input
» Phantom Power

» §-Bus Digital Mixer

» Analysis Tools  » Ultra-Compact Size
» CueMix FX and AudioDesk Software  » Instrument Tuner
» Upto 24-bit/96 kHz  » Mac 0S X, i0S, Windows

(MAMBZMPCUSB) .. 249,00

MOTU 828x Professional

28x30 Audio Interface with Thunderbolt

Focusrite Clarrett series interfaces combine Studio-quality sound
with the very latest in Thunderbolt technology. These interfaces
features brand new transformer-modeled preamps, crystal clear
conversion, and interface latency so negligible that you can monitor
and track within your software without any noticeable delay.

Clarett 8Pre: 18 Input/ 20 Output (FOBPRE).........ooooooo..999.99
Clarett 8PreX: 26 Input/28 Output (FOBPREX) 1,299.99

{=2T1= FireFace UFX

USB and FireWire Audio Interface

L
» 30 Input/30 Output Channels  » 12 Analog Inputs/Outputs
» MIDI/O » AES/EBU, ADAT and Wordclock /0 » Metering
» TotalMix FX with Internal Effects  » 4 Microphane Preamps
» Standalone Operation  » Mac0SX » Windows XP/Vista/7

(RMFUFX) oo Call or Log-0n

MOTTU UltraLite-mk3

Hybrid FireWire & USB 2.0 Connectivity

» On Board DSP Processor
» 10 Inputs, 14 Outputs
» Mic, Line, Guitar, &

Instrument Inputs :
» Classic Reverb, LA-2A Compressors, EQ
» Generates & Slaves to SMPTE Time Code
» Windows & Mac Compatible

(MAULMK3H) ..o Call or Log-0n

MOTU 1248 Thunderbolt and USB

Audio Interface with AVB Networking

» 24-bit 192 kHz Resolution

» Two Microphone Preamps with +48V
» 30 0utputs  » 28Inputs  » Onboard Digital Mixer With Effects
» Standalone Analog Mixer Operation  » SMPTE Time Code Sync
» Built-In Instrument Tuner  » Analysis Tools and Oscilloscope

(MAMOB28X) 799.00
828MK3 Hybrid FireWire/USB2 (MAB28MK3H) ...................... 729.00

» 4 Mic Preamps with +48V » AVB Up to 256 Thunderbolt Channels
» 48 Channel Software Mixer with DSP

» Remote Control Using Web Application

» 2x 8-Channel ADAT Optical & RCA S/PDIF

» USB 2.0 Audio Compatibility  » DSP Modeled EQ & Compression

MATZABTBEIF .. 1,699.00




I WU el KEYBOARD CONTROLLERS

Keyboard Controllers

B&H stocks a wide variety of keyboard controllers for hands-on control
of your virtual instruments or external synth hardware. Available in 25
to 88 key variations, with keybeds ranging from synth action (spring
loaded) to semi-weighted/weighted, many models also feature rotary

=5 8202 LTHH 2o

and button encoders, faders, transports controls, and pads. MIDI 1/0
ranges from traditional 5-pin DIN connections to USB.

acorn PAnovation ARTURIA M-AUDIO® &)k

INSTRUMENTS

. N
ROLI KAWAI wrve nstwents  HQRG  C ALESIS
G Aftertouch | Arpegiator
Type

Acorn Masterkey 49 49 Synth Action v v v [ACMK49) 79.99

Acorn Masterkey 61 61 Synth Action v v v [ACMKe1) 99.00

Akai APC Key 25 25 Synth Action v v v v v (AKAPCKEY25) | 129.00

Akai LPK25 25 Synth Action 4 (AKLPK25) 69.00

Akai MPK 225 25 | Semi-Weighted v 4 v v v v (AKMPK225) | 249.00

Akai MPK 249 49 | Semi-Weighted v 4 v v v v v v [AKMPK249) | 399.00

Akai MPK mini 2 25 Synth Action 4 v v (AKMPKMINIZ) | 99.99

Arturia MiniLab 25 Synth Action 4 4 v (ARMINILAB) | Log-on

CME Xkey 37 Note 37 Synth Action v v (CMXK37N) | 199.99

CME Xkey-Piano Black 25 Synth Action v (CMXKEYPB) | 99.00

CME Xkey-Silver 25 Synth Action 4 [CMXKEYS) | 99.00

IK Multimedia iRig KEYS - Mini 37 Synth Action v (IKIKLLC) 129.99

IK Multimedia iRig KEYS Pro 37 37 Synth Action v v (IKIRIGKEYPRI) | 149.95
Kawai VPC1 88 | Hammer Action v (KAVPCT)  [1,849.00

Keith McMillen QuNexus 25 Smart Senso v v (KEK708) 179.00

Korg NANOKEY2BK 25 Synth Action v (KONKZB) 49.99

M-Audio Axiom AIR Mini 32 Synth Action v v (MAAXAIRM32) | 99.00

M-Audio Code 25 25 | Semi-Weighted v v v v v (MACS25KKB) | 299.00

M-Audio Keystation 49 I 49 Weighted v v (MAKEYSTATION) | 99.00

M-Audio Keystation 88 I 88 | Semi-Weighted 4 v (MAKSB8) | 199.00

M-Audio Oxygen 25 IV 25 Synth Action v v v (MAOGZ5) | 119.00

M-Audio Oxygen 49 IV 49 Synth Action v v v (MAOG49) | 169.00

Native Instruments |Komplete Kontrol S49| 49 | Semi-Weighted v v (NAKKS49) | 599.00

Native Instruments | Komplete Kontrol S61| 61 | Semi-Weighted v v v (NAKKS61) | 699.00

Nektar Technology Impact LX25 25 Synth Action v v v v (NELX25) 99.99

Nektar Technology Impact LX49 49 Synth Action v v v (NELX49) 159.99

Nektar Technology Impact LX61 61 Synth Action v v v (NELX61) 199.99

Nektar Technology Impact LX88 88 | Semi-Weighted v v v v (NETLX88) | 299.99

Novation Impulse-25 25 | Semi-Weighted 4 v 4 v 4 v 4 4 (NOIMP25) | 199.99

Novation Impulse-49 49 | Semi-Weighted v 4 v 4 v v v v (NOIMP49) | 299.99

Novation Launchkey-25 MK2 | 76 Synth Action v 4 v (NOLNCKY25MK2)| 149.99

Novation Launchkey-49 MK2 | 49 Synth Action 4 v v (NOLNCKY49MK2)| 199.99

Novation Launchkey-61MK2 | 61 Synth Action v v v (NOLNCKY6TMK2)| 249.99

Novation Launchkey-Mini MK2 | 25 Synth Action v v v (NOLNCHKYMNK2), 99.99

Roli Seaboard RISE 25 25 Keywave v v v (ROSBR25) | 799.99

290 800-859-5252 « 212-444-5072
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ableton USB Software Controller

» Completely Redesigned
Hardware Interface

» 11 Touch-Sensitive
Encoders

» Live 9 Intro Software

» 64 Velocity- and Pressure-Sensitive Pads

» 7 Assignable Footswitch Inputs  » Mac & Windows

. 199.00

[ABAP2USBSWC)......ccccccc

novation Launchpad MK2

Ableton Live Controller

» bh4x RGB Backlit Pads
» USB Bus Powered

» Pads Match the Color of Your Clips
» Start and Stop Loops, Arm Tracks
» Control Volume, Pans, and Sends
» Includes 16B of Loopmasters Samples

» Novation Bass Station and VST/AU Plug-In

[NOLAUNCHPAD2) - 149,00

ARTURI A BeatStepPro
MIDI/Analog Controller and Sequencer
» 16x Projects with 16x2 Melodic Sequences
» 16x Drum Sequences & Controller Maps
» 16x Velocity and Pressure

Sensitive Pads

s
» 16x Touch-Sensitive * - @
7 &
73 )

Rotary Encoders S
» Bx Analog Drum Gate Uutputs\a
» 16x MIDI Controller & Sequencer Presats

[ARBSP) ... Call or Log-0n

MOT U MIDIExpress 128

MIDI Interface

» High-speed USB connection

» USB Powered with no additional power necessary
» 8 Input / 8 Output

» Additional MIDI ports

» Mac 0S & Windows

[MAMETZ8) o 235,00

K,} Orion
ntelope AD/DA Converter

» 64-Bit Acoustically Focused Clocking

» 32 Channels of 192 kHz Audio via USB 2.0
» 32 Channels of 96 kHz Audio via MADI

» 16 Channels of 48 kHz Audio via ADAT

» 32 Channels of Analog Audio via D-SUB

[ANORIONBZ).ccre

2,795.00

www.BandH.com

CONTROLLERS & DSP ACCELERATORS

A KA APC40 mKll Ableton Live
Performance Controller

» Perfect Integration with Ableton Live

» b x 8 Clip-Launch Matrix

» 8§ Control Knobs

» Downloadable Music
Creation Software

» Assignable A/B Crossfader

» 9 Faders » Mac 0S X & Windows

(AKAPCAOMKZ) ... 299,00

A KA APCmini
Ableton Live Controller

» Perfect Integration with Ableton Live

» 8x 8 Clip-Launch Matrix

» USB Bus Powered

» Downloadable Music
Creation Software

» 16 Control + Shift Buttons

» 9 Faders » Mac & Windows

(AKAPCMIND o 99,00

—?s\ iRig Pads MiDI Pad Controller
wrveon fOF 1OS, Android, Mac, and PC

» T6x Velocity Sensitive Drum Pads -
» Pads Light Up in 3 Colors o
» 2x MIDI Knobs, Tx Slider

» 1x Pushbutton Rotary Encoder
» Expression/Sustain Pedal Input
» All Controls are User Programmable
» i0S, Android, Mac, PC App Downloads

(IKIPPSMCHH). ... Calll oF Log-0n

UM-ONE mk2
In-Line USB MIDI Interface

» 11Input /1 Output (16 MIDI Channels)
» In-Line Cable Style
» Bus Powered
» iPAD Support
» Mac 0S X
» Windows
XPNVista/7 r,

(ROUMTMKZ) s 39,99

Big Ben 192k Master Digital Clock
apoGeE with Real Time Format Conversion

» Extremely accurate Master Digital Clock

» AES, coaxial and optical S/PDIF and ADAT I/0
» Word clock/videoin » 6 Word clock outputs
» Direct Digital Synthesis (DDS) using Apogee’s C777 clock tech.
» Adaptive Loop Filtering (ALF) to optimize clock performance

» Realtime format conversion between all digital formats

(APBIGBEN). ..o 1,495.00

PRO AUDIO

nektar Panorama P1
MIDI Controller

» 16 Encoders

» 10 LED Buttons

» 3.5” Color TFT Display
» 20 Presets (Overwritable)

» 9 Faders » 28 Buttons
» Tight Cubase, Nuendo, Reason Integration
» Mac 0S X & Windows Vista/7/8

[NEPANORAMAPT) ... £99.99

L3l W) llen QuNeo 3-D Muiti-Touch

INSTRUMENTS Pad Controller

» 127 Velocity Response Levels On Each Pad

» 17 Switches In Intelligent Groupings

» 16 Tactile Pads

» Dual Rotary Sensors

» 9 Touch-Sensitive Sliders

» 251 Multi-Color LEDs

» Same Size As An iPad
Connects To Computer Via Mini USB

249.00

(KEK707)

KORG nanoKONTROL Studio
Mobile MIDI Controller

» Mixer Section with

8 Sliders
» 8 Rotary Controls
» Transport Keys
» Mute and Solo Buttons
» Jog Wheel
» iPhone/iPad Support

» Record and Select Buttons
» USB and Bluetooth Connectivity

» Music Software Bundle

[KONANOKONST) . 169,99

> iRig MIDI 2 portable
wnuneon MIDI Interface for iOS, Mac, & PC

» 5-Pin DIN MIDI In, Out, & Thru

» Portable Form Factor

» Compatible with AUMIDI
Apps & Software

» Includes Lightning Cable for i0S Devices

» Includes USB Cable for Mac/PC  » MIDI In & Out LEDs

» Includes i0S & Mac/PC Software Downloads

(KIMZCMI).c 19:99)

FERROFISH A16
AD/DA Converter with ADAT I/O

» 16x Balanced Analog TRS /0

» 24-bit 192 kHz Conversion » 2x ADAT I/0

» BNC Word Clock /0 » 2x TFT Displays for Metering
» Individually Adjust I/0 Gain

» SMUX Control » Remote Control Over MIDI

[FEATBAE) . 1,099.00




I YW o el VIRTUAL PROCESSOR PLUG-INS

Virtual Processor Plug-Ins

Whether you're entirely in the box or are using a hybrid analog/digital
mixing setup, B&H has a wide selection of virtual processor plug-ins to
help you achieve the mix you're after. Covering everything from dynamics
to EQ, pitch correction, reverb, noise reduction, and beyond, we have the
tools you need to fix, sweeten, and master your tracks. Many plug-ins

are available in bundles, or 4 la carte.

Acen antares®  [{u:

BrGITAL LINE Eelae. @:";‘:fof‘,‘“ oebmom 2
I - )
i M M € lexicon Wh R

fabfilter METRICHALD WAVES 1K MULTIMEDIA wave arts SoundRadix

TCHELICON &Y zynaptiq & soundtoys Eventide >{‘i Zotope

Brand Product Name Delivery Method Processor Type Operating System Format SKU Price
Acon Digital DeVerberate Electronic Download Reverb Reduction Mac & Windows Native (AC1130200) 99.00
Antares Auto-Tune EFX 3 Electronic Download Pitch Correction/Auto-Tune Mac & Windows Native (ANRTATVE) 99.00
Audio Ease Altiverb 7 Electronic Download Convolution Reverb Mac & Windows Native (AUAVO) 520.00
Audio Ease Altiverb 7 XL Electronic Download Convolution Reverb Mac & Windows Native (AUAVXLO) 899.00
Audio Ease Speakerphone 2 Electronic Download Speaker Modeling Mac & Windows Native (AUS2) 450.00
Blue Cat Audio PatchWork Electronic Download Virtual Patchbay Mac & Windows Native (BLSUPIP) 99.00
Celemony Melodyne essential Retail Box Pitch Sifting/Time Stretching Mac & Windows Native (CEMES) Call or Log-on
D16 Group Toraverb Electronic Download Reverb Mac & Windows Native (D11131191) 49.00
Eventide Blackhole Electronic Download Reverb Mac & Windows Native (EVANTH22BLKH) 199.00
FabFilter Pro-MB Electronic Download Multi-Band Dynamics Mac & Windows Native (FASPCPI) 199.00
IK Multimedia Classic T-RackS Electronic Download Peak Clipping Mac & Windows Native (IKCTRACKCL) 49.99
Image-Line Vocodex Electronic Download Vocoder Mac & Windows Native (IMvoc) 79.00
iZotope Alloy 2 Electronic Download Dynamics processor Equalizer Mac & Windows Native (IZMODTWSTMIX) Call or Log-on
iZotope Nectar 2 Electronic Download Vocal Enhancement Mac & Windows Native (IZN2) 299.00
iZotope Ozone 7 Electronic Download Mastering Mac & Windows Native (IZ0ZONE7) 249.00
iZotope 0Ozone 7 Advanced Electronic Download Mastering Mac & Windows Native (1Z0ZONE7ADVN) 499.00
iZotope RX Loudness Control Retail Box Loudness Correction Mac & Windows Native (IZRXLC) 349.00
iZotope Trash 2 Electronic Download Distortion Mac & Windows Native (112) 99.00
Lexicon PCM Native Reverb Electronic Download Reverb Mac & Windows Native (LEPCMNRPIB) 599.95
Metric Halo ChannelStrip 3 Electronic Download Channel Strip Mac & Windows AAX (MECS3) 75.00
Metric Halo ChannelStrip 3 for GarageBand Electronic Download Channel Strip Mac only Native (MECSGB) 9.99
SoundRadix SR-DL1 Electronic Download Drum Leveler, Beat Detection Mac & Windows Native (SOSROL1) 139.00
TC-Helicon Harmony4 Electronic Download Harmony Processor Mac & Windows TOM (TCHATDMPT) 179.00
Wave Arts MR Click and Crackle Filter Electronic Download Click & Crackle Filter Mac & Windows Native (WAMRC) 39.95
Waves API1 2500 Electronic Download Stereo Compressor Mac & Windows Native (WAAPI2500TDA) 299.00
Waves CLA Vocals Electronic Download Vocal Processor Mac & Windows Soundgrid (WACLVCLSGA) 149.00
Waves GEQ Graphic Equalizer Electronic Download Graphic Equalizer Mac & Windows Native (WAGEQSGA) 149.00
Waves Gold Bundle Electronic Download Bundle Mac & Windows Native (WAGTDMA) 799.00
Waves H-Delay Electronic Download Delay Mac & Windows Native (WAHDELAYTDMA) 179.00
Waves PuigTec Equalizers Electronic Download Program Equalizer Mac & Windows Native (WAJJPTTOMA] 299.00
Waves L3 Multimaximizer Electronic Download Multi-Band Limiter Mac & Windows Native (WAL3TDMA) 349.00
Waves Manny Marroquin Plug-In Bundle Electronic Download Bundle Mac & Windows Native (WAMMSG) 399.00
Iynaptiq ORANGE VOCODER Electronic Download Vocoder Mac & Windows Native (ZY0VP) 199.00
Iynaptiq Morph-2 Electronic Download Audio Morphing Mac & Windows Native (ZYMORPH2) 179.00

292 800-859-5252 + 212-444-5072




39 Instruments and Effects, 12,000
Sounds, 1306B of Data, Sampled
Instruments, Virtual Synthesizers

(NAK10) 499.00
Komplete 10 Ultimate (NAKTOU) ... 999.00
Komplete 10 Ultimate Upgrade (NATOUUPGK29) ....................699.00

MOTTU Ethno InstrumentZ

Virtual Instrument

» Universal World/Ethnic Instruments
» 2168 » Audio Units  » VST
» Sounds, Loops and Phrases

» MAS » RTAS » Standalone
» Mac 0S X and Windows XP/Vista

MOTU BPM15

Advanced Urban Rhythm Virtual Instrument

» 19+6B Sound Library

» Beat Box Anthology

» 4 Virtual Pads

» Per Pad Step Sequencer
» Sampling and Synthesis

Garritan. Personal Orchestra 4

Virtual Instrument

» Al Major Instruments of the Orchestra

» Over 200 Instrument Choices

» Includes Keyboards, Harps, and Chair

» Build Orchestra One Instrument at a Time
» Powered by the ARIA Player

» Mac 0S X, Windows

Download (GAT36POADCO) ..o

Virtual Piano

» Physically Modeled Virtual
Instrument  » Effects

» Preset Loading with
Minimal Adjustments

» AAX, Audio Units, RTAS, VST

» Mac 0S X, Windows, Linux

Download (MOPSSE)......... oo

v VIENNA SYMPHONIC LIBRARY

A/A|S

Applied Acoustics Systems

©roonTrRACK

www.BandH.com

SPECTRASONICS

VIRTUAL INSTRUMENTS [ 3{ol:\V]»][e]

ARTURIA’ SparkLE

Hardware Controller & Software Drum Machine

» 8-Pad Mini Controller

» 3 Sound Engines

» Vintage Drum Machines

» Acoustic and Electronic Kits 2
» Standalone, Audio Units, RTAS, VST "Gy ",
» Mac0SX » Windows XP/Vista/7/8

(ARSLE) ... Calll or Log-on

ARTURIA’ VCollection 4

Software Instruments Bundle

» 13 Software Instruments

» Arturia Software Center

» Standalone

» AAX Native, Audio Units, VST
» Mac 0S X, Windows

H1°332504titittl]

Download (ARVCAKBDMBED) ...

©roonTrACK Eldrummer2
Virtual Drum Module Plug-in
» Complete Drum Production =
» Two Sound Libraries

with 5 Kits Total
» Audio Units
» AAX, RTAS, VST, Standalone

(TOTT206). .

CERENEIEESKED Ivory Il American
Concert D Virtual Instrument

» Vintage 1951 Steinway
Concert D

» 49GB Core Library

» Up to 20 Velocity Layers

(SYIVILACD). .o 189,00

Diva

Software Synthesizer Plug-in

» Templates Model Classic
Hardware » 4x Oscillators

» LFOs, ASDRs, VCFs, & More

» High-Fidelity "Divine" Mode

» Works with Macs & PCs

Download (UHDOFE) ..o 179,00

MOTU

—I—bigfishaudio

ARTURIA

SeEcTrRASONICS OmnisphereZ
Power Synth Virtual Instrument

» Multiple Synthesizer Engines
» 646B Core Library

» Over 12,000 Sounds

» 7,027 Patches  » 144 Multi
» 4,879 Sound Sources

[SPOMNIZ) . 479,00

Seecirasonics Trillian
Total Bass Virtual Instrument
» 34GB Library
» Acoustic, Electric and
Synth Basses
» AU, VST 2.4 or higher, RTAS or
AAX capable host software

[SPBTRL).cc 21900

SPITEFI REAlblonOne

Library Epic

Composer Tools

» 49,884 Samples

» 89.86B of Uncompressed
WAV Files

» Kontakt Player Included

Download (SP1241563)...... ..o 99,00

@ Explorer lll virtual

Instruments and Effects Bundle
» Blade, BLUE-II, SubBoomBass [

» Punch and Punch-BD Ik
» Predator and Predator FX
» RG Virtual Rhythm Guitar

» RP-Delay, RP-Verb, RP-Distort,
RP-Amod  » Mac & Win

Download (RORPBUPT3ED).........ooooooo.. 599,00

w oo o \lienna Ensemble PRO S
Mixing and Host Software

» Hosts Vienna Instruments
» Cross-Platform MIDI and LAN
» [TU Surround Support up to 7.1
» Integration with

Vienna MIR PRO

(VIVEPROS) 220.00

SYNTHOGY

Ggarritan. SPITFIRE




I WU el MUSIC PRODUCTION SOFTWARE

AV Pro Tools 11 Recording and Music Creation Software

Avid's Pra Tools 11 makes several improvements to the industry standard audio production software, including
input monitoring and the ability to create larger sessions. But the biggest features are the new licensing options
and cloud-based functionality. Aside from outright ownership, access to the program has been expanded with a
feature-limited free version, or by using a flexible licensing program. All purchases, upgrades, and
subscriptions come with a twelve-month upgrade and support plan that ensures access to future
software updates (as long as the plan is active), along with 24/7 access to customer care to get help
whenever needed. Other enhancements include collaboration in the cloud with artists and producers
anywhere in the world, and a marketplace where artists can share, license, or sell music and audio
projects, and buy virtual instruments, plug-ins, and more

TR IV

599.00

MOTU Dlgltal Performer 9 Audio Workstation Software with MIDI Sequencing

Digital Performer 9 from MOTU is a major upgrade to this digital audio workstation and MIDI
sequencer, featuring new plug-in processors, a powerful synthesizer, and many workflow
enhancements. The software is well suited for songwriters, live performance applications,
creating film and video soundtracks, audio post production, surround mixing, and more. Record,
edit, arrange, mix, process, and master audio and MIDI tracks within a single window interface
for a streamlined workflow experience without the need to dive through menus. Available for Mac
and Windows, the program includes the Masterworks FET-76 emulation of the classic 1176LN
limiting amplifier, along with a spectral display that provides the spectral content of audio signals for each audio
track, side by side with their corresponding waveforms.

395.00

|||||||— Live 9 Suite Music Production Software
ableton

Live 9 Suite is a solid update to the company’s “think different” DAW software that is particularly
popular with electronic and beat-making creators. Two GUI views include a traditional arrangement view, a
vertical-track display with time moving from left to right, while the session view is —
a place for experimentation, improvising, and playing and performing with musical
ideas without the constraints of the timeline. The top-of-the-line version includes
nine instruments, 40 effects, more than 3,000 sounds, along with Max for Live with
its 24 Instruments and effects and further access to more than 900 devices. The
Standard and Intro version feature exactly the same functionality, but do not include
Max for Live and ship with fewer instruments, plug-ins, and sample pack counts.

112 799.00  Live 9 Standard (ABLISTD)............... 499.00

Live 9 Intro (ABLIINTRO)........................99.00

{15 PreSonus Studio One 3 Professional Audio and MIDI Recording/Editing Software

Studio One 3 Professional offers an integrated approach to recording music, from tracking to mixing, to mastering and distribution. Featuring

a flow-oriented, drag -and-drop interface, the software is built for intuitive use, speed and efficiency. It includes the Melodyne pitch-correction
p— ’ plug-in, Red Book CD burning, and video playback and sync. The program is robust

enough for the most complex productions, delivering full audio and MIDI recording

and editing capabilities with 36 audio effects plug-ins, 4 Note FX (MIDI effects), and 5

virtual instruments, including the new Presence XT sampler and the Mai Tai polyphonic

synthesizer. There are no limits on track count, plug-in instantiations, or editing features,

and the software is compatible with any ASIO, Windows Audio, or Core Audio compliant

audio interface, including the company’s entire line of the interfaces.

299.95

Download (PRSOZAPUVKELY ...

@ steinberg Cubase 8.5 Music Production Software

Cubase Pro 8.5, from Steinberg, reflects the company’s push towards making its top-tier audio software even more
relevant to professional producers, mixing engineers, and composers. The update is more than a mere makeover,
as it includes a rebuilt audio engine for delivering a sleeker, more efficient, and more creative
workflow, while offering new audio tools and instruments. MIDI sequencing has always been
integral to creating music on a computer, and tools such as the Score, Brum, and List Editors
are indispensable to modern music production. With easy-to-use editing and innovative
composing and notation tools, the software offers a complete MIDI composing and
sequencing tool set. Additional aids include intelligent compositional tools, such as Treciv il
Chord Track, Chord Assistant, and Chord Pads.

549.99

propellerhead Reasons

» Virtual Instruments Studio Rack

» Mixer Based on the SSL9000K Console

» Record with UnlimitedAudio Tracks

» Bus Channel for Track Grouping

» Automatic Audio
Slicing

» Spectrum Analyzer
Window

» Rack Extensions

» Standalone or ReWire

» Mac 0S X & Windows

[PRREFRV..oocer

celemony_ Melodyne Editor 4
Polyphonic Pitch Shifting/Time
Stretching Software

» Direct Note Access Technology

» Monophanic or Polyphonic Material

» Extract Scales from Audio Recordings
» AAX Native, Audio Units, VST, RTAS

» Stand-Alone or ReWire
» Mac 0S X & Windows

Download (CEMEA)....... oo 399.00

@ lsELINe FL Studio 12 Producer Edition

» Unlimited Multi-Track Audio Recording

» 30 Soft Synths and 40 Effect Plug-ins

» Step Sequencer or Piano Roll  » Audio Editing

» MIDI Sequencing  » Multi-Touch Support

» Live Performance Mode

» Mac 0S X &
Windows

Download (IMFLS12PR).....ooooooooooo.. Call o Log-0n

S ONY Sound Forge Pro Mac 2.5
Digital Audio Editing Software

» All-in-One Production Suite

» Record, Edit, Process

» Mastering, Restoration, Repair

» Spectralayers Pro 2
Interoperability

» iZotope Plug-Ins

» Event-Based Editing

» Expanded Metering (CALM)

» Up to 24-Bit/192kHz
Resolution

Download (SOSFP11Q) ... 369.00

800-859-5252 + 212-444-5072




www.KopulCables.com

STUDIO AND =
~-BROADCAST CABLES

Committed to preserving the purest signal with high grade copper, superior shielding, and
premium connectors. Durability and quality craftsmanship are paramount to our products.

Kopul

Quality products can be achieved only when quality materials are used. All Kopul products are meticulously engineered and manufactured to meet the demands |
of broadcast engineers, A/V integrators, ENG/EFP and live sound professionals worldwide. Our tight quality control ensures consistent and reliable performance.

Y Cables

o Available for 1/8", 1/4" and XLR,
stereo and mono
* 1/8" Gold-Plated Metal Connectors
* Rean Connectors, a Trademark of Neutrik
¢ OFC Spiral-Shielded Cable

Instrument Cables

o For Guitar, Keyboard, or Patch Cables

* M 1/4" to M 1/4" Unbalanced

* 98% Braided Copper-Shielding Coverage

® 22-Gauge Copper Conductor

* Braided Mesh Jacket

o Flexible PVC Jacket

 Conductive PVC & PE Layers of Insulation

 Heavy-Duty 1/4" Gold-Plated Connectors

o Shrink-Wrap Strain Relief

e Available in straight or right-angle styles,
in lenths of 1.5', 3', 6', 10', 15', 20", 25",

d 4 ]
e &

Pro Audio
Accessories

Offering a vast selection of audio
accessories and solutions designed
by professionals, for professionals.

agurd

Models include tripod,
round base, desktop and
instrument stands

Features Include:
(Varies by model)

» Telescoping Shaft with
Ergonomic Clutch

* Reinforced Tripod Base
* Non-Slip Feet

* Durable Steel
Construction

» Portable, Collapsible
Design

More from Auray:
- Microphone Flags
- Keyboard Stands

Models include steel, aluminum
and Pneumatic Lift-Assist speaker
stands, and studio monitor stands

Features Include:
(Speaker Stands)

* 46" to 82" Height Range

+ 1001b Load Capacity

« Use With 1-3/8" or 1-1/2" Mounts

« Non-Slip Feet

« Collapsible Legs

(Studio Monitor Stands)

* 90 1b Weight Capacity

« Height Range from 35 to 58.5"

« Locking Pin for Height Adjustment
+ 9" Steel Plate with Non-Slip Strips
» Rubber Foot Pads for Wood Floors

» Interchangeable Spikes for Carpet

- Wind Protection
- Microphone Pistol Grips
- Reflection Filters

Models include single and double-X
stands, with pull knob and clutch
locking mechanisms.

Features Include:
(Pull Knob Models)

« 5 Locking Positions

« Spring-Loaded Pull-Knob Lock

+ Non-Slip End Rings

*« Removable End Caps

« Sturdy Bolted Metal Construction
« Collapsible and Portable

+ 100-200 1b Weight Load Capacity
(Clutch Lock Models)

* 6 Locking Positions

« Clutch Locking Mechanism

« Non-Slip End Rings

* Removahle End Caps

» Sturdy Welded Metal Construction
* Collapsible and Portable

« 175-225 1b Weight Load Capacity

- Pop Filters
- Headphone Accessories
- Isolation Pads

www.aurayaudio.com

_

Models include
compact, X-style, fixed
height and adjustable benches.

Features Include:
(Varies by model)

« Perfect for Stage, Studio,
or Home

» Reinforced Tripod Base

« Quality Finish

= Durable Construction

» Comfortable cushioned seat
« Support 200-360 1b

- Speaker & Mic Stands
- Portable Recording
Remotes




PRO AUDIO

KORG s0-1

Step Sequencer

» 7x 8 Step Buttons

» Hz/V, Vi/0ct, CV, MIDI,
USB., littleBits

» Sync with MS-20, Volca, Monotribe

» Alternate, Order, Parallel Turn Modes

» Parallel Order, CV/Duty, CV/Slide  » Step Jump Mode

» Battery or USB Powered  » Active Step Mode  » Slide Mode

(KOSOT) . 99,99

DﬂVt W Prophet '08 PE Analog

instruments Synthesizer Module

» 8-Voice Analog Synth

» Analog Curtis LPF Per Voice

» Gated 16x4 Step Sequencer

» Control Knobs A

» 5-Pin DINMIDI /0, §
Through, Chain

» Includes Rack Ears

» 2x Digital Control Oscillators Per Voice
» 4x LFOs

(DAPROOBPEMOD).......ccc... i 1,369.00

Qaccess Music Virus Tl Snow
Desktop Synthesizer Module

» 3 main oscillators and one B

sub oscillators per voice [ ~ @E\\ E!_

» Controls: 6 knobs,
21 buttons, 18 LEDs
» 1000 sounds with access to over 6000 free patches
» Dualindependent filters  » 2-D modulation matrix
» MIDI/0 » Heavy-duty chassis and a small footprint
[ACVTIS) o 1,220.00

Q- FERROFISH BA00O+
Authentic Organ Sound Module

» Supports 3 Manuals - Upper, Lower, Pedal s ]
» 9 Drawbars, 6 Dials 3

» Tonewheel Emulation

» Percussion

» 128 Factory Presets

» Rotating Speaker Emulation
» Key Click, Key Contact Delay Simulation

[FEBADDO) . 52000

Pittsburgh Lifeforms System 201 complete
Eurorack Modular Performance System

» Semi-Modular with Patchable
Signal Path

» Structure EP-96 Enclosure

» LiLifeforms KB-1 Touch Keyboard

» feforms SV-1 Synthesizer Voice Module

» KB-1 Offers Sequencer and Arpeggiator

» MiDILifeforms HP-6 Logo Blank Panel

[PIPMSTON s

cie1,399.00

SYNTH MODULES

KORG Kaossilator Pro+ Dynamic Phrase
Synthesizer/Loop Recorder
» Freely Playable Synthesizer

» XYTouchpad » Play Notes

Manipulate Sound in Real-Time

» Gate Arpeggiator  » USB MIDI
» 4 Infinitely Stackable Loop Banks
» 250 Sounds  » Choice of 35 Scales
» Mac0SX » Windows XP/Vista/7/8

(KOKOPP)...oo . 269,99
KAOSSILATOR 2S- Dynamic Phrase Synthesizer (K0K02S) ...... 159.99

Aira System-1m
Semi-Modular PLUG-OUT Synthesizer

oL

» 2 Oscillators with

6 Waveforms Each S
» Tabletop, Rack, &

Eurorack Compatible
» LFQ, Pitch, Filter, & Amp Contrals
» Reverb, Delay, & Time Effects  » 19 CV/Gate, Audio Connections
» Tempo Syncing  » PLUG-OUT Compatible  » Rackmount Adapter

(ROSYSTEMIM) .. 999,00

[ 4 e=l=ix#r-mmrm Analog Four
Tabletop Analog Synthesizer

» Analog Synth with
Digital Control

» Step Sequencer

» Analog Oscillators and
Filters  » CV Gate and DIN Syn¢

» 4\oices » 6 Arpeggiators  » Effects

» Analog Overdrive Circuit  » Full MIDI Support

(ELANALOGA) . 1,299.00

T Streichfett
String Synthesizer
» "70s, Early-'80s String
Machine Sounds

» 128-Vaice Polyphony

» 8-Voice Solo Section

» 12 Memory Locations  » Effects
» 2 Audio Outputs > USB MIDI I/
» Headphone Output  » MIDI /0

(WASTREICHFET)...oooo oo 309,99
System-500

Complete Eurorack Modular Synthesizer

» Compatible with ALl ; e

Eurorack Modulars
» Includes b Modules
» 512 Dual VCO
» 521 Dual VCF » 530 Dual VCA
» 540 Dual Envelope Generator + LFO
» 72 Phase Shifter + Delay + LFO  » SYR-E84 Eurorack Case

(ROSYSB00CS) ... 1,999.00

P0-20 Pocket Operator

A Arcade Synthesizer

» Synthesized Arcade Sounds

» 16 Punch-In Effects and Parameter Locks

» 16-Step Sequencer with 16 Patterns

» 16 Pattern Chaining  » Built-In Speaker
» Jam Sync with Audio Through  » Alarm Clock
» Folding Stand and Animated LCD Display

(TEOT0ASO20) .. oo 5900
P0-24 Pocket Operator Office Synthesizer (TE010AS024)........... 59.00
P0-28 Pocket Operator Robot Synthesizer (TE010A5026) 59.00

=MV ARG Aero Rhythm Trak

All-In-One Music Instrument

» Base Station with 538 Sounds & 400 Presets
» Wireless Bluetoath Ring Controller
» USB Port and SD Card Slot

» Smart Grip-Detection Circuitry

» Looper, Clip Launcher, MIDI Controller N
» Drum Machine, Sequencer, Synthesizer
» 96 Velacity- and Pressure-Sensitive Pads

» On-Board Mixer

i 999.99

[Z0ZARDE ..o

M@OQg Theremini

Synthesizer Module

» Pitch Correction with Selectable Scales  » Built-In Tuner
For Learning Pitch ~ » 32 Wavetable-Based Prasats

» Built-In Speaker and Two 1/4” Qutputs ~ » Single-Pitch CV
Output with Range  » Adjustable Stere Ping-Pong Delay

» 3/8" Mic Stand and Camera Stand Adapter

» User-Selectable Scale and Root Note v

» Removable Pitch Antenna = N <

-
(MOTHEREMINI oo 299.00

M@0 Mother-32

Semi-Modular Analog Synthesizer

» 100% Analog
Sound Engine

» VCO with Square
and Saw Waveforms §

» LFQ with Square and
Triangle Waveforms

» Classic Moog Filter: Switchable LP/HP

» Records Note, Glide, Gate Length, Accent

[MOMB2) ..o

. 999.00

MYAOQg Werkstatt-01: Moogfest 2014 Kit

Analog Synthesizer

» Patchable Synth Kit

» No-Solder Construction
» Design Based on Classic

Moag Circuits

» Envelope Section

» LFO, VCO & VCF Modulation sections
» Integrated 1 Octave Legato Keyboard
» Single VCO with Saw & Square Waveshapes

[MOWOTMK].c,

ci1,999.00

800-859-5252 + 212-444-5072



Ao Teenage Engineering OP-1 s
Portable Synthesizer —— . - 1 0}

» Synthesizer, sampler & controller 1. - g N
» Real-time control modulation Vi S
» Adsr type envelope  » 4-Channel mixer L “s

» 4-Track tape recorder
» 3-Axis g-force sensor

» AMOLED Display
» Color Coded Interface

» 8 Built-in engines
» 16-Hour Battery Life

J— A

A-01K
Compact Synthesizer & Keyboard Controller
» K-25m 25 Mini-Key Controller Dock
» Portable Design for Mobile Music Making
» Dual Assignable Ribbon Controls
» MIDI Over Bluetooth ~ » CV/GATE Outputs
» For Mac, Windows Computers, Tablets & Smartphones

399,00

novation MiniNova 37-Mini-key Compact Synthesizer
with Gooseneck Microphone

» Powerful UltraNova Sound Engine

» 256 Factory Preset Sounds  » Polyphony up to
18 Voices  » Add up to b Effects to Each Sound

» VocalTune and Classic Vocoder Effects

» USB and MIDI Connectivity

KORG Minilogue

Polyphonic Analog Synthesizer

» Four Voice - Fully Programmable

» 200 Fully Editable Presets

» Modes: Poly, Duo, Mono, Chord, Unison

» 16-Step Poly Note and Mation Sequencer
» Tape-Style Delay » OLED Display with Built-In Oscilloscope

[KOMINILOGUED. .. e 59999

KORG Monotron DELAY
Analog Ribbon Synthesizer

» Pocket Sized  » True Analog Synthesizer
» Space Delay with Time & Feeback Control
» Original (VCF) Filter from MS-10 & MS-20
» Waveshape, Rate and Intensity Controls » Built-in Speaker

(KOMONTROND)
MONOTRON DUO Dual Oscillator Ribbon Synthesizer (KOMONTRON) .......cc.ccoococvocvrcn

&YAMAHA MM8

88-Key Synthesizer Keyboard
» §8-size keys

» Based on the sounds of the MOTIF series

» Drum kits from the MM6

» Eight-track sequencer  » Reverb, delay, and EQ
» Lightweight and Compact Cubase LEa Included

899,99

SYNTH KEYBOARDS

PRO AUDIO

MMYAOQ sUB 37 Tribute Edition

Paraphonic Analog Synthesizer

» 40 Knabs & 74 Switches

» 37-Note Keyboard  » Dual LFOs
» Dual Oscillators  » Sub-Oscillator
» Dual ADSR Envelope Generators

» Arpeggiator  » Glide and Filter

[MOSUBBTTRIBY ..o

Aira System-1
PLUG-OUT Synthesizer
» Arpeggiator with Scatter Function
» 25 Normal-Sized Keys  » 73 Physical Controls
» Four Oscillators  » Delay and Reverb Effects
» Crusher Knob  » Tempo Syncing for LFO and Delay

[ROSYSTEM1)
AIRATB-3 TOUCH BASSLINE (ROTBS3)

ARTURIA’ MatrixBrute
Analog Mono Synth

» 16x16 Matrix Modulation Panel

» Mono, Paraphonic & Duo-Split Modes

» 3 Analog Oscillators  » 64-Step Sequencer
» 256 Preset Memory Locations  » Steiner-Parker and Ladder Filters

» Combination VCO/LFO Oscillator  » Two Standalone LFOs  » Pitch Bend & Mod Wheels

[ARMBAMS) ... 1,999.00

ARTURIA’ MicroBrute

Analog Synthesizer

» 100% Analog Monophonic Synthesizer

» ADSR Envelope Controls  » USB MIDI In/Out

» Modulation Matrix  » CV/Gate Input and Qutput

» 25-Note Mini Keyboard  » Mixable Multi-Wave Oscillator
» Steiner-Parker Multimode Filter  » LFO with 3 Waveforms

[ARMICROBRUTE]....c.e e

Duve St OB

instruments 6-Voice Polyphonic Analog Synthesizer

’
//; :

» 1000-Program Patch Memory

~......Call or Log-on

» Semi-Weighted Velocity-Sensitive Keys
» 4-Octave Keyboard with Channel Aftertouch
» 6 Voices with 2 Oscillators per Voice

» Dual 24-Bit/48kHz FX Engine  » X-Mod Modulation Matrix
» 2-Pole State-Variable Resanant Filter

— A

Dave Sitf Sequential Prophet-6

INSTRUMENTS Synthesizer

» Semi-Weighted Velocity-Sensitive Keys

» 4-Octave Keyboard with Channel Aftertouch
» 6 Voices with 2 Oscillators per Voice

» Polyphonic Arpeggiator  » 1000-Program Patch Memor
» Dual 24-Bit/48kHz FX Engine  » Poly Mod Modulation Matrix

[DASPBBVPAS) ...

- ,799.00




- W el DIGITAL PIANOS

Digital Pianos

Taking you from practice all the way to the studio and the stage, B&H's selection of digital
pianos ranges from models for the beginner all the way to the seasoned pro.
Available digital pianos run from 25 to 88 keys, with many offering
hammer action or semi-weighted keys. Most models also
offer built-in speakers, USB connectivity, a variety
of built-in effects, and MIDI compatibility.

CASIO. KAWAI KORG XuRzwrelr nod ROLI €YAMAHA

Built-in Auto Accompa-
Speaker niment

Key Type Polyphony

Alesis Coda 88 Keys Hammer Action 64 Voice Black Not Included v v v (ALCODA) 399.00
Casio PX-160BK 88 Keys Hammer Action 128 Voice Black Not Included v v v v (CAPX160BK) 499.99
Casio PX-58 88 Keys Hammer Action 256 Voice Black Not Included v v v (CAPXBS) 999.99
Casio PX780 88 Keys Hammer Action 128 Voice Black Console Style v v v v (CAPX780) 999.99
Casio CGP700 88 Keys Hammer Action 128 Voice Black Stand Included v v v v v (CACGP700) 799.00
Casio PX-860BK 88 Keys Hammer Action 256 Voice Black Console Style v v v v v (CAPX860BK) 1,099.99
Kawai CE220 88 Keys Hammer Action 192 Voice Black Console Style v v v (KACE220) 1,899.00
Kawai ES100 88 Keys Hammer Action 192 Voice Black Not Included v v v (KAES100) 699.00
Kawai KDP90 88 Keys Hammer Action 192 Voice Black Console Style v v v (KAKDP90) 1,149.00
Kawai MP11 88 Keys Weighted 256 Voice Black Not Included v v v (KAMP11) 2,799.00
Kawai MP7 88 Keys Hammer Action 256 Voice Black Not Included v v v v (KAMP7) 1,799.00
Korg HAVIAN30 88 Keys Hammer Action 128 Voice Black Stand Included v v v v (KOHAVIAN3D) | 1,499.99
Korg LP180BK 88 Keys Hammer Action 120 Voice Black Console Style v v v (KOLP180BK) 699.99
Korg LP380WH 88 Keys Hammer Action 120 Voice White Console Style v v v (KOLP380W) 999.99
Korg SP-280 88 Keys Hammer Action 120 Notes Black Stand Included v v v (KOSP280BK) 699.99
Kurzweil ARTIS-SE 88 Keys Hammer Action 128 Voice Black Not Included v v v (KUARTISSE) 1,495.00
Kurzweil SP4 88 Keys Hammer Action 64 Voice Black Not Included v v v (KUSP48) 999.00
Nord 2EX Compact 73 Keys Semi-Weighted 60 Voice Red Not Included v v v (NOSZEXCOMPCT) | 3,599.00
Roland F-140R 88 Keys Hammer Action 128 Voice Black Not Included v v v v v (ROF140RCB) 1,199.00
Roland F-20-CB 88 Keys Hammer Action 128 Vioice Black Console Style v v v (ROF20CB) 799.00
Roland FP-50-BK 88 Keys Hammer Action 128 Voice Black Not Included v v v v (ROFP50BK) 1,299.00
Roland FP-80-BK 88 Keys Hammer Action 128 Voice Black Not Included v v v v (ROFP8OBK) 1,799.00
Roland RD-300NX 88 Keys Ivory Feel-G 128 Voice Black Not Included v v v (RORD30ONX) 1,299.00
Roland RD-800 88 Keys Hammer Action 128 Voice Black Not Included v v v v (RORDB00) 2,499.00
Roland V-PIANOC 88 Keys Hammer Action 128 Voice Black Not Included v (ROVPIANO) 6,999.00
Roli Seaboard Grand Stage | 61 Keys Keywave Not Specified Black None 4 v (ROSBGS) 2,999.99
Yamaha DGX650WH 88 Keys Hammer Action 128 Voice White Console Style v 4 v (YADGXOBOWH) | 749.99
Yamaha NPV60 76 Keys Weighted 32 Voice Black Not Included 4 v v v (YANPV60) 280.49
Yamaha NPV80 76 Keys Weighted 32 Voice Black Not Included v v v v (YANPVSO) 399.99
Yamaha P1158B 88 Keys Hammer Action 128 Voice Black Not Included v v v v (YAP115B) 599.99
Yamaha P255B 88 Keys Hammer Action 256 Voice Black Not Included v v v v v (YAP255B) 1,299.99
Yamaha P45B 88 Keys Hammer Action 64 Voice Black Not Included v v v (YAP45B) 449.99
Yamaha YDP143B 88 Keys Hammer Action 128 Voice Black Console Style v v (YAYDP143B) 1,099.99
Yamaha YDP162PE 88 Keys Hammer Action 128 Voice Black Console Style v v v (YAYDP162PE) 1,699.99
Yamaha YDP181 88 Keys Hammer Action 128 Voice Black Console Style v v v (YAYDP181) 1,699.99

298 800-859-5252 + 212-444-5072




ARRANGER & PORTABLE KEYBOARDS

KORG microARRANGER

61-Key Professional Arranger

A compact, lightweight keyboard that features 61
velocity sensitive mini-keys and a built-in 16-track
sequencer. The microARRANGER is loaded with 662 sounds, 33 drum kits and 89 effects and comes packed
with a great selection of sounds ranging from pianos, electric pianos and organs, to thick basses, realistic
woodwinds, strings and drums. An SD card slot for data storage and transfer.

KORG PaiX76
76-Key Professional Arranger

a semi-weighted keybed that provides both
velocity and aftertouch sensitivity. The dynamic
response is adjustable to accommodate any playing technique. The main panel has been optimized to
ensure that all controls are ergonomically positioned. Additionally, it features a 7" touchscreen display
that can provide control over important parameters as well as in-depth editing of your sounds. The display
can be tilted forward and back to provide suitable angle for optimum viewing.

(KOPAGX7O)....oo.3,999.99 PA4X 61 61-Key (KOPAGXeT).................3,799.99

€ YAMAHA PSR-S770

Professional Arranger Workstation
A 61-note portable performance instrument with a
selection of outstanding-sounding voices, styles, and
effects. Powerful features include: XG/XF/GS/GM/GM2/
SFF/SFF GE file compatibility, 16-track song recorder,2 Assignable Knobs, FlashROM Expansion, Super
Articulation, Style recommender, Audio Link Multi-Pad, Real Distortion Effect, Improved Sound System.

1,299.99

€ YAMAHA PSRS970

Professional Arranger Workstation

A 61-note portable performance instrument with a
selection of outstanding-sounding voices, styles, and
effects. Powerful features include: XG/XF/GS/GM/GM2/
SFF/SFF GE file compatibility, 16-track song recorder,2 Assignable Knabs, FlashROM Expansion, Style
recommender, Audio Styles, Audio Link Multi-Pad, Vocal Harmany 2, Real Distortion effect.

[YAPSRSIT0) . 1,999.99

CASIO. 5A-76

Portable Keyboard

Compact and battery operated. Play along to 10 song
bank tunes and choose from 100 preset tones. There

are 44 miniature size keys, five percussion pads (two

with Indian percussion sounds), built-in speakers and
easy-to-read display LCD which shows tone, rhythm, song number, metronome, tempo, note played.

&YAMAHA PSR-E253
61-Key Keyboard (No Power Adapter)

Portable keyboard with almost 400 sounds, 100
accompaniment styles and 102 songs. Lesson guides
and Yamaha's Education Suite provide deep resources for
practice, and with an optional cable, the musical experience can be broadened by connecting to an iPhone
or iPad. Built-in amps and speakers, and an Ultra-Wide Stereo processor deliver great sterea sound.

[YAPSREZB3) .. 99299

PRO AUDIO

KORG PA-600 professional

61-Key Arranger Keyboard
with Built-In Speakers

This all-in-one performance tool is equipped with
two internal speakers in a bass-reflex box, driven by two 15-watt amps. It boasts over 950 preloaded
sounds with 96MB of expansion memory for adding new ones. Over 360 on-board genres and musical
arrangement styles for a wide range of performance occasions.

[KOPAGDDQ)- ... 1, 149,99

KORG Pa%00

61-Key Professional Arranger

A semi-weighted, velocity-sensitive keyboard with
aftertouch that features a 7" touchscreen display that
provides control over important parameters as well as sound editing. It mcorporates over 1,100 sounds, 125
effect types, and over 70 drum kits. Playback is provided via the integrated dual 20-watt amplifiers that power
the 4 built-in speakers. Two 1/4" mic inputs allow you to integrate vocals into your performance.

(KOPAIOO). .o 1,899499

@ YAMAHA Tyros5-76

Arranger Workstation

A 76-key performance keyboard with over 1,780
sounds, enhanced DSP effects, and accompaniment
Styles that sound sa real it's like being backed by the world's finest musicians. More than 300 new voices
have been added, including new brass, guitars, synthesizers, electric pianos, and upright pianos. S.Art2
Voices are high-quality sounds that re-create the feeling of an actual instrument when performing.

5,499.99

€ YAMAHA PSRS670

Professional Arranger Workstation

LT T TR T T T

A 61-note portable performance instrument with a
selection of outstanding-sounding voices, styles, and
effects. Powerful features include: XG/XF/GS/GM/GM2/
SFF/SFF GE file compatibility, 16-track song recorder, 2 Assignable Knobs, Voice & Style Expandability,
MegaVoice Technology, 181 built-in Styles, Scale Tuning, Style Creator.

[YAPSRSO70) . 19 9.9

CASIO. CTK-2400
Digital Keyboard
with EFX Sound Sampler

Built-in step-by-step lessons teach how to play.

o

150 rhythm patterns and 150 One-Touch presets. A sterea mini input lets you connect an iPad, MP3 player,
or smartphone. You can even sample sounds from a connected music player and trigger the samples.

[CACTKZAO0) e 99299

@YAMAHA EZ-220

Lighted 61-key Portable Keyboard

92 instrument sounds including strings, guitars, brass,
saxophones, drums and of course, Yamaha's renowned
piano sounds. 100 preset styles accompany your playing so you can spark up a jam session whenever you
wish. Keys light up letting you know which to press as you play along. Wireless connectivity to Yamaha's
free Page Turner iPad app turns the pages at just the right time.
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Compact Series Electronic Drum Set

» T0-11 Drum Sound Module

» 50 Drumkits and 190 Instruments

» 10 Ambience Effects and Built-in EQ

» SuperNATUR AL Sound and Behavior Modeling
» PDX Series Snare Pad

» KD-9 Kick Pad with Double Pedal Support

» FD-8 Hi-hat Controller

» Dual-triggering Technology

» USB Port for Memory and Connectivity

» MDS-4V Drum Rack and Hardware

ELECTRONIC DRUMS

TD-4KP

V-Drums Portable Electronic Drum Kit

» Portable V-Drum Kit with Eight Pads

» Folding Design for Quick, Easy Transport

» Wave-Expanded TD-4 Sound Module

» Features 125 Instruments & 25 Kits

» Tuning & Muffling for Kick, Snare & Toms

» Coach Mode with Warm Ups & Tempo Check
» Module Equipped with Quick Rec Function

» Mix Input for Playing Along with Songs

» Snare & Tom Pads Feature Rubber Surfaces
» Includes FD-8 Hi-Hat Controller

AL
ssssssssss 5-Piece Electronic Drum Kit

» Includes Drum Module

» 1x 8" Single-Zone Snare

» 3x 8" Single-Zone Toms

» 1x 10" Single-Zone Hi-Hat w/ Foot Pedal

» 1x 12" Crash Cymbal & 1x 10" Ride Cymbal

» 1x 8" Kick Tower Bass Drum Pad

» Drum Rack, Cabling, & Mounting Hardware

» Silent-Strike Bass Drum Beater

» 1x Drum Key and 5x Hook-and-Loop Cable Ties
» 10 Kits, 158 Instruments, & 40 Patterns

hord Drum2

Modeling Percussion Synthesizer

» 6 Channels

» Resonant, Subtractive,
and FM Synthesis

» Distortion, Repeat,
and EQ on Channels

» Flexible Inputs

» Headphone Output

» Attack and Decay Controls

» Group Edit and Mute Group

» Stereo Output
» MIDI In/Out and CC Control
» Repeat Mode for Delay Effects

[NONDRUM2) . 599,00

300 800-859-5252 + 212-444-5072

‘ 499.00

ALESIS DMI0

High Definition Drum Module

» 100 Preset Drum Kits

» 1047 Preset Sounds

» Trigger Software
Drum Kits Via USB

» 12 Trigger Inputs

» Top-Panel Mixer

» Record Yourself
with the Sequencer

» Aux Input to Jam with a CD or MP3 Player

» 100 User Assignable Kits

(ALDMT0) e

ALESIS Nitro Drum Kit

Six-Piece Electronic Drum Set

» 6-Piece Kit: 4x 8" Toms and 10" Snare

» 12" Hi-Hat, 2x 12" Crashes, 14" Ride

» DM10 Drum Module

» Compact 4-Post StageRack with Boom

» Qver 1,000 Premium Drum Sounds

» Built-in Sequencer, Metronome and Mixer
» Dynamic Articulation Technology

» iPad Compatible via Apple USB Adaptor

XD80USB
vehringer  8-Piece Electronic Drumset
with Drum Module
» HDS240USB Sound Module
» 1x 8" Dual-Zone Snare
» 3x 8" Dual-Zone Toms
» 1x Kick Pad with Pedal & Stand
» 3x 12" Cymbal Pads
» 1x Hi-Hat Trigger Pedal
» Drum Rack with Mounting Hardware
» 10 Factory Presets, b User Presets
» 175 Sounds ‘
(BEXDBOUSBY o 399.99

& YAMAHA DTX532K

Electronic Drum Set Kit

» Electronic Drum Set Kit

» DTX502 Drum Trigger Module

» DTP532 Cymbal and Drum Pad Set

» RS502 Rack System

» 50 Drum Kit Presets

» Dual Zone Hi-Hat System and Hi-Hat Stand
» 3-Zone Expressive Snare with DTX-PAD

» 3-Zone Ride and Crash Operation

» Nine-Channel Snake Cable

™-2

Trigger Module
» Compact Trigger In for

7 Pads or Trigger Devices
» 100 Ready-to-Play Sounds
» Suitable for AU Genres
» Multi-Effects
» MIDII/0
» Trigger Custom WAV File

from SDHC Cards
» Adapter or Battery Powered
» Compact Form

e 299.00 i 199.00

[ROTMZ).



ALESIS SamplePad Pro

8-Pad Percussion and Triggering Instrument
» Add New Sounds via SD Card Slot
» 8x Dual-Zone Rubber Pads
» x External Pad Inputs
» 5-Pin DIN MIDI 1/0

» 200 Built-In Sounds

» 10 Built-In Kits

» USBPort  » 1/8" Aux Input
(ALSAMPLEPADP) ... 299.00
KTMP1
FFFFFFFFFF Electronic Drum & Percussion

Pad Sound Module

» Four Velocity-Sensitive Pads

» Playable via Sticks or By Hand

» 50 Drum and Percussion Sounds

» Tune, Pan, Reverb,
Sensitivity, & Level

» Includes Stand Mount

[KAKTMPT). ..o

ALESIS SampleRack percussion
Module with Onboard Sound Storage

» 8x 1/4" Drum Pad Inputs
» 5-Pin DIN & USB MIDI 1/0
» Stereo 1/4" Main Qutputs  » Backlit LCD Panel
» Rackmountable Design  » 200 Built-In Sounds
» Sounds Expandable via SD Slot

» Dual-Mode Kick & Hi-Hat Inputs
» 1/8" Aux Input

[ALSAMPLERACK] ... 199,00

ALESIS SR-18

Portable Drum Machine

» 17 Pads

» Built-n Effects, £Q,
and Compression

» Battery or AC Power

» Backlit LCD

» MIDI and 1/4"
Connectors

[ALSRTB) ..o 20900

d“""'" Pacific 800-04 Series
Drum Throne

» Adjustable Height

» Suitable for All Styles =

» Folds for Easy Transport '

» 21" Min Height

» 28" Max Height ‘,'

[DWPDDTBO00A) ... 14,99

www.BandH.com

ELECTRONIC DRUM PADS

ALESIS DMDock

Drum Module for iPad

» Thirteen 1/4” Drum
Trigger Inputs

» Dual-zone Drum &
Cymbal Pad Compatible

» 1/4" Headphone Jack
with Volume Control

» Balanced 1/4" Stereo Outputs  » Powers and Charges iPad

» USB MIDI Port & MIDI I/0 Connectivity » Assignable Footswitch

(ALDMDOCK]) . 249,00

€ YAMAHA DD-65
Compact Digital Drum Kit

» Eight touch-sensitive pads for expressive playing
» Hand percussion mode 100 built-in songs
» Large LED Display =
» Headphone Jack

» Two assignable Foot Pedals
» b0 drum kits and custom kits
» Reverb and Master EQ effects
» Qver 250 GM-compatible voices

(YADD) ... 219,99

[4 lsfx#r-mmrm Machinedrum SPS-1 MK

Drum Machine, Synthesizer & Sequencer

» 16 Track Sequencer

» 4 MD Synthesis Methods

» 32Songs  » 16 LFOs

» b Individual Track Effects |
» Res: 24-bit / 44.1kHz ’
» 28 Patterns & 64 Step Patterns

» Internal Flex RAM - 80MB Per Project

999,00

(ELMDSPSTMER) ..o

Groove Production Studio

» Sequencer, Sampler & Multi-Effect Unit

» VST/AU Plug-In Host =

» Sample Library with
Over 66B of Sounds

» Includes MASSIVE
Synth Plug-In

» Multi-Function Master Push Encoder

» Time Stretch & Pitch Shift Features

(NAMMIKRMKZBK) ... 349.00

ELECTRONIC DRUM PAD ACCESSORIES

KD-7
Kick Drum Trigger Pad and Beater Unit
» Compatible with V-drums and other v W

electronic percussion modules
» Dynamic, velocity-sensitive
Kick Drum mini-trigger
» Thick rubber trigger pad
» All-metal construction

=

[ROKDT)...ccscc e 117.95

PRO AUDIO

@?,PVLE” PTEDO1 Electronic

Table Top Drum Kit

» 7 Drum Pads with Touch Sensitivity
» 7 Pedals Pad Layout
» 25 Preset Drum Kits
» b User Kits

» 100 songs

» 1 Demo Song

» 215 Percussion Voices
» USB Port (MIDI In/Out)

[PYPTEDDT) s

e 129.99

EC-10
Electronic Layered Cajon

» Hybrid Acoustic/Electronic Cajon

» Integrated Amplifier & Coaxial Speaker

» Sapele Wood-Playing Surface

» 30 Built-in Electronic Kits

» Standard Cajon Size (50 x 30 x 30cm)

» Up to 12 Hours Playing Time on Six AAs

» Layer Acoustic Cajon & Electronic Sounds
» Trigger Sounds from Head & Edge of Drum

[ROECTD) e

HandSonic HPD-20

Digital Hand Percussion Instrument

» 10" Pad with 13 Sections e m
» 850 Ready-To-Play Sounds
» |mport up to 500 of Your Own WAVs

» Sounds are Editable

» Roland's D-BEAM Control

» Record Performances to USB Flash Drive
» USB for Controlling Virtual Instruments

ROHPD20 . 899200

AiraTR-8
Rhythm Machine AN
» TR-808 and TR-909

Reproduction
» 11 Instruments
» External Input with Side-Chain Effects
» 16-Step Sequencer with A/B Variations
» Each Instrument Features Tone Controls
» 4 Real-Time Rolls & Per Instrument Mutes

» 16 Kits
» USB Audio / MIDI

[ROTRB) . 499,00

KT-10
Kick Trigger Pedal

» Kick Trigger Pedal for Electronic Brums
» Authentic Playing Feel

» Adjustable Pedal Response
» (uiet Operation

» Small Footprint

» Double-Pedal Setup Possible

[ROKTT0) o,

. 229.00
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GUITARS AT B&H

B&H now carries a full complement of electric, acoustic,
and bass quitars. Strum freely in the park with the
purchase of a Takamine acoustic, shred your audience
to pieces with an active-pickup ESP electric, delight
them with some bluesy licks from an Ibanez
Artcore, or thump out some massive bottom
end with a Music Man Sterling—the choice is
yours! Note that we also carry
an assortment of amplifiers,
cabinets, pedals, strings, and
other accessories to make

your  guitar  shopping
experience the best
it can be.

To view a full listing
of all Guitars

SCAN THIS CODE

or visit our website
BandH.com/w15301

ENI®

Ranging from masterpieces of metal to single-cutaway axes rock legends like Ron Wood can get behind,
the ESP lineup featured at B&H is quite extensive. Below, we've listed an E-II Eclipse, and E-II EX, and
several LTD models for your perusal. We also carry models from ESP's Thinline series—acoustic/electric
hybrids—as well as signature-series axes and a wide-ranging selection of basses. Also, if you're loaking
for seven-string, eight-string, or left-handed guitars, look no further; we stock those, as well

LTD TE-401

E-Il ECLIPSE FM Electric - Tobacco Sunburst (ESENECFMTSB)......ooooooooo.1,189.00
LTD H-101FM Electric - Dark Brown Sunb urst (ESLH101FMDBS) 329.00
LTD TE-401 Electric - Snow White Satin (ESLTEA01SWS) ... 68900
E-1I EX Electric — Black (ESE2EXBLK) ..o 1,099.00

We now carry a large selection of Ibanez guitars, which vary from the metal-oriented to the jazzy to the acous-
tic to everything in between. Don't believe us? Check out the models listed below: a Black Knight GRGM21
miKro Series Electric, an AMV10A Artcore Vintage Series Hollow-Body, and two acoustics, to boot. We also
carry Artist Series models, such as the John Scofield Signature JSM10 and the Paul Stanley Signature PS40.
Whether you're rocking out to eleven or getting yourself all jazzed up, Ibanez has something for you.

AEWAOASNT

149.99

GRGM21 miKro Series Electric - Black Night (IBGRGM21BKN)
AMV10A Artcore Vintage Series Hollow-Body Electric - Tobacco Burst (IBAMVIOATCL ................. 499.99

.299.99
399.99

AEG12I1 Acoustic/Electric - Natural (IBAEGT2INT) ..o
AEWA0ASNT Exotic Wood Series Acoustic/Electric - Natural (IBAEWADASNT)

302 800-859-5252 + 212-444-5072

€©YAMAHA

In addition to synthesizers, pianos, and motorbikes, Yamaha manufactures an extensive and excellent lineup of
quitars, many of which we now carry. You'll notice the Gigmaker Electric Bundle, a complete amplifier/guitar set
for well under $300. We also stock a wide range of Revstar models, including the RS320 electric guitars—pictured
below—as well as steel-string acoustics, classical uitars, and silent-body models such as the SLG200S; this axe
can plug straight into headphones, PAs, and mixing consoles, thereby bypassing the need for amplifiers altogether.

GIGMAKER

GIGMAKER ELECTRIC BUNDLE Pacifica PAC012 Electric & 15W Amp - Red (YAGIGMKRGRED)...... 259.99
REVSTAR RS320 Electric - Black Steel (YARS320BST). ... 399299
CGST03AI1 3/4-Size Nylon-String Classical (YACBSTO3AI ..o 129,99
SLG6200S Steel-String Silent - Tobacco Brown Sunburst (YASLG200STBS) 629.99
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GUITARS
Takamine acoustic guitars are used by some ortfie most popular artists in the world, from Bruce Springsteen to Blake
Shelton to Bruno Mars. Now, we at B&H can put a Takamine in your hands, as well. Choose from an array of models,
such as the EF360S Thermal Top Series, the Garth Brooks Signature Series, the EF341SC Legacy Series, and more.
We have models ranging from entry Level (the GC1) to the top of the line (the EF450C Thermal Top). Also, don't forget
about ukuleles. Never forget about the ukuleles. We haven't—we ve got soprano, tenor, and concert models available.

EF450C T TBB

EF360S TT Thermal Top Series Acoustic/Electric (TAEF360STT) 1,549.99
TAGBTC Garth Brooks Signature Series Acoustic/Electric (TAGB7C) ... 1,499.99
EF450C TT TBB Thermal Top Series Acoustic/Electric - Transp. Blackburst (TAEF450CTTTB)...... 2,549.99

GUITARS [z {eW.\V]p][e)

Waslibuen

We are pleased to carry an assortment of Washburn quitars, such as the EA12B Festival Series Steel-
String Acoustic and the C40 Thermal Top Nylon-String Acoustic, pictured below. But if guitars don't
tickle your fancy, we also stock a variety of other instruments from Washburn, including banjos (the
B8K 5-String), mandolins (the M1SDLB Bluegrass Series), and basses (the T14QTBL). Also, we have
left-handed Washburn acoustics, such as the WDT0SCELH Heritage 10 Series Acoustic/Electric.

§

EA12B Festival Series Steel-String Acoustic (WAEA128) 199.00
WD10SCE Heritage 10 Series Acoustic/Electric (WAWDTOSCE)........oooooo. 269.95
C40 Thermal Top Series Acoustic/Electric (WACAD).............c.oocoo.... Calll OF Log-o0

&

€
Ay MUSICMAN

Many bassists know that few things are as fm as a Music Man bass. Now, we carry the Sterling by
Music Man line. Check out the blue-burst RAY34 Electric Bass, as well as the John Petrucci signature
JP70—a seven string guitar with locking tuners and a Modern Trem Bridge. We also carry left-handed
Sterling basses (the RAY34LH), as well as the Steve Lukather signature LK100D, an electric guitar with
five-way pickup selection and an active circuitry boost.

AX40D

JP70 7-String Electric Guitar (STJP706GB)... R
AX40D 6-String Electric Guitar Ruby Red Burst [STAXA[]D]
RAY34 4 -String Electric Bass (STRAY34BB)

wsnine

An excellent choice for entry-level players and acoustic aficionados alike, Jasmine crafts quality dreadnought- and
orchestra-style guitars. Check out the S-34 Grand Orchestra acoustic for less than $80. Conversely, the JD-36CE
Dreadnought Acoustic/Electric will come in handy if you'e looking to grace a stage; this model goes for less than
$200. We also offer their mini-dreadnought, the JM-10, as well as their orchestra acoustic electric, the J0-47CE.
Whether you're looking for a traditional steel-string acoustic uitar or something with a cutaway, Jasmine and B&H
have got you covered—and for reasonable prices, too!

] - 2
] 5 :

[

S-34C Grand Orchestra Acoustic (JAS3ACT37132) .o
S-35 Dreadnought Acoustic (JAS35137131)... F
JD-36CE Dreadnought Acoustic/Electric lJAJDHéCENAWI
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MOCGCER Twin Series Reecho Pro

Digital Delay Pedal o

» 6 Delay Effects
» 3 Additional Effects \ B &
» Utilizes Floating-Point DSP Chips ~ .®
» 20 Second Loop Recorder with Overdub . @
» True Bypass or Buffered Bypass Switch % ="
» Controls for Dry, Wet, Low Cut, High Cut

[MOTDLT149940) . 168,00

322 Dhigilech 1ri0
Band Creator Guitar Pedal
» Analyzes What You Play on the Guitar
» Automatically Generates Bass & Drums
» 7 Genres & 12 Song Styles Per Genre

» Recall Song Parts On-The-Fly

» Adjustable Tempo

179.95

Eventide H9Max

Guitar Multi-Effects Pedal

» 45 algorithms from Space,TimeFactor/
PitchFactor, & ModFactor pedals

» 99 selectable presets

» Stereo /0 and MIDI /0

» Built-in tuner, True bypass circuitry
» Includes: H9 Control editor/librarian software

® -

.699.00

(EVIT79031) oo
Replicator

@ Tape Echo Pedal

» For True Analog Tape Echoes

» Delay Time from 8ms to 3 sec

» Chorus: Built-In Tape Modulation
» 2x Playback Heads  » Tap Tempo
» Feedback, Boost, and Saturation Controls

(TRREPLICATOR)
Replacement Tape Cartridge (TRTPCRTRDGSL)

» LED Peak Indicator

899.00
24.99

HOTONE Soul Press
Volume/Expression/Wah-Wah Pedal

» 3-in-1Volume, Expression & Wah Pedal

» True Bypass. Compact Size

» Active Volume for Lossless Tone

» Expression mode can be used
without a battery

» QVDC or 9V Battery Power Supply

[HOTPSPRESS)...oc

99.99

SNARK' SN-8
Clip-On Super Tight All Instrument Tuner
» Full Color Display  » Transpose Feature
» Rotates 360° » Tap Tempo Metronome
» Pitch Calibration: 415 to 466Hz

» High Sensitivity Vibration Sensor

» Brighter EZ Read Display

[SNBTBITTT o

EFFECTS PEDALS

RAT2

Guitar Distortion Pedal

» Compact and versatile guitar
distortion pedal. Control knabs
for filter, distortion, and volume

» Completely analog signal path

» Glow-in-the-dark graphics.

67.08

(PRRAT2)

t.c. electronic Ditto X2 Looper
Looper Effects Pedal

» Looper Effects: Stop, Reverse, 1/2 Speed

» Stereo I/0 » Unlimited Overdubs 4
» Dedicated Start/Stop Button

» Up to b Minutes of Looping

» True Bypass & Analog Dry-Through
» Import/Export Loops from Mac or PC

(TEDITTOXZL)

179.99

=M1 61%on

Multi-Effects Guitar Pedal

» 105 Guitar Effects

» 68 Built-In Rhythm Patterns
» Built-In Chromatic Tuner

» Built-In Expression Pedal

» b Effects Can Be Used Simultaneously
» b Expression Pedal-Controlled Effects

.69.99

(ZOZGTXON) e

KORG Pandora Stomp

Multi-Effect Processor and Tuner

» 4 Program Memory Buttons for Fast Recall
» 158 Amps & Effects for Guitar & Bass
» 200 Presets & 200 User Programs
» Amps & Effects Powered by

REMS Modeling. Integrated

LED Tuner & Metronome

(KOPXST) o 129,99

MMAOJ Moogerfooger MF-101

MF Trem Pedal
» Analog Tremolo Pedal
» Optical and Hard Tremolo Effects
» Sweepable Modulation Waveshapes
» For Guitar and Bass  » True Bypass
» Based On Balanced Modulator & Sub VEQ

(MOMFSTREMO2) ..o 179,00

DI20SS 1U-3

Chromatic Tuner

» For Electric & Bass Guitars

» 21-Segment LED Meter

» Accurate to +/- One Cent

» Accu-Pitch Verification of Tuning
» Powers for Up to Seven Effect Pedals
» High-Brightness Mode Enhances Visibility

.99.00

DBIBI: Sonic Stomp sonic Maximizer

Sound Inc. Stomp-Box Pedal

» 4821 Sonic Maximizer Quality

» Adds Clarity and Definition

» Low contour and process controls
» For Guitar, Bass & Keyboards

» True hard-wire bypass

(BBSS)

DI30SS RC-30
Loop Station Pedal

» Dual-Stereo Looping Pedal

» XLR, 1/4", and Mini- Jack Inputs
» Up to 3 Hours of Recording Time
» Records to 16-Bit 44.1 kHz WAV Files
» Layer Complex Arrangements

» Built-In Effects and Drum Beats  » Buffered Bypass

[BORCDQ) . £99.00

electro-harmonix KEY9
Electric Piano Machine Pedal
» For Guitar or Keyboard Effects

» Emulates Electric Piano Tones

» 9x Presets

» Dry, Keys, CRTL 1, and CRTL 2 Knabs

» Rugged & Easy-to-Use

» Includes DC Power Supply

L2130

¢lectro-harmonix Silencer
Noise Gate

» Tame Irritating Noise in Your FX Chain

» Delivers up to -70dB of Noise Reduction
» 8ms to 4 Seconds of Release Time

» Rugged yet Compact Chassis

» 9V Battery or Optional AC Adapter

[ELSILENCER). .. 9160

{(r13) M101 Phase 90
Phase Shifter Pedal

» For Electric Guitar, Bass or Keyboards

» Adds Shimmery Velocity to Lead Lines

» Adds a Dramatic Swoosh to Chords

» Rich, Warm Analog Tone  » True Bypass
» Runs on 9V Battery  » LED Indicator

IMXMTOT) e 19:99)

Clip-On Tuner

» Full color LCD display

» Integrated clip with 360°
movement for easy viewing

» Built-in mic or clip-on setting for precise tunlng

» Chromatic, guitar/bass tuning scales  » Pitch calibration
rages A 410-490Hz  » Flat tuning/transposition

[SACT20)..coccnr

SAMSON (120 p——

Call or Log-on

800-859-5252 + 212-444-5072



JC-40 Jazz Chorus

40W 2x10 Guitar Amplifier
» 40WRMS » 2x10" Speakers
» Twin Cabinets for

Stereo Capabilities
» Chorus/Vibrato, Reverb

& Distortion
» (n-Board Stereo Effects Loops
» Three-Band EQ and Bright Switch
» Stereo Line Outputs and Headphone Output

[ROJCAD).. 9900

MOBILE AC: Acoustic Chorus
Battery-Powered Amplifier

» Inputs for Guitar, Microphone, and iPod
» Independent Volume Control per Input
» Powered for 15 Hours

by Six AA Batteries
» Dual 4" Speakers with

“Wide" Button
» Built-In Stereo Chorus & Reverb
» 1/8" Headphone Qutput

[ROMOBILEAC) .- 129,00

Micro Cube Bass RX

Portable Bass Amplifier A

» Four 4" Drivers

» Dual 2.5W Power Amps

» Portable Design

» Battery or AC Power

» COSM Amps and
Digital Effects

» 1/4"1/0 Connectors

v 279.00

(ROMICROCBRX) ..o

UII30SS eBand JS-10
Audio Player with Guitar Effects
» 2.1 Channel Sound with Integrated Sub
» Records to USB Flash Drive or SD/SDHC
» Built-In COSM Amp Modeling
» 2C1/4" Inputs for

Guitar, Bass, or Mic
» 350 Loops & 50 Songs
» Loop & Repeat Modes
» Import MP3s & WAVs

[BOUSTO).c

Performance 2
G Capo for Steel String Guitar

» Smaller & Lighter Than Original Model
» Wrap-around rubber protects
the finish on your guitar
» Clamps to Guitar Neck
and Raises Pitch
» Silicone Improves Tone & Protects Neck
» Squeeze Design for Reduced Tuning Issues

(67PRF26STBLK) ... Call or LOg-0n

www.BandH.com

GUITAR AMPLIFIERS & ACCESSORIES

Blackstar® FlY3
40W 2x10 Guitar Amplifier

» Can Be Used as Compact
Portable Speaker

» 3" Speaker

» Clean and Overdrive Channels

» Built-In Delay & Infinite
Shape Feature

» Battery or DC Powered

» Uses 6x AA Batteries

Blackstar

(BLFLYS). 99,99

. .
A Soun_dBox mini B
= Mobile Multipurpose Amplifier

» For Guitar, Bass, Keyboards, Vocals

» Sound Technology Based on VOX Amps

» 1/8" Auxiliary Input
for MP3 Players

» Built-In Effects

» Center Cancel Function
for Singing Along

» Mic-Stand Mountable

Black (VOSNDBOXMMBK) ..o

7/ MAX 115
”\/I/ Bass Combo Ampilifier

» 300 watts into 8 ohms

» DDT speaker protection

» Pre-gain control with
TransTube gain boost

» Chromatic tuner

» Tuned, ported enclosure

» Built-in direct output
with ground ift

i 349,99

(PEMTTEC)

VT-12
Vocal Trainer
» Pocket Vocal Coach  » Visually Check Pitch
» Detects 2 Singers for Two-Part Harmany
» Record-In Function with 10 Tracks
» Built-In Metronome
» Additional Audio Exercises
» Convenient Handheld Form
» A Battery Powered

- 199.00

Metalic Orange (ROVT120R)........c..ccoc

Musicians Value 651000
Guitar Stand

» For AU Conventional-Shaped Guitars
» Thick Structural Tubing

» Rubber Padding

» Security Strap

» Adjustable Height

» Removable Lower Stepped Yoke

(MUGS1000) .. 10,99

PRO AUDIO

Marshat? MG3OCFX

Solid-State Combo Amplifier

» MG Carbon Fiber Enclosure
» Single 10" Custom Speaker
» Gain and Volume Knobs
» Chorus, Phaser, Flanger,
Delay, Octave
» Clean, Crunch, OD-1, 0D-2 Presets

(MAMG30CFXU) 199.99
MG10CF Solid-State Combo Amplifier (MAMG10CFU)................. 79.99

Quilter 101 MiniHead
Guitar Amplifier

» Up to T00W Qutput  » Gain Control for Overdrive

» All-Analog Circuitry  » Serial Send and Return Effects Loop
» Five Voice Settings  » Headphone Output for Private Listening
» Tri-( Variable Tone Control
» Two Speaker Output Jacks
» Hi-Cut High-Frequency

Attenuator
» Master Output

[QUIDTMINIHD) ..o

= |R|g HD

rumeon - GUItar Interface

» Compatible with i0S and Mac Devices

» 1% 1/4" Hi-I Instrument/Line Level Input

» Preamp Gain Control

» 24-Bit A/D Conversion

» USBYi0S Device Powered

» Includes i0S 30-Pin and
Lightning Cables

» Includes USB Cable

(IKIRIGHDIND s

A JAM 96k
apocee Guitar Interface

» Fori0S Devices & Mac Computers

» Designed for Guitar and Bass

» Up to 96kHz/24-bit Audio Resolution

» Circuit Design for Tube Tone Emulation

» Compatible with Any Core Audio App

» Plug-and-Play Operation =7

» Includes Lightning
&USB Cables

2 129.00

[APJAMIBKLO).....ccccoo

e

K&M KONIG & MEVER 17540
E-Guitar Stand

The black 17640 E-Guitar Stand from K&M
is designed to hold your electric guitar.
The width is adjustable from 8.7 to 13.8",
and is 16.5" tall. The support arms are
covered with non-marring plastic
to protect your instruments finish.

[KM7B40B) ... 63,99




SHURE (LX-D
Digital Wireless

PRO AUDIO
Offering networked control, AES-256
encryption, and simplified setup

and operation, QLX-D delivers k
for mid-size events and installations.

outstanding digital wireless sound

LIVE-WIRELESS

SHURE PGX-D
Digital Wireless

PGX-D Digital offers wireless
audio that sounds like wired,
rock-solid RF performance, and
simple setup and operation for
small clubs and venues.

=

SHURE (LX-D
Digital Wireless

=

GLX-D Digital features intelligent technology and convenient
rechargeable power options for musicians who run their own sound.

Lavalier System (SHXDT4B3HGD]..........cooooovvvn 108300 favalir System (SHPOXD1493) ...................399.00 Lavalier System (SHGLIDI48522) 549.00
Handheld System (SHD245M58650) 999.00  eadset System (SHPGXDT4PGAY).. . ........399.00  Handheld System (SHOLXD2ISETZ) ___ 499.00
Combo System (SHXDT2ABG60).........cvcove LAIIO0 yondnelq System (sHPEXD24SMSB)..................379.00  Handheld System (SHGLXDZ772) ...............589.00
SHURE ULX-D SHURE BLX SHURE ULX Series

Digital Wireless ‘/—‘\ Analog Wireless Microphone System

ULX-D Digital Wireless offers extremely

efficient RF performance, networked ;
control, Dante digital audio, and

AES-256 encryption for professional

sound reinforcement.

The ideal entry-level wireless microphone system for small venues,
BLX offers professional quality sound with simple setup and an
intuitive interface.

» Automatic Frequency Selection
with group scan function

» Up to 1440 frequencies

» b-segment transmitted audio
signal strength meter

Lavalier System (SHULXD144J50) ..o 1,634.50 Lavalier System (SHBLXTACVLHY)_____299.00 Bodypack System (SHULXST4J1).......ccoov..... 629.00
Headset System (SHULXD4G50K)......oooco 1,419.00 Handheld System (SHBLC288P56)) . 549.00 Handheld System (SHULXS245863) ... 689.00
Combo System (SHUD12485H) 1,902.00 Headset System (SHBLX14PG10) 299.00 Combo System (SHULXS12485)) 989.00

71 sennHEISER Evolution D1

Digital Wireless Q\
- )

These systems combine digital -

innovation with a great selection
encies

of options and evolution capsules.
and synchronize up to 15 additional transmission links.

They can quickly locate the best frequ

Bodypack Transmitter (SESKD1) 299.95

7 sennHEISER Eyolution 63

Professional wireless solutions for large stages and
multi-channel applications. 63 combines
analog system benefits with sophisticated
third generation technology. Extremely
easy-of-use, up to 32 channels, and
huge UHF bandwidth.

71 sennvHEISER XS Wireless

The system is quick and easy to set up due
to its automatic search for free frequencies
and synchronization via RF remote channel.
Professional True Diversity technology
guarantees optimum reception
under any circumstances.

_ Bodypack System (SEEW11263) 649.95 Lavalier System (SENXSW128)
Lavalier System (SEEWDIMED ... 69995 ayatior System (SEEWIS563A).........................599.95  Handheld System (SENKSWA5E) . -399.95
Headset System (SEEWD18356) 69995 oqdset System (SEEWIEGAA) 049.95  Headset System (SENXSWSZA) ... 4995

@audio-technica, System 10 PRO
This system operates in the 2.4GHz range

(outside of TV bands). Its half-rack
chassis can house 2 receiver units,

allowing 4 channels to fit in a single rack spac® %

Up to'5 chassis (10 receiver units] can be linked and used simultaneously.

@ audio-technica. 3000 Series

The 3000 Series wireless systems
offer up to 1001 selectable UHF
frequencies, clear sound &
intuitive operation, and
Frequency-agile True Diversity UHF.

@audio-technica, 2000 Series

Frequency-Agile True Diversity
UHF Wireless System features 10
user-switchable channels, Tone
Lock squelch to fight interference, and a ground-Lift switch to elimi-
nate hum. Rack-mount kit and detachable UHF antennas included.

Handheld System (AUATW1302) 449.00 Bodypack System (AUATWSTIOBS). . 449.00 Bodypack System (AUATW2110AD) 329.00
Lavalier System (AUATWITOIL) oo 349,95 Lavalier System (AUATWS1318C) 549.00 Lavalier System (AUATW2129AD) ..o 379,00
Combo System (AUATW1312L) 849.00 Handheld System (AUATW31418C) 549.00 Handheld System (AUATW2120AD) ... 379.00

Series Digital/ Frequency Receiver Range Encryption Max ; Dante/ Rack
Analog Range Format Channels Ethernet Mount
Shure QLX-D Digital UHF Single 328 (100m) Yes n Lithium-lon, AA 10 Hrs Yes Yes XLR, 1/4
Shure PGX-D Digital UHF Single 200" (60m) No 5 M 10 Hrs No No XLR, 1/4”
Shure GLX-D Digital 2.46Hz Single 200" (60m) No 8 Lithium-lon 16 Hrs No No XLR, 1/4"
Shure ULX-D Digital UHF Single, Dual, Quad 328 (100m) Yes 60 AA 11 Hrs Yes Yes AR
Shure BLX Analog UHF Single, Dual 300" (91m) No 12 AA 14 Hrs No No XLR, 1/4"
Shure SLX Analog UHF Single 328" (100m) No 12 M 8 Hrs No No R 1/6
Sennheiser Evolution D1 Digital 2.46Hz Single Not Specified No 15 M 6 Hrs Yes No AR
Sennheiser Evolution 63 Analog UHF Single Not Specified No 32 M 8 Hrs No No XLR, 1/4”
Sennheiser XS Wireless Analog UHF Single Not Specified No 12 AA 10 Hrs No No XLR, /4"
Audio Technica System 10 PRO Digital 2.46Hz Single, Dual 200" (60m) No 10 AA 7 Hrs Yes Rack Ears Included XLR, 1/4”
Audio Technica 3000 Analog UHF Single 300 (91m) No 10 AA 8 Hrs No Rack Ears Included R 1/6"
Audio Technica 2000 Analog UHF Single 300 (91m) No 16 AA 9 Hrs Yes Rack Ears Included XLR, 1/4”

800-859-5252 « 212-444-507




N WMS 40 Mini Vocal set
Handheld Wireless Mic System

» Frequency Set B
» HT 40 Mini Handheld Transmitter

» Operates up to 30 Hours on a AA Battery

» Dynamic Cardioid Capsule
» Stable UHF Operation

» Miniature Receiver Design
» 1/4” Phone Audio Output

AKWMSADVADB .........ooocoee

gemini UHF-116HL
Wireless Head-worn
Microphone System

99.99

» Combo Headset/Lavalier Micraphone
» 16 Selectable UHF Frequencies
» 1/4" Phone Output Connecto

» 0n/Off Microphone Switch
» Qutput Level Control

(GEUHFTI8HL) ..o

SPYLE POWNZEND

J_

_.Callor Log-on

4-Channel Wireless System

» High signal/noise ratio performance

» RF signal & AF signal LED indicators

» UHF band receiver system

» (Quad frequency channel design

» Operating range of 164 (50 m)

» Broad frequency response
range & low distortion

[PYPDWMBB00) ..

COUNTRYMAN
ASSOCIATES, INC Hb

Omnidirectional Microphone Headset

» Omnidirectional Polar Pattern
» 2.5mm Diameter Capsule

» Adjustable Head Frame

» Sweat-Resistant Connectors
» Switchcraft TA4F Connector
» Includes Windscreen

» 5" Cable

7 sennHEISER A2003UHF

Directional Wide-Band Antenna

» 450 to 960MHz Wide
Band UHF

» Enhances Reception

» Mounts To Microphone
Stands

» Lightweight

[SEAZODBUHF) ..o

I sennMEISER

FTY
/ \ %
L \

m/\:

—

COMOWSTSL 49500

279.95

LIVE-WIRELESS

Bl Electro-Voice RE-2
Wireless UHF Microphone System

» Includes: RE-2 Receiver,
HTU-2 Handheld Transmitter
and ND267 Cardioid Capsule
(Band A 648-676MHz)

» HTU-2 Cardioid Handheld
Transmitter  » Frequency Agile UHF

» 1,112 possible channels

» Diversity Reception
» Advanced ClearScan

(ELREZNZA). .o 599,00

77/ ~7 77 JHF-5900

Wireless Mic System with Frequency Scan

» Four Simultaneous Microphone Operation

» UHF Operation Over 600MHz Band

» Auto Frequency Scanning

» Four XLR Channel Outputs

» Mixed Stereo 1/4”
Phone Qutput

» LCD Displays

(VOUHF5900) . Calll o Log-un

SHURE SLX
Analog

SLX Wireless offers quick setup and exceptional wireless clarity for
working bands and professional installations.

SLX14/93-G4 Mic System (SHSLXT49364) .........c.ooocoe..
SLX24/BETA58-H5 Mic System (SHSLX24BB8HS) ...

599.00
639.00

SHURE SM10A-CN

Cardioid Headworn Dynamic Microphone

» Unidirectional (cardioid) polar pattern

» Close-talk design provides
excellent isolation and
minimizes gain-before-feedback

» Extremely rugged with fully
adjustable headband and
microphone boom

(SHSMAOACN) . 108,88

@audio-technica. ATW-A49
UHF LPDA Antennas (Pair)

» LPDA (Log Periodic Dipole Array) antenna

» Designed for use with Audio-Technica UHF
wireless systems ~ » 440-900MHz range

» Directional coverage pattern

» Beam-width of 90 degrees

» |deal for use in theatrical & musical
performances  » Sold in pairs

219.95

AUATWAR ...

PRO AUDIO

SAMSON Stage X1U
Digital Wireless USB Microphone

» Record Wirelessly to Mac or PC Computers
» For Lectures, Seminars,

& Recordings
» 100" Operating Range
» Easy Pairing for Fast Set Up
» 2.46Hz Digital Wireless System
» Wireless Receiver Built Into a USB Stick

&

[SASTAGEXTU]...occccs

89.99

SAMSON Concert 288 All-In-One

Dual-Channel UHF Wireless System

» CR288 Wireless Regeiver |

» Handheld Transmitter
& (6 Dynamic Mic

» Beltpack Transmitter

» | M5 Lavalier Mic and

HS5 Headset Mics > g
» 300" Operating ‘
Range ﬂb
(SASWC2BBALLH) . oo 329,99

> AudioStream Pro EL Pocket Portable
semussews - Digital Wireless Stereo Lavalier
» |deal for podcasting, VoIP, Audio Monitoring
» Wide 15Hz to 20kHz frequency response
» Compact, rugged & lightweight design
» Uncompressed 16-bit, 48kHz l i
CD quality wireless audio
» Built-in 2-way USB interface

» Internal rechargeable batteries
» Up to 6 hours of operation

(WIASPEL)....o o= Call or Log-on

RYLE’ POV

4-Channel Wireless System

» UHF band receiver system -

» (Quad frequency channel
design  » Operating
range of 164" (50m)

» Broad frequency response
range & low distortion

» High signal/noise ratio performance

[PYPDWMABB0U) ... 229,99

SHURE UA874

Active Directional Antenna

» Directs a Cardioid Pattern Toward Target
» Four-Position Gain Selector Switch

» Low-Noise Signal Amplifier

» Makes Up for Coaxial Transmission Loss
» Integrated Threaded Adapter

» Mounts Easily to Microphone Stands

» 470-698MHz

.313.95

SHUABTAUS. ...



o W:\V[p][el8 PA SPEAKERS

7% EON600 Series

Powered Sound Reinforcement Speakers

» 10" Woofer with Bass Reflex Cabinet

» 110 x 80> Coverage Pattern  » 5-Way User Definable Parametric EQ

» Proprietary Waveguide Technology  » 1000W Peak Class D Amplifier

» Bluetooth Controllable DSP » Two Handles for Easy Transport

» Dual Combination XLR - 1/4” Inputs  » Main, Monitor, Sub, Speech Modes

EON610 10" 2-Way Speaker (JBEONATO).........coocccovcc 399.99
EON612 12" 2-Way Speaker (JBEON612)

EON615 157 2-Way Speaker JBEONOTE) ..o

IS KSeries
1000 Watt Powered Speakers

» Powerful, Lightweight, & Versatile  » Mix & Output Three Signals Internally

» Inputs: Combo XLR & 1/4” TRS,RCA  » Strong ABS Enclosure, Tough Steel Grille
» 1000 Watt QSC Amplifier Built-ln -~ » Integrated DSP Technology

» 3bmm Pole Sockets with Tilt Capability » Cast Aminum Handles

K8 8" 2-Way Speaker (SK8) 649.99
K10 10" 2-Way Speaker (OSK10)..........oococi. 699,99
K1212" 2-Way Speaker (OSK12).....c..ooccovoococcc. 199.99

KSUB Dual 12" Subwoofer (QSKSUB) 1,079.99

IMMNCKIE. SRM Series
T000W Portable Powered Loudspeakers

» 1.4” Titanium Dome Compression Driver

» Automatic Feedback Elimination

» 2 XLR/TRS Combo & Stereo RCA Inputs

» Precision 2-Way Crossover

» Application-Specific Speaker Mades

» Integrated 2-Channel Mixer  » 12" High-Output LF Driver
» Limiter for Speaker Protection  » Rugged Design

SRM350 10" Loudspeaker (MASRM350V3)
SRM450 12" Loudspeaker MASRMABOVE)............ooccccccc

Electro-Voice ILX Series
Two-Way Powered Loudspeakers

» Two-Way Powered Loudspeaker

» LCD display and 1-knob DSP control with presets

» Input level meters and independent amplifier control

» Front LED for “power on” and “limit” indication

» Patented split-baffle design for superior driver time alignment
» Innovative high/low grip design for easy pole mounting

ZLX-12P-US 12" Powered Loudspeaker (ELZLXT2PUS) ..o
ILX-15P-US 15" Powered Loudspeaker (ELZLXTSPUS).......c...coocococce

77/ PR Series
/4
1\3 / 2-Way Portable PA Speaker

» 400 Watts Program

» 800 Watts Peak  » 1/4" Phone Inputs

» RX14 1.4" High-Frequency Driver

» 90 x 40° Constant Directivity Horn

» Light Weight Enclosure  » Pole Mountable

PR10 with 10" Woofer (PEPRT0).........oocccccc 199,98
PRIZ With 127 WOOFer (PEPRTZ).....cctccssess 19299
PR15 with 15" Woofer (PEPR1S) 249.99

5 SRX800 Series
JBL. Self Powered SPeakers

» 1x JBL Premium 12" Woofer ~ » 136dB Max SPL

» 480 20,000Hz (-3dB) » 2000W Peak Crown Drivecore Amp

» LCD Screen with JBL Application Presets  » HiQnet Network Control
» Integrated DSP with Network Control  » M10 Suspension Points

» Works with Vertec and VRX Systems ~ » 18mm Ply Construction

SRX812P 17" Two-Way Bass Reflex Self Powered (JBSRX812P) ....... 1,299.00
SRX815P 15" 2-Way Bass Reflex Self Powered (JBSRX815P)
SRX818SP 18" Self-Powered Subwoofer (JBSRXB18SP).......o oo

1,399.00
1,599.00

IS KW Series
1000 Watt Powered Speakers
» Powerful, Lightweight, & Versatile  » Mix & Output Three
Signals Internally > Inputs: Combo XLR & 1/4” TRS, RCA
» Strong ABS Enclosure, Tough Steel Grille
» 1000 Watt QSC Amplifier Built-In - » Integrated DSP Technology
» 35mm Pole Sockets with Tilt Capability  » Cast Aluminum Handles

KW122 1000W 12" Active 2-Way Loudspeaker/Monitor (0SKW122) ..1,099.00

KW152 1000W 15" Active 2-Way Loudspeaker (QSKW152)
KW181 1000W 18" Subwoofer (ASKWIBT) ...

1,199.00
1,399.00

IMMNACKIE. Thump Series

1000 Watt Powered Loudspeakers

» 1.75" Compression Tweeter  » 2x 500W Class-D Amplifiers
» XLR/TRS Combo and RCA Inputs  » XLR Line and Mix Outputs
» Integrated DSP with DEEP

» Intrinsic Correction and GuardRail

» Directivity Matched Transition Coverage

» Pole Socket with Tilt-Direct  » M10 Rigging Points

Thump12 12" Powered Loudspeaker (MATHUMP12)
THUMP15 15" Powered Loudspeaker (MATHUMPTE) .........occcccoovovoce

Electro-Voice EKX Series
Two-Way Powered Loudspeakers
» (QuickSmart DSP processing  » Intelligent thermal management
» 1500 W Class D power amplifier delivers up to
132dB peak SPL on the EKX-12P
» Signal Synchronized Transducers (SST) waveguide design
provides precise and consistent coverage
» Lightweight, compact 15-mm wood enclosure

EKX-12P 12" Loudspeaker (ELEKX12P)........799.00
EKX-15P 15" Loudspeaker (ELEKX15P)..........899.00

7 Dark Matter Series
I\/I/ 2-Way Woofer Speakers
» On-board advanced DSP with LCD
» Patented Quadratic Throat Waveguide

technology, 110 by 80 degree coverage

» Pole mount molded-in for 1 3/8" diameter poles
» Suitable for band, DJ, or other musical applications

w N
Y-
o o
Lo o
° o

EKX-15SP 15" Subwoofer (ELEKX15SP)......... 899.00
EKX-18SP 18" Subwoofer (ELEKX18SP).........999.00

DM112 2-Way 12" Woofer Speaker System (PEDM112)........................ 299.99
DM115 2-Way 15" Woofer Speaker System (PEDM115)
DM118 Sub 18" Powered Subwoofer (PEDMTT8ST20) ..o

800-859-5252 + 212-444-5072




JRX200 Series

Loudspeaker System

UBL

» Low-frequency driver with a 2.5" diameter edgewound ribbon voice coil
» 1" polymer diaphragm compression driver
» High-voltage capacitors and inductors
» SonicGuard protects the high-frequency driver from
excess power without interrupting the performance

12" Two-Way Stage Monitor Loudspeaker System (JBJRX212).............. 249.99
JRX215 15" 2-Way Sound Reinforcement Loudspeaker System (JBJRX215) 299.99
JRX218S 18" Compact Subwoofer BJRK218) ........ooocccccc 599,99

QIS KA1

12" 2-Way Line Array Loudspeaker

» Rugged ABS Enclosure  » 12" Woofer

» 1.75" Compression Tweeter

» 500W x 500W Power Amp Module

» XLR and PowerCon Input/Thru Connectors

» DEEP DSP and GuardRail  » Ar-Q Processing

» SOLO Rigging System  » Tilt-Direct Pole Mount

(OSKLA12B)
KLA181 1000-Watt Subwoofer (QSKLATBTBY ...

1,759.99
e 1,859.99

MACKIE. (200

Passive 10" 2-Way Loudspeaker

» Precision-Tuned by Eaw
» Incredibly smooth, spike-free respanse and
dispersion over a wide range of treble frequencies
» Tuned to Perfection  » Ultra-Wide Dispersion
» Injection-molded composite chassis
and premium components

[MAC200) 199.99
€300Z Compact 300 Watt 2-Way Passive PA Speaker with Constant Directivity Horn (MAC300Z).........349.00

B212D
vehringer  2-\Way Active Loud Speaker

» 200 Watts  » 8" Long-Excursion Driver

» 1.35" Aluminum-Diaphragm TweeterDenon Delta 1035mm Pole Socket
» Lightweight Class-D Amplifier

» 35-mm Pole Socket  » XLR & 1/4” Phone Inputs

» Side Mounting for Stage Monitoring

[BEBZ1ZDB) o 269,99
B210D 200w, 10" Woofer (BEB210D8) 199.99
B215D 550w, 157 WOOTer (BEB21GDB) ... 929:99

NIA DY  PM-200A
5” Active Nearfield Personal Stage Monitor Speaker
» Lightweight and Durable

» Dual 5" Drivers

» 150W RMS Amplifier

» Volume Control and 3-Band EQ

» XLR and TRS Inputs

» Line and Speaker Outputs

» 1/4" Headphone Output  » Protection Circuitry

NAPM2OOA oo, CalL OF LOG-ON

www.BandH.com

PA SPEAKERS [ {eW.\V/p][e)

PRX700 Series
1500W 2-Way Self-Powered Speaker

» 133dB peak SPL  » 10" Low-Distortion, Low-Frequency Woofer

» Waveguide for Accurate Coverage  » Tongue & Groove Construction

» 1.5" Neodymium Compression Driver — » DSP for Crossover, Limiting, EQ

» Line Level and Microphone Inputs  » Combo Balanced XLR and 1/4" Inputs
» Integrated Handle and Pole Mount Socket  » Class-D Amplifier

PRX710 10" Multipurpose Speaker (JBPRX710) .........ccc.cccccnn.. 749.00 L
PRX712 12" Multipurpose Speaker (JBPRX712) 849.00
PRX715 15" Multipurpose Speaker (JBPRXT1) .........ccocciccc. 949,00

DENON Delta Series

10" 2-Way Powered Loudspeaker

» Advanced Engineering and Design  » 10" Low Frequency Transducer
» 1.75" High Frequency Transducer  » 90° x 60° Dispersion Pattern

» Custom Controlled DSP Crossovers  » Ground Lift Switch

» Wireless Control Over DSP Functions  » Limit/Clip Indicators

» Built-In Mixer  » Flyable via 12x M10 Rigging Paints

Delta 10 10" Loudspeaker (DELTA10) 599.00
Delta 12 12" Loudspeaker (DELTAT2) ............699.00
Delta 15 15" Loudspeaker (DELTA15) ............799.00

Delta 15 Sub 15" Subwoofer (DELTA15SUB)...899.00
Delta 18 Sub 18" Subwoofer (DELTAT8SUB) ._999.00

_MAVS - Fl1Model 812

Powered Flexible Array Loudspeaker

» 8-Driver Mid/High Line Array

» 12" LF Driver  » 1000 Watts Bi-Amplified
» Four Vertical Coverage Patterns

» Optimize Sound to Fit the Venue

» 2-Channel Integrated Mixer

» XLR, 1/4" & RCA Inputs

(BOF1FALS) 1,199.00

F1 Powered Subwoofer (BOFTSW) ..o 1,199.00

B212XL
vehringer 800W 2-Way Passive PA Speaker

» Passive Speaker

» 800W Peak

» 200W Continuous

» 12" Woofer

» 1.75" Titanium Compression Driver

» 1/4" and Speakon Parallel Connections

@OPYLE' PPHPSO3MU
PR( Powered Two-Way PA Speaker

» Power Output - 300 Watt (600 Watts Peak)

» Titanium Diaphragm Tweeter - 1"

» MP3, USB and SD-Card Playback

» Woofer Size - 8" » 1/4” Phone Mic Inputs

» Mini 1/8” (3.5mm) & RCA Stereo Inputs

» /4" Line Output  » LCD Display

» Lacking Speaker Pole Insert - 3bmm

PYPPHPBOSMU ... 103021




I TN Ul PORTABLE PA SYSTEMS

Portable PA Systems

With power outputs ranging from 20 watts to 1000 watts and low frequency woofers from 4 to 157, there’s a portable PA system for almost every
occasion. Whether it's a rechargeable system with wheels and a telescoping handle, or a larger set of speakers designed for speaker stands, many
models include a microphone, a built-in mixer, EQ controls, FX, and digital connectivity to your source via Bluetooth, USB, or an i0S 30-pin dock.

ALESIS AMERICAN AUDIO =
ANBAMPLIVOX @ 7’%0{% ):( 1on
behringer

DENON SAMSON  (technical

Bl S

BOSE™
MACKIE. <R3
OFx  J&y  ©YAMAHA

m Fender Fender ION Audio

pro

Model TransActive | TransActiveVU|  S610A AN-1000X+ | B20SD  MPAGOBT-PRO L1 Ewoi | osseort o Passport P@:ﬁﬂ‘;" et
Power Output 25W 50w 50w 50w 150W LW Not Specified 360W 175W 375W 600W 50W
Speaker Size Not Specified 8 Horn Driver 3 b 8 Not Specified 10" b.25" 8 10" 65"
Rechargable Battery v v v v v
Wireless v v
Includes Mic v v v v v v
FX v v
EQ v v v v v v v
BlueTooth v v v v v
CD/MP3 v
UsB v v v v
Wheels v v
30-Pin Dock v
Switching Power Supply v v
Color Black Black Gray Black Black Black Black Black Black Black Black Black
Itemcode (ALTRNSACTWRL) | (ALTRNSACTWVU) (AMS610A) (ANANT000XP) (BEB205D) (BEMPA4OBTPRO) (BOL1) (DEENVOI) (FEPC175W) (FEPE375W) (FEPE60OW) (IOTAILGATERI)
Price 199.00 249.00 344.95 Call or Log-on 199.99 199.99 999.00 599.00 399.99 699.99 999.99 119.99

Model Blolcplxﬁulc\ker EON206P SRM150 FreePlay PBX 3080BT | PBX 710700BTL  Escort 6000 | PWMA1090UI CM-30 XP106W  |WASP1050UIBT STAGEPAS 6001
Power Qutput 50W T60W 150W 150W 600W 25W 600W 80ow 3w 100W 1050W 680W
Speaker Size 8 6 b 8 8" 0 10" 107 0 6 107 10
Rechargable Battery v v v v v v 4
Wireless v v v v
Includes Mic v v v v
X v v v v
EQ v v v v v v v v
BlueTooth v v v v v v v
CD/MP3 v
USB v v v v v v
Wheels v v v v v
30-Pin Dock v v v
Switching Power Supply v 4 v
Color Black Black Black Black Black Black White Black Black Black Black Black
Itemcode (10IPA76A) (JBEON206P) (MASRM150) | (MAFREEPLAY) | (QFPBX3080BT) | (QFPBX710700B) | (PEESCORT412U) | (PYPWMAT090UI) | (ROCM3D) (SAXP106W) | (TEWASP1050UI) | (YASP60OI)
Price 154.22 449.00 249.99 399.99 149.99 51.67 899.95 214.99 199.00 299.99 159.99 899.99

310 800-859-5252 + 212-444-5072




@3 PYLE' PWMA50 waistband
PR

Portable PA System (Black)

» Small super powerful voice amplifier /

» Used by teachers, coaches, tour {
quides, presenters, US Army '

» Projection range up to 1/2 mile

» Includes headset microphone

» Built-in rechargeable lithium batteries

» AUX input for MP3 player or iPod

PYPWMABDB ........oocccccc

Silver [PYPWMAE[]S] 29 l](l Whlte [PYPWMAE[]W]

ANEAMPLVOX Mity-Vox
Portable Battery Powered PA System

» Operates on 8 D-cell rechargeable batteries
» Reaches Audiences of up to 150 People

» Built-in Wireless Receiver

» Wireless Handheld Transmitter

» Wireless Bodypack Transmitter

» Lapel Microphone

LANBAMPLIVOX Pro BeltBlaster

)

» Charging Time: 6 hours

..26.99
.. 2699

28475

Waist-Worn PA System with Microphone

» b Watt Small PA System you wear like a belt
» Runs on 6 NiMH AA Rechargeable Batteries
» Headset and lapel microphone

» Adjustable volume controls

» Neoprene Protective Sport Cover
» Heavy Duty Nylon Carrying Case
» 44" belt and 12" extender

«»” MP-10
POLSEN" Megaphone with Siren
» Qver 500 Yard Audible Range
» 10W of Output  » Built-In Siren
» Built-In Microphone
» Adjustable Volume Control ’
» Sturdy ABS Construction
» Collapsible Handle
» Includes Carrying Strap

O PYLE PMP30)

PR Prof. Megaphone/Bullhorn
» Built-in siren
» 30W of Power
» 800 Yard Range
» Tough housing
» For indoor/outdoor use |
» Variable volume control

» Used by U.S. Army, Nawy, Air Force and Marines ‘

(PYPMP30)..
PMP40 Professwonal Megaphone/Bullhom [PYPMPAD]

.125.00

14.95

=118

..19.99

PERSONAL PA SYSTEMS & MEGAPHONES

@O PYLE PWMA200
PR( Wireless Portable Ampilifier
» Wireless Rechargeable Amplifier

» Lavalier Mic with
Bodypack Transmitter

» Bonus Wired Microphone

» All-in-one design for easy
carrying and portable use

» FM radio function

» Works on both AC & DC

(PYPWMAZ00)............ .69.99

@ PYLE PWMAGOUB
PR Waistband Portable PA System

» 50 Watts _/'
» USB Input for
Playing Audio Files

» Includes Headset
Microphone
» Full-Range Sound
» Powered up to 12 Hours
» Built-In Rechargeable Batteries

(PYPWMAGOUB).....occce 39T

To view a full listing of all
Personal PA & Megaphones

or visit our website
BandH.com/w15327

M MP-15 Megaphone with Siren
POLSEN" and Detachable Microphone

» 800 Yard Audible Range
» 15Wof Qutput  » Built-In Siren

» Built-In Microphone )

» Detachable Mic with Coiled Cable <5

» Adjustable Volume Control

» Sturdy ABS Construction ;

» Includes Carrying Strap \)
19.95

PA25R Megaphone

lFa&é'
(( with Detachable Microphone

» Durable ABS plastic construction
» 25W of output power, allowing you
to be heard from up to 1250" away
» Detachable microphone
» 10-second message, and playing back
» Sirenmode > Integrated volume cantrol J
» Operates for up to 4 hours on a set of 8 “C" hatter\es
» Detachable shoulder strap included

CAPAZBR .o 1099

PRO AUDIO

w Lite-BP MiniVox Lite
Portable PA System
» Battery Operated

» Weighs Under 3 Pounds
» Neodymium Driver
» Mic/Line Inputs

» Soft Carrying Case
» Wired Mic

» Recharge Kit

[ANLITEBPB) .o 942,00

Europort EPA40
behringer 40W Handheld PA System

» Convenient battery and shoulder strap compartment
» Compact and Portable P

» Includes Handheld Microphone
» b” full-range loudspeaker

» Auxiliary inputs

» § Hour Rechargeable Battery
» Convenient battery & shoulder strap compartment

2119.99

' ER-1000
‘ Personal Public Address System

TOA 6 Watt & 10 Watt Modes

» Cover over 2401t distance in 6W mode
» Lightweight Waistband Design
» Head-Worn Microphone
» Aux Input

» Easily Cover Over 240ft
» Power: 6 AA Batteries

TOERTO00WR oo Call or Log-on

o MP-25 Megaphone with Siren,
POLSEN" MP3 Player & Microphone
» 1,500 Yard Audible Range
» 26W of Output
» Built-In Siren & Whistle
» Built-In MP3 Player
» Plays Files from SD Cards & USB
» Detachable Microphone with Coiled Cable
» 3.5mm Aux Input > Includes Shoulder Strap

39.95

ANBAMPLIVOX $602M

Piezo Dynamic Megaphone

» Can reach up to one mile away

» 3 modes for voice, whistle or
siren broadcasting

» Reach up to 1 mile away

» Weatherproof  » Easy Battery Installation

» Lightweight solution for long term presentations

» Use as handheld megaphone or w/ detachable shoulder strap

AMSBO2M . 149,00



PRO AUDIO

© crown XLS Series

DriveCore Stereo Power Amplifiers

» Lightweight Rackmount Design

» DriveCore Technology

» XR, 1/4”, and RCA Inputs

» Speakon and Binding Post Outputs
» Integrated PureBand Crossover System

» Individual Level Controls  » Forced-Air Cooling Fans  » LED Indicators

XLS 1002 350W/Channel (CRXLS1002)......... 299.00  XLS 2002 375W/Channel (CRXLS2002).........499.00
XLS 1502 535W/Channel (CRXLS1502) 399.00  XLS 2502 775W/Channel (CRXLS2502) 599.00

SAMSON Servo Series

Power Amplifier

» 1/4-inch and RCA input connectors

» 5-way binding post and 1/4-inch outputs
» Dual Rack space design

» 10-segment, 3-color Level LED meters

» Dual variable speed cooling fans

» 4-stage power protection circuitry

SA120 60W/Channel (SASAT20)..................199.99  SA300 150W/Channel (SASA300)................279.99
SA200 100W/Channel (SASA200) 199.99  SA600 300W/Channel (SASAG00) 329.99

ALESIS RA500

Stereo Power Amplifier

» 150W per channel into 8 ohms
» (uiet, cool, efficient class
AB power amplifier
» Crisp, clean signal
» Advanced convection cooling for outstanding heat dissipation
» More power and better performance at a lower cost-per-watt than competitive amplifiers
» Inputs: XLR, 1/4” TRS,RCA » Switchable voltage (120/230 VAC)  » Front-panel volume controls

w.......Callor Log-on

2-Channel Rackmount Power Amplifier

» 200W Per Channel at 8 0hms

» High quality audio with Low distortion
» Low Profile 1U Rack-Mountable Design
» 10Hz to 40kHz Frequency Response

» 1/4-inch TRS, and Euroblock Balanced Inputs  » Recessed “Pop Out” Detented Gain Knobs
» Multi-way Binding Post Outputs  » SmartFan Silent Cooling System

(ARSLA2) 329.00
SLA1 2-Channel 200w (ARSLAT)......Call or Log-on  SLA4 4-Channel 100w (ARSLAG)..................399.00

EPYLE PTATOND

250w Stereo Power Amplifier

» Rackmount Design

» Stereo and Bridged Modes

» XLR and 1/4” Inputs

» Dual-Speed Cooling Fans

» Speakon and Binding Post Outputs
» Protection Circuitry  » LED Indicators  » Selectable Operating Voltage

(PYPTA1000) 110.04
PYPTA1200 1200W/Channel (PYPTA1200).....119.00  PTA1400 350W/Channel (PYPTA1400)..........122.00

312 800-859-5252 + 212-444-5072

POWER AMPLIFIERS

CREST Pro-LITE Series
AUDIO power Amplifier

» Automatic Clip Limiting

» 7 front panel attenuators,
crossover select switch

» Inputs: Dual Combination 1/4” XLR

» Qutputs: Three Speakon connectors

» Temperature dependent variable speed fan

Pro-LITE 3.0 830W (CRPL30A) 479.00
Pro-LITE 5.0 5000W (CRPLS0A)...................849.00  Pro-LITE 7.5 7500W (CRPL75A)................1,049.00

IS GX Series
8 Ohm Power Amplifier

» XLR, 1/4” TRS and Phono Inputs
» Speakon/Z Combo Outputs

» (SC GuardRail Protection l["I“I"""["I

» |deal for Driving Sub-Woofers -
» Optimized for 4 and 8 ohm Speakers » Subwoofer/Satellite Crossover Built-in

(T

GX3 300 WAL (ASBX3) ...t L9 0199
GX5 500 Watt (0S6X5) 399.99
GXT 725 WAL (QSBX7) . 99900

Professional Power Amplifiers
» Matched for 4 Ohm & 8 Ohm Speakers b S —
p 1 i 14 ﬂm
» Built-In DSP Speaker Processor ! e
» High & Low-Pass Filters with 4-Band EQ
» LCD Display » Binding Post and NL4 Speaker Connects  » Lightweight: 11.3 b
GXD 4 1600W with DSP (QS6XD4) 499.99

IS GXD Series

» Efficient Class-D Power Amplifier

» Digital Limiting with Speaker Protection  » Parallel XLR and 1/4” Inputs

GXD 8 A500W With DSP (QSEXD8)....c 199299

iNUKE NU4-6000 Ultra-Lightweight
behringer  High-Density 6000W 4-Channel Power Ampilifier
» High-Density Class-D Amplifier
» Built-In Subwoofer-Satellite Crossover
» DC, LF, and Thermal Overload Protection &
» (Quad Mono, Dual Stereo, Dual Mono Bridge
» XLR and 1/4” TRS Input Combo Connectors
» Professional Speakon Connectors  » Back-To-Front Ventilation System

[BENUA46000) 349.99
iINUKE NU1000 150W/Channel (BENUTO00) ... 169,99

EuroPower EPQ304

vehringer  4-Channel Power Amplifier

At

» 50W/Channel @ 8 Ohms ~ » All-Steel TRU Rackmount

» ATR Technology
» Switchable Limiters  » Back-to-Front Airflow with Filter ~ » Protection Circuitry
» XLR/TRS Combo Inputs  » Speakon Outputs  » Detented Gain Controls  » Indicator LEDs

[BEEPOBDA). ..o 209,99



ALLEN&HEATH ZED-16FX

16-Channel Live Sound Mixer with FX & USB

» USB Connection for Mac and PC
» 16 Internal Effects

» 10 Mona Input Channels
» 3 Stereo Input Channels
» 3-Band EQ Section with MusiQ
» Four AUX Sends

» Includes Cakewalk Sonar LE Software

(ALZEDTOFX) . 699,00

PMP4000

vehringer 16-Channel Powered Mixer

» 1600 Watts
» §-Mono Line / Mic Channels
» 4 Stereo Line Channels
» 24-Bit Effects Processor
» 7-Band Graphic EQ

» Ultra-Compact Design
» FBQ Feedback Detection

(BEPMPADDO) ..o

Europower PMP550M 5-Channel
vehringer  Powered Rackmount Mixer

» 2x 260W Built-In
Class D Amplifier

» 7-Band Master
Graphic EQ

» 5 Mic & Line Inputs

» 7-Band EQ Per Channgl

» Feedback Detection Klark Teknik FX with 25 Presets

» Wireless Ready » Rackmount Brackets Included

[BEPMPEEOM) ..o 199,99

Speaker Management System

d b x DriveRack PA2 Complete

» Crossover for 2- or 3-Way Systems

» Loudspeaker Management  » Mac, PC, i0S, & Android Control

» AutoEQ Automatic Room EQ Function  » Driver-Alignment Delay
» Automatic Feedback Suppression  » dbx Compression & Limiting
» 8-Band Parametric EQ & Graphic EQ  » Subharmonic Synthesis

[DBPAZ) e 399,00

ARPHIE>K 2-Channel Aural Exciter

and Optical Big Bottom Effects Processor

330 000,,000000 |

» Restore and Recreate Lost Harmonics  » Enhance Bass
without EQ Boosting  » Improve Clarity and Presence

» Differentiate Voicing and Sonic Details  » Maintain Overall
Output Level  » Adjustable Operating Level Switches

» Independent Control of Channels 1and 2

[APEXCITER). ..o 900,33

SOUND REINFORCEMENT MIXERS

IMMACKIEE. ProFX8v?2

Sound Reinforcement Mixer with Built-In FX

» Per Channel 3-Band EQ  » Dual 7-Band Graphic EQ

» USB Recording to Computer (Mac & PC)

» 4 Low-Noise Mackie Vita Mic Praamps

» 16 FX Including Reverb, :
Delay & Chorus

» Hi-Z Input for Direct
Guitar & Bass

(MAPROFXBVL)...coe

@YAMAHA EMX-5125C

12-Channel Stereo Powered Mixer

» Small-Format Sound Reinforcement

» 8§ Mono Input Channels Sy

» 4 Stereo Input Channels

» D-Pre Microphone
Preamplifiers

» Dual Digital
Effects Engine

. 639.99

(YAMBPTOX) .o

@YAMAHA EMX-5125C

12-Channel Stereo Powered Mixer

» 500 Watts Per Channel
» Built-In FX Processor
» Dual 7 Band Graphic EQ
» Feedback Channel
Locating
» Yamaha Speaker Processing
» Durable and Lightweight

1 VAL

(YAEMXBT2SC)...ooce

db . DriveRack VENU360
I 3x6 speaker Management System

[ ———

» dbx Compression & Limiting
» Advanced Feedback Suppression

» Driver Alignment Delays
» 31-Band Graphic EQ » 12-Band Parametric EQ

» Subharmonic Synthesis  » Backline Delay » Noise Gate
» Android, i0S, Mac, & Windows Control

[DBVENUB0) - 199,99

SHARK FBQ100

vehringer  Automatic Feedback Destroyer

» Delay Line, Noise Gate, and Compressor
» Integrated Mic Preamp e
» Destroys up to

8 Frequencies
» Balanced XLR and 1/4”1/0
» Narrow FBQ Filters
» Subsonic Filter

i 99.99

(BEFBATO0)..occccc

PRO AUDIO

XENYX X1222USB
vehringer USB Audio Mixer with Effects

» Built-In USB
Audio Interface
» Easy-to-Use 1-Knob
Compressors
» "British™ Style 3-Band Eds
» Mac, Windows, and
Linux Compatible

[BEX1222USB)....occccce

%y XRS
INE
7 \/ Powered Mixer with Bluetooth

» Subwoofer line output

» Footswitch capabilities;
Master Mic Mute,
Effects Defeat

» Effect to Monitor Return

» Monitor Send  » Input pads

» Analog record output capability

w........Call or Log-on

XR-AT Powered Mixer with Bluetooth (PEXRAT).............799.95

(06 D—

PYLE' PMX80M
PR( Powered PA Mixer/Amplifier
» USB 2.0 Port for MP3s
» Built-In Effects
with Level Controls
» 800 Watts of Power
» 8 Channels

[PYPMXBOZM) .o 166,99
PMX602M 600 Watt 6-Channel (PYPMX802M) 137.99
PMX402M 400 Watt 4-Channel (PYPMX40ZM)......................... 134.00

DCX2496 Ultradrive Pro Digital

vehringer Loudspeaker Management System

» 3-input, 6-output loudspeaker management system

» 4 different operating modes  » “Zero” attack limiters

» Butterworth, Bessel & Linkwitz-Riley Crossovers

» High-, band- and low-pass filters for each input and output

» Dynamic EQ » Automatic or manual-adjustable delays

i 299.99

[BEDCXZA9B) ...

Protea 4.85P

Digital Speaker Processor

» Variable filter response  » Peak overload warning LEDs
» 4Input, 8 Output  » Extensive Digital Processing
» Built-in Limiter  » 24-Bit 49kHz A/D Converters
» Crossover, EQ and Delay  » USB and RS-232 Interface

[ASABSP....oo.1,150.00




IMMNACKIE. VL4 Series

12, 14 & 16-Channel Mixers

1642VLI4

» The 1202 and 1402-VLZ3 have 12 or 14 balanced line inputs
» The 16-channel mixers offer 16 switchable line inputs
» Super quiet XDR? (Extended Dynamic Range)
mic preamps deliver studio-grade sound
» All except the 1202-VLZ3 have 60mm tapered faders
» Aux sends, level, pan and PFL solo on each channel
» 3-Band Active EQ (80Hz, 2.5kHz, 12kHz),
Control Room/Phones source matrix

1604VLZ4 16-Channel 4-Bus Compact Mixer (MA1604VLZ4) ...899.99

1642VLZ4 16-Channel 4-Bus Compact Mixer (MAT642L24) ....699.99
1202VLZ4 12-Channel Compact Mixer (MA1202VLZ4)............... 269.99
1402VLZ4 14-Channel Compact Mixer (MA1402VLZ4)............... 399.99

ALESIS MultiMix 10

Wireless Rackmount Mixer

» (ne-Button Pairing for Bluetooth Input ~ » 4 XLR Mic Inputs
with Phantom Power ~ » Pre- and Post-Fader Aux Sends

» 7 Stereo Channels  » 60mm Faders on Each Channel

» Stereo Aux Return  » Front-Panel Stereo Mix Output

[ALMMIOW) . 299,00

ASHLY IV

Stereo Microphone Mixer

» 8 Stereo Channels

» Rack Mountable

» 8 XLR & TRS Inputs

» § Send/Return Insets
» Sweepable EQ Section
» Balanced XLR Output

» 1/4” Mono Qutput
» Sub Input/Qutput. +48V Phantom Power

[ASMXBOB) . 1, 440,00

MX-400

ehringer Compact Low-Noise Mixer

» Ultra-compact 4-channel line mixer -

» |deal way to add more inputs 2
to a large console

» Low-noise 4580 ;
operational amplifiers @

» Four 1/4” phone inputs

» Power adapter included .

[BEMXADO) . 26,99

314 800-859-5252 + 212-444-5072

- WUl ANALOG MIXERS

XENYX QX Series

vehringer  Premium USB Audio Mixers

(0X2442USB

» Premium ultra-low noise, high headroom analog mixers
» State-of-the-art Xenyx mic preamps
» Studio-grade compressors with super-easy one-knab functionality
» Neo-classic British 3-band EQs. KLARK
TEKNIK FX processor with 100 presets
» Built-in stereo USB/audio interface

0X1002USB 10-Input 2-Bus Mixer (BEQX1002USB)................. 109.99
QX1204USB 12-Input 2/2-Bus Mixer (BEQX1204USB)............... 224.95
0X1222USB 16-Input USB Audio Mixer (BEQX1222USB) 249.99
0X1202USB Premium 12-Input 2-Bus Mixer (BEQX1202USB).... 129.99
QX2442USB Premium 24-Input 4/2-Bus Mixer (BEQX2442USB) 399.99

ALESIS MultiMix 8 USB FX
8-Channel Mixer with Effects & USB

» USB interface supports 16-bit,
44.1/48KkHz audio

» XLR inputs have gain trim,
switchable high-pass filters,
and 48V phantom power

» 1/4" line and guitar level inputs

» 3-band EQ with sweepable parametric mids

» Built-in DSP effects processor. Multicalor LED level meter

v 149,00

(ALMMBUSBEX) ..o

RX-1602

vehringer  Rackmountable Line Mixer

» Balance & Level Control  » Stereo and Mono Channels
» 16 input channels  » 19" Rack Mountable
» Each input channel features a +4 / -10dB level switch

e 169,99
219.99

(BERKTB02) ...
RX-1202FX 12 Channel (BERX1202FX)

ROILLS MX310 MorMics
3-Channel Mic Mixer/Combiner
» 3 XLR Mic Inputs and 1 Output
» Individual Level Controls

» Phantom Power

» Low Cut Filters

» 3.5mm I/0

» Metal Chassis

» Bottom Mounts and Power Supply Included

MorMics

(ROMX3T0).-.occ. 9400

ALLEN&HEATH ZED-14

Recording & Live Sound Mixer

» USB Connection
for Mac and PC

» Four AUX Sends

» 14 Input Channels

» 3-Band EQ Section

» Mono and Stereo Channels

(ALZED14) 399.00
ZED-10 Mutti-Purpose Miniature Mixer (ALZED10)................... 249.00

Soundcraft EPM-12

Audio Console

» 12 Mono &2 Stereo
Input Channels

» 12x GB30 Microphone
Preamplifiers

» Compact Mabile Enclosure

» Recording and Live Sound Audio Console

(SOEPM2). . 328,00
EPM-8 8 Mono + 2 Stereo Audio Console (SOEPM8) 248.00
EPM-6 Mono + 2 Stereo Audio Console (SOEPM6) ... 220.00

&YAMAHA MG10XU
10-Input Mixer with Built-In FX and USB

» "D-PRE" Mic Preamps with 48Y Phantom
» 2-In/2-Out USB Up to 24-bit / 192kHz 4

» bx Mic/Line Combo Inputs Py
» 6x 1/4" Line Inputs

» Built-In FX with 24 Presets
» TRS Monitor Outs

(YAMGTOXU -
MG10 10-Input Mixer (YAMG10)

SAMSON SM10

Rackmount 10-Channel Line Mixer

» TRU Metal Chassis

» /4" and XLR Connectivity » Balance Controls
» Mic Preamps with 48V Phantom Power

» Headphone and Monitor Outputs

» 6-Segment LED Meter. Internal Power Supply

[SASMID).. e 199,99

SAMSON S-Mix

Miniature Audio Mixer

» b total input channels

» Two 1/4” phone line/
Hi-Z inputs and stereo
RCA phono inputs

» Individual Level Control

» 3-pin XLR microphone input

» RCA phono stereo output

[SASMIX) . 69,99



X32 Rack O-Input, 25-Bus Digital
behringer  Mixer with 16 Microphone Preamps
» 16 Programmable MIDAS

Microphone Preamps
» 8 XLR Outputs, 6 Aux
Inputs/Outputs
» 48-Channel Digital Snake Ready via AESH0
» 32x32 USB Audio Interface Card  » 40-Bit Floating-Point DSP
» Built-In Virtual FX ~ » 5" Color TFT Front-Panel Display

[BEXBZRACK) . 1,199.99

Soundcratt Ui1é
6-Input Remote-Controlled Digital Mixer
» Control via Tablet, PC or
Smartphane. Integrated Wi-Fi
» J1-Band GEQ & Dynamics
On All Outputs
» i0S, Android, Windows, Mac 0S
» DSP from dbx, DigiTech & Lexicon :
» Per Channel 4-Band EQ, HPF & Dynamics

(soulte)
UI12 Digital Mixer (S0UI12)

549.00
...399.00

M-200i
Live Digital V-Mixer Console

» For Sound Reinforcement
» 17 Motorized Faders

» Roland's REAC Technology
» Wireless & Wired

iPad Control

» Controllable with or without iPad
» 24 Onboard Inputs and 14 Outputs

» Multi-Channel Recording to 40 Channels

[ROMZ00). ... 2,495.00

X Air Series Digital Mixers
venringer  for iPad/Android Tablets

» Built-In Wi-Fi Module

» USB Connectivity

» Midas-Designed
Microphone Preamps

» Records Audio via USB

» XLR Outputs

I[
00 |
ODoOO0ODO0OO0OOO0OOO

» MIDIIn/ Out
» X32 FX Rack with 4 Stereo FX Slots

XR12 12-Input XR18 18-Input (BEXR12) 249.99
XR16 16-Input XR18 18-Input (BEXRT6) ..o 399.99
XR18 18-Input Digital Mixer (BEXR18) ... 699.99

ALESIS i0Mix
4 Channel Recorder for iPad

» Mix and Record 4 Channels into iPad
» Switchable Phantom Powar
» 4 Combo XLR/TS Inputs
» Video Output

» Switchable Limiter

» Core Audio Compliant
» Latency-Free Input Monitoring
» Per Channel Gain, Trim, Pan, Low/High EQ

[ALIOMIX).eececre

» DI Switch
199.00

www.BandH.com

DIGITAL MIXERS

X32 40-Channel,
behringer  25-Bus Digital Mixing Console

» Programmable MIDAS-
Designed Mic Preamps

» 6-Band Parametric EQs

» Digital Snake Ready

» 32x32 FireWire/USB Audio
Interface Card ~ » 40-bit Floating-Point DSP

» 7" Color TFT Display. Motorized Faders  » Virtual FX

(BEX3Z) .o £,299.99

ALLEN&HEATH 0Qu-16C (Chrome Edition)

Rackmountable Digital Mixer

» Chrome Knobs & Faders +
Updated Firmware

» Touchscreen Interface

» Motorized 100mm Faders

» iPad Qu-Pad Control App

» 16x Mic/Line Inputs & 3x Stereo Inputs ~ » Recallable Preamps

» USB Audio Interface  » Built-In Processing & Effects

(ALAHQUTOC) - 1,999.00

IS TouchMix-16

Compact Digital Mixer with Touchscreen

» 201Inputs  » 16 Mic Preamps
» Multi-Track Recording

» Color TouchscreenB

» Assignable Pitch Correction

» Wireless Control Via iPad App

» DSP Processing Per Input Channel
» USB Wi-Fi Adapter Included  » Carrying Case Included

(asTM™16) 1,299.99
TOUCHMIX-8 Compact with Touchscreen (QSTMS) ................ 899.99

X18 Compact 18-Input
venringer  Digital iPad/Tablet Mixer

» 16 Programmable
MIDAS Preamps

» Built-In Wi-Fi Router

» 18x18 Bidirectional
USB Audio Interface

» 100-Band Real Time Analyzer

» ULTRANET P16-M Personal Monitoring Virtual FX Rack with
Classic Emulations  » 6 Aux & Main LR Buses with Inserts

499.99

©YAMAHA TF1

Digital Mixing Console

» Touchscreen & 17 Motorized Faders

» 16 Analog XLR/TRS Combo
Mic/Line Inputs )

» RCA Pin Stereo Line Inputs

» 16 Analog XLR Outputs

» 2x2 Recording via USB Storage Device

(YATF1).... e 1,699.99
TF3 D\glta Mlxmg Console [YATFS 2,999.99
TF5 Digital Mixing Console (YATFS) ... 3,599.99

PRO AUDIO

5= M3R
Digital Mixing Console

» 16 Midas PRO Microphone Preamplifiers

» 40-bit Float Point Internal Pracessing

» 17 Midas PRO Motorized
100 mm Faders

» 8 Digital FX Engines

» 25 Time-Aligned Mix Buses

» Durable Aluminum & High-Impact Steel

(57

..2,999.00
...999.00

[MIM3ZR).... .
M32C 40- \nput Dlgltat Rack Mlxer [MIM32C]

b PreSonus StudioLive 24.4.2Al
Digital Recording Console

» 24 Inputs, 4 Sub Groups,
10 Analog Buses

» High-Headroom XMAX
Microphone Preamps

» 40-In/26-Out FireWire s800 Interface

» Ethernet Port and USB Wi-Fi LAN Adapter

» Control Mixer with Mac, PC, or iPad

(PRSLM2442A1)
STUDIOLIVE 16.0.2 Digital Mixer (PRSL1602) ..o

2,499.95
999.95

MNACKIE. DLI2R
Wireless Digital Live Sound Mixer

» Complete Wireless
Control via iPad

» Personal Monitor
Mixing with Any i0S

» 3U Rackmount Design

» 14 Fully Assignable XLR Outputs

» 32 Mic Inputs with Onyx+ Recallable Pres

» 28 Output Busses with EQ & Alignment Delay

[MADLBZR) . 1,799.00

IMMNACKIE. ProDX8
Wireless Digital Mixer

» Bluetooth Streaming and M\xmg

» Recallable Mix Presets

» 6 XLR/14" Combo Inputs

» 3-Band EQ, Low-Cut &
Comp Per Channel

» Remote Control of Levels, EQ, FX & More

» 16 FX Including Reverb, Delay & Chorus

(MAPRODX8)
PRODX4 4-Channel Wireless Digital Mixer (MAPRODXA)...........

299.99
199.99

MACKIE. DL1608
iPad-Controlled Digital Live Sound Mixer

» With Lightning Connector

» Integrated iPad Dock on Faceplate
» iPad Mixing with Master Fader App
» Extensive DSP Built In

» 16 Onyx Microphone Preamps

» Optional Wireless iPad Operation
» Snapshot Mix Total Recall  » Support for Multiple \Pads

(MADLT60BLIGH) .. . .599.99
DL806 iPad- ControlledS Channel Dlg\tal M\xer [MADLSU&L] .499.99




PRO AUDIO

stanton €.502 Rack-Mountable
CD Player with MP3 Playback

» 8 Times Oversampling
» 1 bit D/A Converter

» MP3 Playback

» Frame Search

» Auto Cue

» 4 Different Scan Speeds
» 20 Sec Anti-Shock ~ » Pitch Display

[STCBOZNAY...occ

=
(@) DN-DL500MK2

Dual Digital Media Player
» Dual CD Drives =
» CD/CD-R/CD-RW/

CD-ROM Compatible

» AAC, AIFF, MP3, WAV Compatible
» Playback from USB Memory Devices
» Pitch Control  » Rack Mount Control Panel & Player
» BPM Counter For Beat Matching  » Key Adjust Changes Tempo

(DEDNDABOOMK2)....o..c

... Callor Log-on

Numark Ms
4-Channel USB DJ Mixer

» 4-Channel Club-Style Mixer

» LED Metering

» 3-Band EQ per Channel

» Replaceable Crossfader
with Slope Control

» Class Compliant USB Audio Interface

» Microphone Channel with Dedicated EQ

» Mac and Windows Compatible

[NUMBUSBBLACK) ..o 149,00

@ audiotechnica. AT-LP120USB

Direct Drive Professional DJ Turntable

» USB Output  » Direct Drive Motor /
» 331/3, 45 and 78 rpm Speeds S
» +10% and 20% Quartz Pitch Control R

» Cast Aluminum Construction \’
» Includes Audacity
Recording Software

(AUATLP120USB)
AT-LP120USB with USB Output (AUATLP120BKU)

Call or Log-on
279.00

gemini T7-1100USB
Belt Drive DJ Turntable with Cartridge

» USB Audio Output Port

» Audacity Recording Software
Included

» Belt Drive Motor

» +[-10% Pitch Control

» 33, 4, and 78 RPM Speeds

» Battle and Club Style Design

[GETTTT00USB . 122,20

DJ PLAYERS, MIXERS & TURNTABLES

gemini CDM-4000
CD/MP3/USB DJ Media Player
» Great for Mobile DJ Rigs
» Pitch Control Slider

» Anti Shock with RAM

Buffer Memory

» Two Independent Jog Wheels
» Single and Continuous Play Modes
» Blue-Backlit LCD Display Screen

» Two XLR Outputs
» Two Band Equalizer

(GECDMA000) ... Calll OF LOG-0R

gemini CDMP-1500

19" Professional TU Rackmount Player

utd

» Great for Bars, Restaurants or Clubs  » Slot-In CD Player
» Remote Control Included  » Plays CDs, CD-Rs and MP3 CD's
» Large LCD Display » Anti-Shock RAM Memory Buffer

» 2 Balanced XLR Outputs  » 1XLR Combo Microphone Input
» 1 Front Panel 1/4" Microphone Input

(GECOMP1500) oo Calll oF Log-0N

ALLEN&HEATH XONE:23
2+2 Channel DJ Mixer

» Xone Filter with Resonance Control

» VCAFaders  » Illuminated Switches
» 9-Segment Signal Level Monitoring
» Balanced XLR Microphone Input
» Balanced XLR Master Outputs
» Crossfader Curve Selector

» Dedicated Monitor Output

» External FX Loop

» 3-Band Total Kill EQ

(ALKONEZS)...ooo. 299,00

@ audiotechnica. AT-LP1240-USB

USB Professional DJ Direct-Drive Turntable

» USB Output to Mac & Windows Computers
» Rugged Construction
» Built-in Phono Preamp
» Phono or Line Output
» Direct Drive Motor

» 33, 45 and 78RPM Speeds
» Includes Audacity Recording Software

(AUATLPI2A0US) . 399.00

stanton 1.92

USB Direct Drive Turntable

» USB Port for Digitizing Audio _

» Includes Cakewalk <
Pyro LE Software

» 33, 45, & 78 RPM Speeds

» High-Tarque Direct-Drive Motor

» S/PDIF Digital & Analog Outputs

» Mac & Windows Supported

(STT92USB) ... Calll OF LOG-0R

Numark MP103USB
Professional USB & MP3 CD Player

» CD & USB Media Player for DJs

» CD & MP3-CD Support

» Load Filed From USB
Storage Devices

» Variable Pitch

» Scratch & Seamless Looping

» Balanced XLR & RCA Output Connections

i 199.00

(NUMPTO3USBY ..

Numark NDX500
USB/CD Media Player & Software Controller
» Touch-Sensitive Jog Wheel

» DJ Software Control via USB MIDI
» USB Audio Interface

» Pitch Tracking up to 100% \
» Anti-Shock Skip Protection

» Programmable Playback Modes! E‘ >
» Reloop Button Jumps to Beginning of Loop

. 269.00

[NUNDXB0) ...

> PYLE' PYD19628U
PR

Bluetooth DJ Mixer

» Built-in Bluetooth
» Digital Graphic Display Meter e
» Ush Flash Drive and Sd Memory
Card Reader Compatible
» Microphane Tone
Adjustments and Volume Contral
» Instantly Stream MP3 Files  » Microphone Talkover Control
» Allows You to Speak Over Audio, Karaoke Style

e 132.87

[PYPYDT9BZBU ..o

Technics. 51-1210MK5

Analog DJ Turntable

» Adjustable Braking Speed

» No-Click Pitch Control

» Instant Pitch Reset

» Quartz Direct-Drive

» 331/3 and 45
RPM Speeds

» Die-Cast Aluminum Platter

[TESLT210MKB) ..o

Numark NUTTUSB
Belt-drive Battle and Club Turntable

» USB Qutput

» 33-1/3 and 45 RPM
Motor Speeds

» 78 RPM Supported
Via Software
(Included)

i 139,00

(NUTTUSBT)

316 800-859-5252 + 212-444-5072



» Dual Display Jog Wheels
» Emulates 33 1/3
and 45 RPM
» Blue Display: Speed &
Scratch View

» White Display: Song Position

DJControl Jogvision
with Built-In Jog-Wheel Dlsplay

» Two 5.9" Touch Reactive Jog Wheels
» Two Sets of 4-Pads for Cue and Samples

[HEDJCIV).

» Two Touch-Sensitive
Deck Platters

» Main and Monitor
Audio Outputs

» Scratch- and
Vinyl-Style Manipulation

» Eight Velocity Sensitive Trigger Pads
[HEATBOTT1)..ooo

» Two Jog Wheels

» Four Modes (Loop,
FX, Samples, Cue)

» Two-Band EQ per Deck

299.99

DJ Control AIR S
USB DJ Controller with Software

» FX Controls
» Mac & Windows 0S

129.00

DJControl Compact

DJ Software Controller

» Scratch and Vinyl Style Cuing

» Four Pads per Deck

» Manual & Automatic Beat Mixing

» Software Based Mix Recording  » Windows & Mac 0S
(HEATB0BA). ... 19:99
(NI HATIVE INSTRUMENTS Traptor Kontrol S4 MK2

» Works with TRAKTOR
DJ iPad/iPhane App

» Aircraft-Grade
Aluminum Jogwheels

» Color-Coded RGB Indicator Buttons

for Each Deck

[NATKSAMK).....occc

» Flux Mode Buttons
» +18 dBu Balanced 1/4” Outputs
» Includes TRAKTOR PRO 2 with Remix Decks

599.00

Numark Dol

USB DJ Audio Interface

» 2h4-bit 44.1 kHz Audio Resolution

» 1/4" Headphone Qutput with Volume Knob
» 1/4" Microphone Input for MCing

» USB Bus-Powered

» Stereo RCA Master Output
» PC and Mac Compatible

» No Drivers Required

» Record Audio to Computer

INUDJIOZ) s

-

79.00

DJ CONTROLLERS & INTERFACES

Numark' Mixtrack Pro3 pJ controller
for Serato DJ with Integrated Sound Card

» All-In-One Serato Controller

» Integrated Audio
Interface

» 16x Multifunction
Performance Pads

» Touch Strips for
Dynamic FX Control

» Dual 5" Hyper-Responsive Jog Wheels

(NUMIXTRAKPR) . oo 249.00

Numanrk Mixtrack 3
DJ Controller for Virtual DJ

» All-In-One Virtual
0J Controller

» 16x Multifunction
Performance Pads

» Touch Strips for
Dynamic FX Control

» Dedicated Track Search Functionality

» Touch-Activated Illuminated Platters

149.00

(NUMIXTRACKS) ..

Numark iDJLivell
DJ Software Controller

» DJ parties of all sizes
with your compatible
iPad, iPod, or iPhane

» Crossfader

» Large scratch wheels

» iPad stand included

» Plug-and-Play: Works with i0S Core MIDI DJ Software

» Headphone / speaker split cable included

99.00

(NUIDJLIVED) e

Add-On DJ Controller

» Add-On for Your Existing TRAKTOR Setup
» Touch Strip  » 11 Knobs

» 31 RGB Back-Lit Buttons

» Control Two TRAKTOR FX Units

» Control Two TRAKTOR Track Decks
» USB Bus Powered

» Requires TRAKTOR PRO 2 Software

(NATKKTCNTRLR oo

» Mac and Windows

199.00

RANE] S| 4

5-Channel Interface for Scratch Live

» 2x High Speed USB Ports
» 24Bit [ 96kHz Resolution
» Auxiliary Input & Output 5
» Inputs for Turntables & CD Decks

» Includes Serato Scratch Live Software

(RASLA).... .
SL3 USB Z U Interface [RASLS]
SL 2 for Serato Scratch Live (RASL2) ...

_..Call or Log-on
Call or Log-on
_Callor Log-on

PRO AUDIO

Q\, MC6000MK2 Professional
Digital Mixer and Controller

» 4 Channel/8 Source )

Real-Time Matrix

» Dual-Deck Functionality

» Built-In 24-Bit Audio Interface

» 8 Assign Keys For Effect Control

» 14-bit 100mm Long Pitch Slider

» 105mm Touch-Sensitive Jog Wheels

699.00

[DEMCAOOOMKZ) ..o

Q\ MC4000 Professional

2-Channel DJ Controller for Serato

» Professional
2-Deck Controller
» Two Microphane Inputs
» Hot Cue and Sample Pads
» Touch Sensitive Jog Whesls
» 24-Dit/44.1 kHz Audio Interface
» Echo and Ducking Effect for Microphones

[DEMCAD00) . 399,00

EE=E:GETE° BeatPad 2

Cross Platform Controller

» for iPad, Android & Mac/PC
» Eight RGB Drum Pads Per Dack
» Integration with Spotify
» Integrated iPad Mount

» 1/4" Microphone Input

» Jog Wheels for FX, Scratching, & Cuzing
» Integrated 4-Channel USB Audio Interface
» Dedicated DJAY Filters and Encoders > Includes USB, Lightning, & Android Cable

599.99

[REBEATPADZ)....occcecceeccre

DJ Software Controller

» Works with TRAKTOR DJ iPad/iPhone App

» Aircraft-Grade Aluminum Jogwheels

» Color-Coded RGB Indicator Buttons

» Flux Mode Buttons
for Each Deck

» +18 dBu Balanced 1/4” Outputs

» Includes TRAKTOR PRO 2 with Remix Decks

399.00

[NATKSZMK).....occcc

Portable DJ Interface

» Works with Traktor DJ and Traktor Pro 2
» Compact and Portable

» 24-Bit/48 kHz Resolution

» USB 2.0

» 30-Pin i0S Cable Included

» Traktor LE 2 Software Included
» For Mac, PC and i0S

99.00

(NATAZMEH) .



PRO AUDIO

767/ 27 DVX-890K Multi-Format
Digital Key Control DVD / DivX Player
» Karaoke, Video, MP3, CD & DVD Player

» USB & SD Card Readers -

» Dolby Digital (AC-3) _
&Dolby 2.1

» 1/4” Phone Microphone Inputs x2

» Flexible Video Outputs  » 13-Step Digital Key Control

» Rackmount Hardware & Remote Control

(VODVXBIOK)....o oo Call or LOg-0n

SHURE Mi47
Competition DJ Turntable Cartridge

» Engineered for scratch DJ's and turntablists
» High output voltage and tracking force
» Designed for scratching,
spin-back and back-cuing
» Polished gemstone stylus e
» Stereo channel balanced within 2dB for high accuracy
» Compatible with Shure N44-7/70/71 replacement needles

..53.52
... 22.08

(SHMAT).... . .
N447 Replacement Stylus for M447 [SHNW]

@audio-technica. AT95E
Dual Magnet Phonograph Cartridge

» Frequency Response 20 to 20,000Hz
» Channel Separation
>20dB at TkHz
» Channel Balance
within 2dB
» Standard Half-Inch Mount
» Includes Mounting Hardware & Stylus Guard

40.00

[AUATOBE) .

y K67 Tiesto

Headphones

» (n-ear, Closed Back Design
» 1.6" Drivers
» Built From XRP3
Reinforced Polymer
» 30-Axis Folding
for Flat Storage
» Gold Plated 1/8" to 1/4" Adapter

[AKKOTTIESTO) ..o 69,99

SHURE MRB
Record Bag

» Fits Approximately
50 Vinyl Records

» Padded Nylon

» Four Pockets

» Two Tote-style Handles Sﬂuﬁ

» Backpack Straps BRE

» Shoulder Strap with Pad

38.99

KARAOKE & DJ ACCESSORIES

Karaoke USA G6F829 karaoke System
with 7" Color Screen & Record Function

» DVD/ CDG / MP3G karaoke player

» 7" (17.8cm) TFT color screen

» Record CDG / MP36 and voice

» Record and instant playback

» 15W power output (RMS)

» Remote control  » 2 microphones
» 100 to 240VAC AC/DC adapter

(KABFB29)......c

SHURE' WHLB White Label
DJ Turntable Cartridge

» High output voltage and tracking
force designed for optimum
results in nightclubs

» Diamond stylus designed for
preserving hard to replace vinyl records

» Stereo channel balanced within 2dB for high accuracy

» Compatible with the Shure NWLB replacement needle

(SHWHLB) .. 1199

Numark GrooveTool
DJ Cartridge

» Replaceable DJ Turntable Cartridge
» Fits Most Traditional
Head-Shell Mounts

» Includes Replaceable Jp— : ,
Diamond Stylus ‘\\T—;) )

_Callor Log-on

SHURE MDR-V55
DJ Style Headphones

» Large 40mm Drivers

» 1000mW Power Handling

» 5Hz -25,000Hz

» Flat, Tangle-resistant Cable
» Gold Plated Stereo Plug

(SOMDRV55BR]

To view a full listing of all
DJ Accessories & Karaoke

or visit our website
BandH.com/w15332

BIiETErix Party Bundle

Home Karaoke System

» Professional Vocal Pitch Correction

» Vocal Removal Function

» Powered Stereo Speaker with Subwoofer

» Controller with Professional Effects

» Qver 300 Preset Effects =t
» Microphone with Effect Button

» Mic Stand with Device Holder Included

(SISBTX) oo Call or LOg-0n

SHURE MJ7XE

Low Mass Turntable Cartridge o

» Rich sonic detail and response

» Extremely accurate reproduction

» Elliptical stylus

» Die Cast Aluminum Mounting Block
» Dynamic Stabilizer aides in playing uneven surfaces
» Compatible with the Shure N92E replacement needle
» SIDE-GUARD stylus protection system

[SHMITXE].ee

89.93

OrTOfONN omega Etiptical

Headshell Mounted Cartrldge with Stylus

» Includes Cartridge
and Stylus
» Elliptical Cartridge
» Headshell Mounted
» Archiving with USB Turntables

[OROMEGA . 6,99

HPX2000
vehringer  High-Definition DJ Headphones

» High-Definition Bass & Transparent Highs
» Single-Sided, Oxygen-Free Copper Wire

» Rugged, yet Comfortable Design

» Rotating, Reversible Earcups

» 40mm Cobalt Drivers

» High Dynamic Range

» Includes Adapter

[BEHPXZ000) ... 19.99

ROLLS VP29

Phono Preamplifier with RIAA EQ

» Solid state compact
phono stage

» RIAA Equalization

» RCA inputs/outputs

» 1/8" (3.5mm) TRS output

» Ground Connector

» AC adapter included

(ROVP29)

800-859-5252 + 212-444-5072




COLORstrip
@Hﬂmnﬂ [EH" LED Linear Wash nght

V- anvaton Pafr

» h-channel DMX-512 LED linear wash light ~ » 38" LED Source

» |deal for cyclorama lighting  » Daisy-chain a maximum of 32
units  » Great for Backgrounds, Footlights, Wall

» Controllable via optional DMX controller or optional Footswitch

» 100-240VAC, 50-60Hz, auto-switching

[CHCOLORSTRIP)....occcc

159.99

HWMWEE SlimPAR 56
mmmmmiees LED PAR Can Lighting Effect
» Slim 2.2” Profile
» 108 Red, Green & Blue LEDs
» 3 or 7-Channel DMX-512 Modes
» Color Mixing With or Without DMX
» Built-in automated and

sound activated programs
» Pulse effect with adjustable speed

(CHSLIMPARDG).......oo -
m

Hﬂm W[EE EZ GObO . I‘_/‘ﬂ--

Ve mwm Gobo Projector . =~

» Battery-powered | ¢

» Projects a custom image ‘ gﬁoha )

virtually anywhere
» Includes 10 wedding-ready gobos I
» Magnetic base affixes to most metal surfaces == “‘f_’
» Manual zoom for short-throw or long-throw applications
» Scissor clip with eye loop easily attaches to drop ceiling supports

179.99

[CHEZBOBO)......oeec

Hﬂmﬂﬂ EE, Hurricane 700

Fog Machine

V- anvaton Pafr

» Professional Fog Machine

» For enhancing visual lighting
effects, laser effects

» Generous Capacity Tank

» Quick Heat Up of Water-Based Fog

» Manual fog button  » Includes Wired Remote

» Includes a yoke bracket  » Includes 0.6L of Fluid

[CHHURTOOFOB) ..o

mafne B-230

L .,,..wm Bubble Machine

» Bubble Effects Machine

» |deal for parties, events, mobile DJs
» Suited for Mid to Large Areas

» Manual bubble button

» Easily Removable Fluid Tank

» Plastic Construction Prevents Rust
» Easily mounted on a lighting truss, T-bar, etc.

79.99

[CHBUBBLEMACH)......occc

DJ LIGHTING

Mega Bar RGBA

N—”" 42" Linear Fixture

» Multi Colors
» 6 Operating Modes
» 3-Pin DMX Connection

» Electronic Dimming 0 to 100%
» Built-in Microphone
» Power Cord Daisy Chain

164.00

(AMMBRGBA) ...

—WyRri Par38

» 150 Watts Maximum

» £26 Screw Base

» Baked Black
Enamel Finish

» 360° Fixture Rotation

» Accepts Flood or Spot Bulbs
with E26 Screw Base, up to 150 Watts

(NSP3BB) ... £9.9D

Inno Pocket Spot
N\’ Compact LED Moving Head Light
» Seven Colors Plus White
» 12W LED Source
» Seven Fixed Gobos
» Pan and Tilt Inversion Mode
» 2-Channel DMX Control
» Build Complex Lighting Installations
» Sound Activation Mode

(AMINNPCKTSPT) oo Calll o LoG-0R

Bob
Em Mﬂ LED Flame Effect

» Simulated Flame
Lighting Effect

» No Heat,
Completely Safe

» bk Orange and
12 Blue LEDs

(CHBOBLED) ..o b

To view a full listing of all
DJ Lighting & Effects

SCAN [Op=01 r[-

THIS 3 L]
CODE O

or visit our website
BandH.com/w15333

PRO AUDIO

4 MegaFlatPak 8 Plus
N—”" Mobile Lighting Rig

» Bx Mega Par Prfile
Plus LED Fixtures

» Bx Scissor Yoke

» Bx Power Cord

» 7x DMX Cables

» Soft Carry Bag

[AMMEGFLTPK8P) ..., Call or LOg-0R

PAR38
N\—”" Spot with Lamp
» 150W PAR can
» Great light for mobile DJs, live
performances,& installations
» Supplied for use with 120VAC
» Includes the fixture, a lamp,
power cord, & gel frame
» Compact (7x7x6”) and lightweight (2 [h]

[AMPARIBBL) ... 19,99

Micro Galaxian Il Laser
N\—”" DJ & Nightclub Lighting Effect

» 200 Green & Red Laser Beams
» Auto or Sound Active Modes
» Built-In Programs
» Fan Cooled
» RF Wireless Remote
» Includes Dual
Hanging Bracket

79.99

[AMMICROBALI) ..o

L w L|ght|ng Controller

» Fog & Strobe Controls 8
» 14 Reversible Faders
» Rack-Mountable

» MIDI Compatible

» 16 DMX Channels per Fixture
» Pressure Sensitive Joystick

» Up to 12 DMX Light Fixtures

» 30 Banks of Eight Scenes
» Tap-Sync and Beat Activation
» DMX Polarity Selector

149.99

[CHOBEYTD)....c.cc e

SDC12
\—”" Basic DMX Controller

» 12 DMX Channel Faders

» Master Dimmer Fader

» Portable, Hand-Held,
Wall-Mountable

» Runs on 12 VDC Supply,
or 9 VOC Battery

89.99

[ELSDCIZ).see
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OPYLE' PTAULS

PR( Stereo Power Amplifier
» 20 Watt x 2 10% RMS

at 4 Ohms

» Power on LED Indicator
» Bass & Treble Tone Control
» USB Input  » Switchable MIC Pager and Mixing Modes
» 1/4” Front Headphones Jack  » 3.5mm Aux CD/MP3 Input Jack
» 1/4” Front MIC Jack with Volume Control - » Volume Control

[PYPTAUB) ..o 99.99)

BOGEN. (1)) lassic Series

COMMUNICATIONS,INC.
Public Address Amplifier 1OOW
» Qutput for Tape Recorder or Booster Amp
» Thermal protection
and electronic
shutdown
» 4 Inputs
» AUX muting
» Telephone input

[BOCTOO). . 380,91

@3 BPYLE" PDWR63 6.5" Indoor-Outdoor
PR Waterproof Speakers

» Indoor-Outdoor Use

» Waterproof

» 6.5" Throw Woofer

» 1" Polyamide Tweeter

» 60-ounceMagnet Structure

» Spring-Loaded “U”
Mounting Brackets

[PYPDWRO3) .. 10,99

PYLE PWRC52
P 5.25" In-Ceiling Speaker
» Weatherproof Design
» 200W Power Handling
» Dual 0.5" Tweeters
» 525" Driver
» Installation
Hardware
Included

[PYPWRCSZ)...occc 19,98

CE500A

vehringer  Multi-Purpose Speaker

» 80W Internal Amplifier

» 5.5" Woofer and 0.5" Tweeter
» Integrated Limiter

» XLR Mic/Line Input

» XLR Link/Output Connector

» RCA Line Input

» Mounting Hardware Included

[BECESOOABK)....o.ccccc 129,99

INSTALLATION SOUND

Atlas AA120120 watt
/Sound g-Channel Mixer Amplifier

» Extensive muting

and output options
» Low cut filter
» \ICA control
» Bridge infout for combining amplifiers without relays
» b mic/line phantom power inputs and 1 stereo AUX input
» Pre out/power amp in for patching of external processor

(ATAA120).. ...527.50
AA240 ZA[]W Slx Input M\xer/Ampllf\er [ATAAZAU] Call or Log-on

Integrated Ampllfler with USB & SD Inputs

» RCA, USB, SD, AUX Inputs  » Push Button and RCA Outputs
» 1200W Peak Power  » SD Card Size up to 326B
» Play MP3 Files  » iPod Playback Through USB Input
» Record from AUX/RCA Inputs  » Repeat/Random Playback
» Bass, Treble,

& Balance

Controls

(TEIA1200) oo Call o Log-0n

IBL Control 1 Pro

use near computer monitors,
» Full frequency response
» 5" woofer &0.75" tweeter

Professional Compact Loudspeaker
» SonicGuard protection circuitry
» Perfect for video editing or DAW use

» Compact two-way speaker system
» Ball and socket mounting bracket included

» Magnetically shielded for safe i
Pair - Black (JBC1PROB) 164.00

BOGEN. (i Speaker Assembly

COMMUNICATIONS, INC.

with S86 8" Cone (Off White)

» 9508 SPL
» 586 8" Cone Driver
» 50-12kHz Frequency

Response
(BOSB6PGBW) 20.48
BRIGHT WHITE with 586 8" Cone &
Screw Terminal Bridge (B0S86T7G8UBR)............coe... 36.59

To view a full listing
of all Installation Sound

or visit our website
BandH.com/w15329

© crown 135MA

35W Commercial Mixer/Amplifier

» 3-input, 1-output

» Phoenix and RCA inputs

» Telephone Output

» VOX or Switch
Priority Muting

» Bass and Treble
Controls

[CR135MA)... - .179.00
160MA 6I]W Commermal Mlxer/Amp n‘lef [CRH]UMA] ..289.00
' A-912MK2
8-Channel Modular Mixer/Amplifier
4 h | Modul ixer// lifi

TOA

» |deal for background music, paging & messages

» 8 expansion output slots ~ » 25 & 70V Operation

» Paging Priority Modes  » Master low-cut filter

» Remote Master Volume Terminals  » Auxiliary Output

(TOA9IZMK2UL) oo Call or LOg-0n

Ed Electro-Voice EVID-6.2
2-Way 300-Watt Installation Speaker

» Rugged surface-mount weather-
resistant installation monitor

» Dual bass ports

» Treated woofer cones

» Cast aluminum Strong-Arm Mount(SAM)

» Dual 6" woofers with magnetic shielding

» 1" Coherent Coverage Waveguide Horn tweeter

BLack (ELEO2) ..o
White (ELEA2) oo

Call or Log-on
Call or Log-on

CSP-162
6.5" 2-Way Ceiling Speaker System
» For 70V, 100V, & Low-Ohm Systems 4

» Integrated Multi-Tap Transformer

» Front-Baffle Located Tap Selector

» 6.5" Woofer » Sealed Backcan Enhances Fidelity

» 75" Clearance  » Vented Port Enhances Low Frequencies
(SECSP162)........199.00CSP-142 80W 4" Premium 2-Way Ceiling

» Up to 150W Power Capacity I )
» 34" Titanium-Coated Tweeter
Speaker (SECSP142) 149.00

Atlas AP-15T Horn Loudspeaker

/Sound with Transformer

» Environment Resistant for
Outdoor and Indoor Use
» Transformer 25, 70.7, &
100V Line Applications
» High-Efficiency Driver
» 15 watts of continuous power handling .
» Omni-Purpose Bracket for Precise Positioning
» Intelligibility for Voice and Tone Signaling  » Gray Finish

[ATAPTST) oo Call or LOg-0n

800-859-5252 + 212-444-5072




IN-LINE PROBLEM SOLVERS & ACCESSORIES

ILA-123 switchable
PEARSTONE In-Line Attenuator

» Provides -10, -20 or -30 dB of attenuation

» For use with all low-impedance &
phantom-powered condenser Mics

» XLR female to XLR male

» Shielded metal case to prevent interference

(PEILA123) 24.99

<& kopul CBT-MF

Multi-Function Cable Tester

» Tests 11 Connector Types

» Integrated Test Tone Generator
» Simple & Convenient Operation
» Detachable Chassis for Long Cable Runs
» XLR, TRS, Speakon, RJ45, RCA, BNC & More

[KOCBTMF) ..o

e 99,95

(whirlwind|" [MP 2

Single Channel Direct Box

» Passive Design

» Designed for both PA & Studio Use
» 1/4” parallel wired infout jacks

» Uses Whirlwind's TRHL-M transformer with metal shield
» Ground Lift switches help eliminate hum &buzz  » Rugged built

(WHIMP2) . 98,99

ﬁ&).ﬂamal lorizon. LTIBLOX

Laptop Interface

» Volume control of outgoing stereo signal

» 3.5mm male input and XLR male output

» Black powder-coated aluminum chassis

» Converts unbalanced input to a mic level balanced output
» Compact design  » Hand-soldered connectors

[RALTIBLOX) .. 9297

[whirlwind]" SPLIT6
1x6 Line Splitter

» 1 Input

» 6 Output

» Balanced XLR Connectors
» Level Signal

(WHSPLITB). oo

= CM-130 CHECK MATE
‘‘‘‘‘ SPL Meter

» Lightweight, miniature with 0.1dB Resolution

» Built-in electret condenser microphone with windscreen

» Large backlit Level range display with low, medium
and high level readouts  » AC signal output

(GACM130) Call or Log-onCM-140 CHECK MATE
(7T A1) Call or Log-on

www.BandH.com

SHURE A85F

Microphone Matching Transformer
» Low to High Impedance

» Provides 24dB of gain

» May be used in reverse

» In-Line XLR Female to 1/4" Male

(SHABBF.....o

Cable Tester

@?,PVLE@ PCT-40 12-in-1 Audio 4

» Tests 12 different cable types & :;.,, ""'/.
» LED indicators confirm |
conductor’s continuity & connection
» 8-way switch allows you to make quick cable selections
» Rugged metal housing  » Uses a standard 9V battery
(PYPCT40) 33.99

&, .
N Kopul PDI-40
Passive Direct Box

» /4" Balanced Input

» XLR Balanced Output
» Parallel Output For Connecting to Amp
» Converts High Impedance to Low Impedance
» -20 or -40dB Pad  » Ground-Lift Button Minimizes Hum

(KOPDIAD) . 26,99

EBTECH- HE-2-XLR

Dual Channel Hum Eliminator

» Eliminates AC Hum

» Breaks Ground Loops

» 1/4" TRS and XLR Connectors

» Audiophile quality components

» Converts automatically between
balanced and unbalanced lines

A |

(EBHEZXLR)...occc

ROILLS PB223 Mic Power Il

Dual 48V Phantom Power Supply

3

» Input Connectors: E
2x3-Pin XLR Female :

» Qutput Connectors:

2 x 3-Pin XLR Male

X ]

(ROPB223) ..o

To view a full listing of all In-Line
Problem Solvers & Accessories

Opr0]

or visit our website
BandH.com/w15336

PRO AUDIO

(whirlwind|" LIFTER

Ground Lifter

» In-Line XLR Barrel Design

» |deal for troubleshooting ground problems

» Isolates the ground of a balanced audio signal
without requiring you to cut the cable’s shield wire

» Eliminates 60 Cycle Hum

CT-100

S
behringer  Cable Tester '.-'_ (.f' o4 ”:é
» Tone Generator S 2 ‘;‘,:‘:".“' ')
» Microprocessor-controlled = o
» Compact, low-profile form factor x]e

» Test Modes: Continuity, Intermittent, -
Phantom, Grounded Shield Detect
» Durable metal enclosure  » Powers via (2) A alkaline cells

[BECTI00) o 29,99

& PYLE PIC21
PRO Direct Box

» 1/4" Balanced Input

» Unbalanced 1/4” Phone Qutput

» XLR Balanced Output

» Parallel 1/4” Phone Output  » Attenuation switch

» Switchable Ground Lift  » All steel chassis construction

(PYPDC21) 8.99

ROLLS MS1M

Microphone Mute Switch
» General purpose muting switch

» Latching or Momentary Switch

» On/off or push-to-talk style operation
» Male and Female item Connections

» No Popping When Switched  » Passes Phantom Power

e he 00

[ROMSTIT .

(whirlwind® Micmute PT

Push-to-Talk Switch

» Convenient Pedal Design
» Metal Housing
» XLR Input and
Output Connectors
» Entirely Passive Design

[WHMICMUTEPT). ..o 6750

PHONIC pAA3

Handheld Audio Analyzer

» Portable Audio Analyzer
» Measurement Tool

» Condenser Microphone
» SPL and line metering

» USB Port

(PHPAA3) oo Call or Log-0n




3 {o:\V[p][el PROFESSIONAL AUDIO CABLES

Choosing Audio Cables

Whether you are looking to run cable in your professional studio or simply to get
your home theater set up, B&H's cable selection runs the gamut to cater to your
needs. With cabling solutions including 3-pin XLRs, 1/4” TRS and instrument,
1/8" stereo, DB25 connectors, RCA, Speakon, and a variety of digital audio cables
including AES/EBU, TOSlink, and more, B&H has your audio cabling needs covered.
To find the exact cable you need, log on to www.BandH.com/CableFinder/ProAudio

L[ LN MO MONSTER CABLE’

(=] @ I‘ -@ Kopul

ﬁ_‘;},)kapco!-!orimn. C©mpﬁ'@h@@ﬁ|\\.’/@ﬁ

B dH com/CableFinder/ProAudlo
WWW. andr.
BALANCED AUDIO CONNECTORS
Connector XLR 3-pin 1/4” TRS 1/8” TRS 1/8” TRRS TT or Bantam DB25
Cable 2 Conductor + Ground 2 Conductor + Ground 2 Conductor + Ground 3 Conductor + Ground 2 Conductor + Ground 8x 2 Conductor + Ground
Signal Balanced Balanced Balanced Balanced Balanced Balanced
Basic Balanced microphone and line Balanced line level signals or Balanced line level signals or Typically used for cel phones. Balanced line or microphone level, |- Balanced line or microphone Level
Application level sf nals unbalanced stereo s? nals unbalanced stereo sgi nals Balanced stereo signal with a typically used pro-audio patchbays typically used in pro-audio for
9 J v microphone for recording or broadcast studios | multi-channel audio equipment.

UNBALANCED AUDIO CONNECTORS

Connector 14" TS 1/8" TS RCA Sub-Mini

Cable 1 Conductor + Ground 1 Conductor + Ground 1 Conductor + Ground 1 Conductor + Ground

Signal Unbalanced Unbalanced Unbalanced Unbalanced

Basic Unbalanced signal, typically used in for instruments | Unbalanced signal, typically used in smaller modular | Unbalanced signals, typically used in professional DJ - ; o
Application such as quitars, bass, and synthsizers synthsizer formats such as eurorack equipment and consumer home audio Typeialy used in compact electronic devices

SPEAKER CABLE CONNECTORS

To view a full listing
of all Pro Audio Cables

Connector Speakon 14" 1S Banana
Cable 2, 4, 8 Conductor 2 Conductor 2 Conductor
Signal Unbalanced Unbalanced Unbalanced |- .
. Standard pro-audio speaker cable. NL-2 is typical single A or visit our website
Ap;?;giun speaker input. NL-4 is typically used for bi-amped speakers. Single speaker cable AuSlﬂo&J@lfpiZﬂe[Jrrg:glrger BandH.com/w15337

NL-8 is typically used for tri-amped 3-way speakers.

DIGITAL AUDIO CONNECTORS

Connector AES/EBU (3-pin XLR Connector) SPDIF RCA (RCA or JIS FO5 Connector) TOSLINK (JIS F05 Connector) TOSLINK Mini (3.5 mm Connector) ADAT Optical (JIS F05 Connector)
Cable 2 Conductor + Ground Coaxial Cable or Fiber Optic Fiber Optic Cable Fiber Optic Cable Fiber Optic Cable
Signal Stereo Stereo Stereo Stereo 8 Channel
. - ’ Typically used in professional and con- Based on S/PDIF protocol utilizing optical | Based on S/PDIF protocol utilizing optical Typically used in professional audio
Ap;?;gion di]t\?gldgﬂICUUHTI\]NEDEtClggﬂf[?élpo[?ffgfst‘/%[\]stﬂ sumer level audio devices. Two channel fiber cable for digital audio. Two channel | fiber connector for digital audio. Used on applications for transfering or receiving

or Left/Right

or Left/Right

compact devices. Two Channe or Left/Right

8 channels of audio

322 800-859-5252 + 212-444-5072





